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Chapter 1: Introduction to
Dragon 12

The Dragon 12 Administrator guide is intended for administrators that deploy and manage installations
of: Dragon NaturallySpeaking version 12:

n Professional edition

n Legal edition

The administrator guide refers to these products generically as Dragon 12. We will mention when a fea-
ture applies specifically to one or more of these products editions.

Use the Dragon 12 Administrator guide to install Dragon 12, and to configure and manage the many fea-
tures, tools, and User Profiles in Dragon 12. To install Dragon 12 and perform the tasks in this guide,
you must have administrator access to the workstations in your network.

Dragon version 12 contains new features and improvements that enhance the ability to talk to, control,
and interact with a computer. This section contains general information about Dragon and the exciting
new features of Dragon 12.

What's new for administrators in Dragon NaturallySpeaking 15

Auto-saving end-user recognition history data 22

Creation and management of the recognition history log files 23

Contents of the recognition history log files 24

Enabling or disabling the logging of recognition history for an end-user 25

Removing the recognition history log files 26

Enable auto-saving of recognition history during a Dragon push installation 27

Configuring Dragon NaturallySpeaking to receive audio from a smartphone 28

Dictating with a smartphone over a network 34

Supporting Web applications 36

Enabling Web application support in a supported browser 38

Troubleshooting web applications 40
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What's new for administrators in
Dragon NaturallySpeaking

The following table lists details about the new features and changes in Dragon 12.

New features

Remote Desktop Connection – Use Dragon without installing it locally

Dragon 12 NaturallySpeaking, Professional, and Legal support remote use on Windows com-

puters running Windows Server 2008 R2 or Windows 7 Ultimate Server. Windows client end-

users connect to the server using Microsoft’s free Remote Desktop connection software (ver-

sion 7 or higher). Afterwards, end-users can dictate from a local Windows computer into appli-

cations that are on the server. Dragon end-users can also use a PowerMic II with Dragon over

the remote desktop connection. .

See Using Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server for more

details.

Using Multi-core computers with Speech Models and maximizing your computer's

resources

If you have a computer with two or more processors and more than 4 GB of RAM, Dragon

NaturallySpeaking automatically selects the BestMatch V speech model for you when you

create your User Profile. BestMatch V performs two recognition passes in parallel. See 'About

speech and acoustic models' in the Dragon Help.

BestMatch V models are recommended only for 64-bit computers.

Dragon 12 provides several BestMatch V speech models:

n BestMatch V: Provides the highest recognition accuracy if you have a computer with two

or more processors and at least 4 GB of RAM. BestMatch V performs two recognition

passes in parallel.

n Bluetooth 8Khz BestMatch V: Provides the highest recognition accuracy if you have a

Bluetooth microphone and a computer with two or more processors and at least 4 GB of

RAM. BestMatch V performs two recognition passes in parallel.

n Enhanced Bluetooth BestMatch V: Provides the highest recognition accuracy if you have

a Bluetooth wide band (16 kHz) microphone and a computer with two or more processors

and at least 4 GB of RAM. BestMatch V performs two recognition passes in parallel.

Web application support

Dragon 12 includes Web Application Support. Web Application Support provides Full Text

Control when an end-user dictates into Web mail applications. End-users can dictate content

and use commands just as they would in a desktop program.

Web Application Support means support for selected browser-based applications using Rich

Internet Application
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New features

(RIA) support. RIA support installs extensions in supported Web browsers.

As an administrator, you may need to help end-users enable web application support, deter-

mine if the features are on, or resolve issues related to web application support.

See Supporting Web Applications for details.

Smart Format Rules

Dragon 12 can learn from the corrections an end-user makes. If the corrections are format

related or related to alternate written forms, Smart Format Rules may display a prompt to allow

an end-user to set up corresponding format rules for future dictation. When the end-user edits

dictated text that corresponds to an Auto-Formatting option or Alternate Written Form For-

matting, Dragon displays a "hint," asking if the end-user wants to enable or disable the setting.

The end-user can also ignore the hint by continuing dictation, making keyboard edits, or saying

"Cancel" to close the hint.

If an end-user selects a smart format rule, the rewrite rule will apply for their future dictation.

To revert the rule, the end-user can make a correction in a different way. For example, if you

have applied a rule to always rewrite kilogram to kg, making a correction from “kg” to “kil-

ogram” will trigger a Smart Format rule prompt and you can apply the rule to “always rewrite

kg to kilogram”

Both Dragon end-users and administrators can enable or disable Smart Format Rules.

See Managing Smart Format Rules for details.

Using the Dictation Box with unsupported applications

You can configure settings in the Options dialog boxMiscellaneous tab for dictating into

unsupported applications. See the Dragon Help for details.

n Use the Dictation Box for unsupported applications: Displays Dragon's Dictation Box if

the microphone is on and an end-user starts to speak when the focus is not in a text field

where Dragon has Full Text Control. This option is turned on by default.

Viewing the confirmation box when a user closes the DictationBox

In Dragon 12, Dragon end-users can close the Dictation Box without having to view or

respond to the ‘confirm’ dialog box. There is no graphical user interface for this setting.

See Hiding Dictation Box confirmation for details.

Support for 8 kHz and 16 kHz Bluetooth microphones

Dragon now takes advantage of wideband Bluetooth to provide higher wireless accuracy com-

pared to 8 kHz Bluetooth.

If the dongle of a certified wideband Bluetooth microphone (such as the Plantronics “Calisto

II” BT-300) is plugged into a USB port on the PC before Dragon is open, the list of audio

sources on the Profile Creation wizard (and the New Dictation Source dialog box) will contain

the option “Enhanced Bluetooth”.
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If you are upgrading a User Profile for use with a 16 kHz Bluetooth microphone, perform one

of the following actions:

n After you upgrade the User Profile, add a new Enhanced Bluetooth source to the profile.

n Create a new User Profile with an Enhanced Bluetooth source.

For a list of fully supported Bluetooth microphones, please see

http://support.nuance.com/compatibility/.

Notes:

n See your Plantronics Calisto Bluetooth user guide for setup and operational details for your

device. The user guides are also posted on the Nuance User Documentation page.

n See the Dragon Help for more details about using Bluetooth microphones with Dragon.

Set audio settings on up to fifty computers

In Dragon 12, by default, you can configure audio settings on fifty computers that run Dragon.

A User Profile can have up to fifty computer-device pairs in the audio.ini file. This should

reduce the number of times an end-user with a Roaming User Profile must run the Micro-

phone quality check as they use their roaming User Profile on different computers.

You can change the number of computers that you can configure audio settings on .

1. In Windows Explorer, navigate to C:\ProgramData\Nuance\NaturallySpeaking12.

2. Use a text editor to open the nssystem.ini file.

3. Under the [Settings] section, set Number of Audio Settings to the number of computers

to configure audio settings on.

4. Save the nssystem.ini file.

Automatically save a rich recognition history for a user

Only for Dragon 12 Professional and higher:

Dragon Administrators can now turn on the automatic creation of recognition log files, a con-

venient way to quickly obtain rich objective information about how end-users are using

Dragon (commands, applications, audio sources, etc.). This data can help provide targeted

advice to end-users about how to get the most out of Dragon. Recognition log files can also

help Enterprises in gathering data for return-on-investment assessments.

Note: there is no graphical user interface for this feature. It is not accessible from any Drag-

onBar menu.

See Auto-saving end-user recognition history data for more details.

Keeping custom words up-to-date

Using Dragon’s support for custom words, especially contact names, can make communicating

with Dragon faster and more precise. To facilitate this, when Dragon loads a User Profile, it

determines how long it has been since the last time the document-analysis and email-analysis

tools were used. Dragon may then display the Personalize Your Vocabulary dialog box.
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The Personalize Your Vocabulary dialog box contains information about the last time the

"Learn from specific document” wizard and the “Learn from sent e-mails” wizard ran for the

profile. The dialog also displays the total time required to run the wizards.

Users can run both the "Learn from specific document” wizard and the “Learn from sent e-

mails” wizard from the dialog.

Dragon displays the Personalize Your Vocabulary dialog box:

n Two days after creating a User Profile if the "Learn from" wizards have not run for the

profile

n Once a week after not running a "Learn from" wizard for 1 month or if the end-user pressed

cancel the first time Dragon displays the Personalize Your Vocabulary dialog box:

See the Dragon Help for details.

Checking for User Profile maintenance when saving a User Profile

When an end-user saves a User Profile or closes Dragon, Dragon checks whether Language

Model Optimization has run recently. If that is not the case, then a check box will appear on

the Save dialog. The maintenance should only take an extra minute or two to complete since it

only uses text data and is particularly beneficial if new custom words have been added.

Enable or disable the hot key that clears the local cache

To clear the local cache copy of a Roaming User Profile, an end-user holds down the Shift key

when they open a profile. This action removes the local copy and replaces it with a copy of the

master User Profile.

In Dragon 12, you can enable or disable the hot key that clears the local cache User Profile.

1. In Windows Explorer, navigate to C:\ProgramData\Nuance\NaturallySpeaking12.

2. Use a text editor to open the nssystem.ini file.

3. To disable the hot key that clears the local cache User Profile, add the following text in the

[Settings] section: Roaming User Turn Off Force Reload=1.

4. To enable the hot key that clears the local cache User Profile, remove the following line

from the [Settings] section: Roaming User Turn Off Force Reload=1”.

5. To set the hot key that triggers the feature, add Roaming User Force Reload Key 1 to the

nssystem.ini file and set it to the decimal value of the VK Key code you want to use to

trigger this feature; currently it’s set to VK_SHIFT (the shift key).

6. To set a pair of keys to trigger the feature, add Roaming User Force Reload Key 2 to the

nssystem.ini file and set it to the VK Key code you want for the second key, otherwise

leave it at zero.

7. Save the nssystem.ini file.

Backing up and restoring a User Profile

Users can backup and restore a User Profile. The Profile Restore wizard allows end-users to

restore a profile from a checkpoint or a backup copy. See the Dragon Help for details.
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New features

Dragon displays the Profile Restore wizard when it cannot load a User Profile. End-users can

also click the Advanced button and select the Restore menu item on theManage User Pro-

file dialog to display the wizard.

To backup a User Profile, end-users can select Profile > Backup User Profile.

To restore a User Profile, end-users can select Profile > Restore User Profile.

See Backing up and restoring a User Profile for details.

Utility to package profile data for investigation

Dragon 12 provides a new tool to improve customer support interaction should you expe-

rience a problem.

The Dragon Support Packager collects and important files and data and places them into an

encrypted package. This encrypted package can then be sent to Nuance Technical support to

help resolve any issues you might be experiencing.

See Using the Dragon Support Packager for details.

Receiving notifications when the vocdelta.voc file is full

Prior to Dragon 12, when the vocdelta.voc file reaches 90% of its maximum size, Dragon dis-

plays a message indicating that the file is full. Dragon then incorporates the contents of the

local vocdelta.voc file into the master Roaming User Profile.

In Dragon 12, when the vocdelta.voc file reaches 90% of its maximum size, Dragon incor-

porates the vocdelta.voc content into the master Roaming User Profile but does not display a

message to end-users.

In Dragon 12, theMerge contents of vocdelta.voc into network user profile when file is

full option is enabled by default.

See the Dragon Help for details.

vocdelta.dat is now vocdelta.voc

In Dragon 12, the vocdelta.dat file uses the .voc format. The vocdelta.voc file performs the

same function as vocdelta.dat in Dragon 11.x and earlier versions of Dragon.

In the case where a Dragon end-user is working in disconnected mode, the “topicname”.dat

file is now “topicname”.voc.

Export custom words with word properties

Users can export custom words from a vocabulary and retain the word properties in the export

file. A new XML-based export format retains the word properties.

To export custom words, including the properties of each word:

1. On the DragonBar, select Vocabulary.

2. Select Export custom word and phrase list and follow the instructions.

3. When you arrive at the step for saving the export file, save the file as an XML file.
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New features

See the Dragon Help for more information.

Import custom words with word properties

Users can import an XML file that contains words and word properties into another vocab-

ulary.

1. On the DragonBar, select Vocabulary.

2. Select Import list of words or phrases.

3. Select the XML file that contains the custom words.

See the Dragon Help for more information.

Send an email notification when a transcription job completes

Administrators can use a command line instruction to send an email notification when the

Auto-Transcribe Folder Agent completes a transcription job. After the transaction job com-

pletes, the agent sends an email to an address specified by the administrator or end-user.

Users need to specify a path to a .cmd file and must specify the email address of the email

recipient(s) in the Command line field on the Dragon AutoTranscribe Folder Agent dialog.

When the Auto-Transcribe Folder Agent dialog completes a transaction job, an email is sent to

the email address or addresses in the Command line field.

See Sending a notification when the Auto-Transcribe Folder Agent completes a transcription

job for details.

The Auto-Transcribe Folder Agent can produce .rtf or .doc output files

Prior to Dragon 12, the Auto-Transcribe Folder Agent produces output files in .txt format and

an optional .DRA file.

In Dragon 12, end-users can set the Auto-Transcribe Folder Agent to produce output files in

.txt, .rtf or .doc. formats.

Users specify the output file format in the Output file format field on the Dragon Auto-

Transcribe Folder Agent dialog.

Note: To save output files in .doc format, Microsoft Word must be installed.

See the Dragon Help for details.

Enhanced logging for end-users with Roaming User Profiles

Administrators can now log and view more data for end-users with roaming User Profiles,

including data about connection tests. The logging data can be useful when debugging network

issues.

To enable enhanced logging for end-users with Roaming User Profiles:

1. In Windows Explorer, navigate to C:\ProgramData\Nuance\NaturallySpeaking12.

2. Use a text editor to open the nssystem.ini file.

3. To enable enhanced logging of Roaming User data, add the following text in the [Settings]
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New features

section: Roaming User Test Connection Before Internet User Load=1.

4. Save the nssystem.ini file.

Use the Options tab to turn off Active Accessibility for applications

User can use an option on the Options Miscellaneous tab to disable Microsoft Active Acces-

sibility (MSAA) tracking for specific applications. For more details about MSAA, see

http://msdn.microsoft.com/en-us/library/ms971310.aspx.

See Turning off Dragon's use of Microsoft Active Accessibility Service for details.

Turn off start menu and desktop commands for starting applications

User can use an option on the Options Commands tab to disable start menu and desktop com-

mands for starting applications. End-users can enable or disable the Enable launching pro-

grams from the Start menu option and the Enable launching programs from the

desktop option.

See Setting the Dragon Options Commands tab

View progress when halting acoustic optimization

When an end-user cancels acoustic optimization, Dragon displays a progress bar that shows the

status of the cancel operation.

See the Dragon Help for details.

New name for the Add Words from Documents dialog

The Add Words from Documents dialog is now called the Learn from specific doc-

uments dialog.

Viewing information about silent install errors

If an error occurs during a silent install of Dragon, the installer does not display any error infor-

mation. You will not see any error messages.

You can find information about the error in the dgnsetup.log file in the Temp directory. Use

the information to resolve the problem yourself or supply the log file to Nuance Technical Sup-

port for additional investigation.

You can also review the msi*.log file for information about installation errors.

See Troubleshooting silent install errors for details.

Support for Citrix

Nuance does not support Dragon running in Citrix environments.
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Auto-saving end-user recognition
history data

In Dragon 12, you can configure Dragon to auto-save recognition history data for Dragon end-

users. This feature creates an on disk transcript of Dragon use for each Dragon end-user. These

transcripts can then be used to monitor and help end-users during pilot and training programs.

Dragon writes the end-user recognition data into two recognition history log text files. Dragon

always stores the recognition history log files in the end-user’s local User Profile directory on the

Dragon client computer. Dragon stores the files in this location regardless if the end-user is a roam-

ing or non-roaming end-user.

You can only consider the data in the recognition history log files as valid when the User Profile is

not loaded. Dragon only allows two recognition history log files to exist at any one time.

The recognition history log files contain private information. You must implement appropriate

security measures to protect and control access to the log files.

See the following topics for more information:

n Creation and management of the recognition history log files

n Contents of the recognition history log files

n Enabling or disabling the logging of recognition history for an end-user

n Removing the recognition history log files

n Enabling the auto-saving of recognition history during a Dragon push installation
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Creation and management of the
recognition history log files

Dragon creates and manages two recognition history log files:

n RecogLog.txt: The current recognition history log file. Dragon saves new recognition history

data into this file.

n RecogLog_<year_month_day>.txt: An older recognition history log file. Dragon no longer

saves data into this file. The name of this file includes its creation date, for example, RecogLog_

2011_08_04.txt.

The RecogLog files are located:

n In the local User Profile directory:

C:\ProgramData\Nuance\NaturallySpeaking12\Users

n In the backup locations for the User Profiles:

C:\ProgramData\Nuance\NaturallySpeaking12\Users\backup

When an end-user loads a User Profile, Dragon examines the creation date of the oldest rec-

ognition history log file. Dragon keeps a maximum of two log files. Dragon creates a new log file

every 10 days or when the size of the old log file exceeds 3 MB.

If creating a new recognition history log file would result in three files, Dragon deletes the oldest

recognition history log file.
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Contents of the recognition history
log files

Each recognition history log file contains the same information you can view in the Recognition

History window:

n Words, phrases, and commands that Dragon recently recognized for the end-user.

n All words, phrases, and commands that Dragon has ever recognized for the end-user.

In addition, each log file includes the following information:

n The name of the User Profile used to create the recognition data.

n The name of the vocabulary used to create the recognition data.

n The name of the dictation audio source used to create the recognition data.
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Enabling or disabling the logging of
recognition history for an end-user

To enable or disable auto-saving of recognition history for an end-user, perform the following

steps on the Dragon client computer:

1. Open text editing software such as Notepad. On Windows Vista or Windows 7, make sure you

have administrator rights when you open the text editor (use the “Run as administrator” option

to open the text editor).

2. In the text editor, navigate to the folder that contains the nssystem.ini file.

In Windows 7, by default, the nssystem.ini file is located in:

C:\ProgramData\Nuance\NaturallySpeaking12

In Windows XP, by default, the nssystem.ini file is located in:
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking12

3. In the text editor, open the nssystem.ini file.

4. In the “[Settings]” section, add the following line of text: SavePerUserProfileUtteranceData.

The option name is case sensitive. You should type the option name exactly as it appears here.

5. To enable the logging of recognition history, set the SavePerUserProfileUtteranceData

option to 1. For example, SavePerUserProfileUtteranceData=1. This will log the spoken

form of data.

6. To enable the logging of recognition history, including spoken and written form data, set the

SavePerUserProfileUtteranceData option to 2. For example, SavePe-

rUserProfileUtteranceData=2. This is useful for debugging activities.

7. To disable the logging, delete the SavePerUserProfileUtteranceData line from the .ini file.

Optionally, you can set SavePerUserProfileUtteranceData=0 to disable logging.

8. Save and close the nssystem.ini file.

9. To activate the setting, re-open the User Profile.
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Removing the recognition history log
files

There are several ways you can remove the recognition history log files for an end-user.

Disable the SavePerUserProfileUtteranceData
option
When an end-user loads a User Profile, Dragon checks the profile to see if the

SavePerUserProfileUtteranceData option is enabled.

If the option is disabled (set to 0 or the option is not in nssystem.ini), when Dragon next loads that

particular User Profile, Dragon deletes all existing recognition history log files for that User Pro-

file.

Manually delete the recognition history log files
Delete the RecogLog.txt and RecogLog_… .txt files in the following locations:

n In the local User Profile directory:

C:\ProgramData\Nuance\NaturallySpeaking12\Users

n In the backup locations for the User Profiles:

C:\ProgramData\Nuance\NaturallySpeaking12\Users\backup
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Enable auto-saving of recognition
history during a Dragon push
installation

You can enable auto-saving of recognition history when you install Dragon to workstations using

an MSI push install.

1. Use administrator privileges to install Dragon on a Windows computer.

2. Start Dragon.

3. In a text editor, open the nsdefaults.ini file.

In Windows 7, by default, the nsdefaults.ini file is located in the following directory:

C:\ProgramData\Nuance\NaturallySpeaking12

In Windows XP, by default, the nsdefaults.ini file is located in the following directory:
C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking12

4. Add the following line to the nsdefaults.ini file: SavePerUserProfileUtteranceData option=1.

5. (Optional) Open Dragon and set options that you want to be set on all Dragon installations in

your network. You can set Dragon Options and the Roaming User, Miscellaneous, and Sched-

uled Task Administrative Settings.

6. Save the changes and close Dragon.

7. Copy the updated nsdefaults.ini file to a new location so you can use the updated file to push

install Dragon on other workstations. When you push install the Dragon configuration to other

workstations, use the updated nsdefaults.ini file as input for the DEFAULTSINI option. For

example, DEFAULTSINI="c:<path>\nsdefaults.ini".

See step 7 in Install the same Dragon configuration on multiple computers.

For more information about pushing Dragon installations to workstations, see:

n Overview of the Network Installation of Dragon from a Server

n Install the same Dragon configuration on multiple computers
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Configuring Dragon
NaturallySpeaking to receive audio
from a smartphone

How Dragon NaturallySpeaking receives audio from
a smartphone
To use the Dragon Remote Microphone application, you must also install the Dragon Remote

Microphone application on the Smartphone or supported device. For more information, see 'Using

a Smartphone as a wireless microphone' in the Dragon Help.

The Dragon Remote Microphone application supports the following devices:

n Apple iPhone 3GS and higher, iPad 1, 2, and 3, and iPod touch 4 and higher using iOS 4.2 and

higher. For iOS devices, the application is available from iTunes and the App Store.

n Smartphones and tablets using Android OS 2.2 and higher. For Android-based devices, the

application is available from Google Play (formerly called the Android Market)

When an end-user sets up a smartphone as a dictation source and begins dictating into the phone,

the Dragon Remote Microphone application sends the audio to a component called the smart-

phone server. The smartphone server processes the audio and sends it to Dragon.

The Dragon NaturallySpeaking installation process installs the smartphone server on the same

computer where you install Dragon.
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Starting and stopping the smartphone server and
server connections
When an end-user starts Dragon NaturallySpeaking, the smartphone server turns on and auto-

matically registers for local network access. Closing Dragon automatically closes the smartphone

server.

When an end-user starts the Dragon Remote Microphone application on the smartphone, the appli-

cation detects and displays information about all the smartphone servers that the phone can con-

nect with. In order to connect with a smartphone sever:

n the phone and the server must be connected to the same Wi-Fi subnet

n a User Profile must be set to use the smartphone as a dictation source

On the smartphone, the end-user selects the smartphone server to connect with. This action pairs

the phone with the server.

See the Dragon Help for more details about the Dragon Remote Microphone application.
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Configuring the smartphone server
You use the DNSSPServer.exe.config file to modify settings for the smartphone server.

TheDNSSPServer.exe.config file is an XML-based configuration file that the Dragon Nat-

urallySpeaking installation process places in the same folder as the smartphone server .exe file

(dnsspserver.exe).:

On Windows Vista and Windows 7, the dnsspserver.exe.config file is in the following direc-

tory:

C:\Program Files\Nuance\NaturallySpeaking12\Program

Use caution if you modify the configuration settings for the smartphone server since incorrect set-

tings can have unforeseen side effects.

Serious problems may occur if you modify the configuration file incorrectly. Nuance cannot guar-

antee that these problems can be resolved and you may need to reinstall the software. Modify the

configuration file at your own risk.

Set message logging

In the DNSSPServer.exe.config file, in the <switches> section, set the value parameter for the Serv-

iceDebugLevel option to one of the following values:

Message type Value

No tracing "Off"

Fatal error or application crash "Critical"

Recoverable error "Error"

Non-critical problem "Warning"

Informational message "Information"

Debugging trace "Verbose"

For example:

<add name="ServiceDebugLevel" value="Information" />

Viewing log information

Each time the smartphone server starts, the server creates a tracing / error log file (spserver.log) in

the current Windows user’s TEMP directory. You can view this file when trouble shooting prob-

lems with the smartphone server.

You can also view logging information in real-time by performing the following steps:

1. Stop Dragon NaturallySpeaking (or the dnsspserver.exe process)

2. Run the smartphone server manually in debug mode: In a command prompt, navigate to the

directory that stores the dnsspserver.exe file. Type “dnsspserver /debug".

3. Restart Dragon NaturallySpeaking 12.
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Set the logging of network statistics

You can enable the gathering and logging of network statistics data. The data is placed in the

SpServer.log and the Dragon.log.

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

DNSNetMonitoring option to one of the following values:

Audio support type Value

Enable the logging of network statistics "True"

Disable the logging of network statistics "False"

For example:

<add key="DNSNetMonitoring" value="true"/>

Set the time interval of network statistic reports

You can set the time period, in seconds, during which the system gathers network statistics.

When the time period expires, the system prints the statistics to the SpServer.log and the Drag-

on.log. log files.

For example:

<add key="DNSNetMonitorStatisticsWindow" value ="60"/>

Example log entry:

Info: NetStats: [Interval=60s, 44058Bps, Total=43854Bps]

Log entry explanation:

Over a 60 second time interval, an average of 44058 bytes per second was received, and an aver-

age of 43854 bytes per second is being received for the session to date. (44100Bps is considered

nominal for 22050Hz audio).

Set the time interval for logging audio not received

You can set the maximum time that elapses before the system logs no audio received. The system

logs the message when the timeout elapses (See Set the time interval for network statistic

reports).

For example:

<add key="DNSNetMonitorMaxPacketGap" value="5"/>

Audio not received log entries

The system logs 3 types of entries that are related to audio not received.

Log type Example Explanation

No audio received Warning: NetStats: No audio
data for 15s

Over a 15 second interval, no audio was
received.

Audio received after
interval of no audio

Warning: NetStats: Audio
data gap=90s > max=5s

When the system receives audio, it logs a
message that shows the amount of time that
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Log type Example Explanation

elapsedwithout receiving audio and the max-
imum value specified by this parameter. In
this example, 90 seconds passedwithout
receiving audio data.

Session ends NetStats: Info: [Ses-
sion=92s, Total=44128Bps]

When a session ends (the dictation micro-
phone is turned off), the system logs a mes-
sage about the session length and the
average transfer rate. In this example, the
session length was 92 seconds and the aver-
age transfer rate was 44128Bps.

Set the audio sources that Dragon NaturallySpeaking allows

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

DNSAllowAnyAudioSource option to one of the following values:

Audio support type Value

[Default] Allow only smartphone audio sources "false"

Allow ANY DNS audio source "true"

For example:

<add key="DNSAllowAnyAudioSource" value="false" />

Set encryption of audio data sent between the phone and the server

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

AudioDataEncryption option to one of the following values:

n "none" = [Default] Do not encrypt audio data

Set the default sample rate for Dragon NaturallySpeaking

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

SampleRate option to one of the following values (in Hz):

n "11025"

n "22050"

For example:

<add key="SampleRate" value="22050" />

Set the domain name for the Bonjour Domain Name Service

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

BonjourDomainName option to the domain name for the service. An empty string represents

the default domain.

For Example:

<add key="BonjourDomainName" value=""/>
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You can set the BonjourDomainName option to a valid domain name for your network provided

your computer has a real IP Address and is not using one of the private 10. 192., or 168. NAT

addresses.

Set the timeout interval for the smartphone and server connection

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

SPServiceSessionTimeout option to the number of seconds of inactivity that occurs before the

connection between the smartphone and the smartphone server is released and made available to

other smartphones.

For example:

<add key="SPServiceSessionTimeout" value="120"/>

Set the address port that the smartphone web listener uses

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

SPServiceWebListenerPort option to a port address within the 1025-65535 range.

For example:

<add key="SPServiceWebListenerPort" value="51001" />

Note: The default value for SPServiceWebListenerPort is 51001.

Set the maximum number of bytes per message that the smartphone
web listener can receive

In the DNSSPServer.exe.config file, in the <appSettings> section, set the value parameter for the

SPServiceMaxReceivedMessageSize option to the maximum number of bytes that a message

can contain for it to be accepted by the smartphone web listener.

For example:

<add key="SPServiceMaxReceivedMessageSize" value="131072" />
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Dictating with a smartphone over a
network

You can use the Dragon Remote Microphone Application on a smartphone or other supported

devices as a wireless microphone to dictate with Dragon NaturallySpeaking .

To use the application as a wireless microphone, your mobile device and the Dragon client com-

puter must be on the same Wi-Fi network.

Note: Your device and Dragon NaturallySpeaking cannot communicate using cellular networks. A

Wi-Fi connection is required.

Using the Dragon Remote Microphone Application
in a home network
Bonjour works on home networks where all computers are on the same subnet, which is a com-

mon configuration. As an alternative to using Bonjour, you can also choose to enter the IP address

or computer name that runs Dragon. The Dragon Remote Microphone Application only supports

IPv4 addresses.

If the home network has multiple routers, you need to enter the correct IP address or computer

name of the target computer or turn on multi-cast routing. See the Dragon Help for details.

Using the Dragon Remote Microphone Application
in Public Wi-Fi Hotspots
There are two general types of public Wi-Fi:

n Pure open Wi-Fi where an end-user turns on their computer or device, and they are “just on”.

This is similar to a typical home networking setup with one router as described above. The

Dragon Remote Microphone Application should work with this Wi-Fi configuration.

n Locations such as Starbucks and Panera, which use service providers such as AT&T Wi-Fi,

where the end-user must logon or accept the terms of service and where end-user fees may

apply. Nuance does not support this Wi-Fi configuration. The typical security settings in this

kind of network prevent the iPhone to communicate with the Dragon client computer.

Using the Dragon Remote Microphone Application
in corporate environments with multiple subnets
If the Dragon client computer and the iPhone are on the same wireless network and multi-cast

routing is enabled, Bonjour discovery should work. You may find that this multi-cast con-

figuration is not very common. IT departments may disable multi-cast routing to reduce security

threats and to reduce Wi-Fi bandwidth consumption.

If multi-cast is disabled, Bonjour discovery does not work. For Bonjour discovery to work on a

site has computers on multiple wired or wireless subnets, an administrator needs to enable the

multi-cast feature on the routers. This effectively puts all computers on the same subnet.
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The site can also use Bonjour with unicast routing with a Domain Name Server. This network con-

figuration requires all computers to have real IP addresses and not the 10., 192. and 168.

addresses.

As an alternative to Bonjour, end-users at this type of site can choose to enter the IP address or

computer name of the Dragon client computer.

Issues with Firewalls, Antivirus software and
Malware detection software
When you create a User Profile for the Dragon Remote Microphone Application. Dragon auto-

matically opens port 51001 in the Windows firewall.

Port 51001 needs to be open for the Dragon Remote Microphone Application to communicate

with the computer where Dragon is running. Some non-Windows firewalls, antivirus, and malware

detection software may disable port 51001. If that occurs, you need to configure the software to

open port 51001.

iOS 4.3 and HotSpot Tethering
iOS 4.3 provides the ability to connect a computer to the iPhone via WiFi and then connect the

iPhone to the Internet using 3G. This allows the computer to access the Internet even when a

WiFi network is not available.

Note: This configuration is not supported The Dragon Remote Microphone Application does not

work when a computer is tethered to the iPhone.
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Supporting Web applications
Dragon 12 includes Web Application Support that provides Full Text Control when an end-user

dictates into Web mail applications. With some limitations, end-users can dictate content and use

commands just as they would in a desktop program.

Web application support means support for selected browser-based applications using Rich Inter-

net Application (RIA) support. RIA support installs extensions in supported Web browsers.

Supported web browsers
Dragon 12 provides RIA support for the following Web browsers:

n Internet Explorer 9 (32-bit)

n Mozilla Firefox 12 or higher

n Google Chrome 16 or higher

Supported web applications
Dragon 12 recognizes unique commands for the following Web applications:

n Gmail

n Hotmail

Non-supported browsers and non-supported web
applications
In non-supported web browsers, an end-user can still use Dragon's basic commands with the Web

application, but they won't have access to the commands that work specifically with that appli-

cation.

In non-supported web applications, an end-user can use the Dictation Box to utilize Full Text

Control while they dictate. After the end-user enters text in the Dictation Box, they can transfer

the text to a field they are working in.

See the Dragon Help for details.

Enabling and using Web application support
An end-user performs the following general steps to enable web application support:

1. Ensures the requirements for web application support are met.

2. Launches Dragon and launches the browser.

3. Clicks or says "Yes" at the prompt to enable the browser extensions or perform the steps in

.Enabling Web application support in a supported browser

4. Goes to the site for the Web application they want to use and logs in to their account.

5. Determine if the feature is turned on. See Verifying web application support is on.

6. Begin a dictation session in the web application.
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Notes:

n On Windows XP - To use RIA on a Windows XP computer, use Firefox or Chrome. Internet

Explorer 9 is not available with Windows XP.

n With Google Chrome - RIA does not work if using Chrome's Incognito mode.

n After an end-user enables the extensions in Internet Explorer, they must restart the browser or

open a new tab before they can use the new commands.

n Web application support commands don't work if an end-user is working off line.

Verifying web application support is on
When Dragon's Web application support is active in Hotmail or Gmail:

n -users see a green dot next to objects that they can click by voice

n -when the cursor in an e-mail field or the message body, the Full Text Control Indicator is green

Troubleshooting web application support
See Troubleshooting web applications for details.
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Enabling Web application support in a
supported browser

Dragon's Rich Internet Application extensions install on a computer when you install Dragon.

Afterwards, the extension must be enabled to work with a supported web browser.

After installing Dragon, the easiest way to enable the extensions is for the end-user to click or say

"Yes" to the prompt to enable them the first time the end-user opens one of the supported

browsers. The end-user just says or clicks "Yes" to enable the extensions.

The following are the steps for enabling Rich Internet Application extensions with one of the fol-

lowing supported browsers:

n Internet Explorer 9 (32-bit)

n Mozilla Firefox 12 or higher

n Google Chrome 16 or higher

Enabling Web application support in Internet
Explorer 9 (32-bit mode) or later
After installing Dragon, a Dragon end-user performs the following steps to enable web application

support or to check the extension settings with Internet Explorer 9:

1. Open Internet Explorer.

2. Click the cog icon on the title bar.

3. Click "Manage Add-ons."

4. Scroll the Add-ons list to the section for Nuance Communications, Inc.

5. If the Status column indicates that either the Plugin or Extension is "Disabled," do the fol-

lowing:

vi. Select the name of the item from the list.

vii. Click "Enable"at the bottom of the Manage Add-ons dialog box.

8. Click "Close" to close the Manage Add-ons dialog box.

9. Close and reopen the browser. The feature will now be enabled.

Enabling Web application support in Mozilla Firefox
12 or higher
After installing Dragon, a Dragon end-user performs the following steps to enable web application

support or to check the extension settings with Mozilla Firefox:

1. Open Mozilla Firefox.

2. Click the Firefox button to open the Firefox file tab.

3. Click "Add-ons" to open the Extensions pane. The Dragon RIA extension shows.

4. If the extension is disabled, click "Enable."
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5. Click "Plugins" to open the Plugins screen, and look for the Dragon RIA plugin.

6. If the extension is disabled, click "Enable."

Be careful when you upgrade!

When you upgrade Firefox, you'll see a window prompting you to choose which add-ons you want

to keep active. You must select the Dragon RIA extension, or Firefox will automatically dis-

able it. If this happens, use the steps above to re-enable it.

Enabling Web application support in Google Chrome
16 or higher
After installing Dragon, a Dragon end-user performs the following steps to enable web application

support or to check the extension settings with Google Chrome:

1. Open Google Chrome.

2. Click the Wrench icon beside the Address bar to open the Google Customization and Control

menu.

3. Click "Settings."

4. Click "Extensions." The Dragon RIA Extension for Chrome displays.

5. Close and reopen the browser. If necessary, click "Enable" to enable the Dragon Rich Internet

Application extension. A checkmark appears in the "Enabled" checkbox when the Dragon RIA

extension is enabled.
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Troubleshooting web applications
Check the following items if an end-user experiences issues using Dragon with web applications:

n Make sure end-users are using a supported browser.

n Make sure web application support is turned on.

n Make sure the browser extension or plug-in is enabled: Dragon 12 includes plug-in and

extension files that Web browsers use to provide Rich Internet Application support. If an end-

user is having trouble, make sure the RIA plug-in or extension is enabled for the browser they

are using. This can be done from a Tools or Options menu. After enabling it, the end-user must

restart the browser.

n Make sure there are no issues with the site: Changes a site makes to its layout or functionality

can cause compatibility problems for Dragon. Nuance makes every effort to keep up with these

changes, but if end-users encounter difficulties, please contact Nuance Technical Support.

n Make sure end-users are using the correct language: To use Rich Internet Application support

and web browser commands, end-users must set the language of the Web application to the

same language as their User Profile. If a profile is set up in English, end-users must set up the

web application (Hotmail or Gmail) in English.

n Make sure end-users are not working offline: Offline mode is not supported for working with

Web-based documents.

n Play back dictation in a web application: use voice commands such as "Play that back," "Read

that," and "Read selection." Dragon does not support playback of dictation using menus and

buttons.

n Trouble opening the Correction menu: Dragon does not currently support the following

methods for opening the Correction menu when working in web applications:
n Using the hot key. By default, this is the Minus key (-)

n Double-clicking on selected text

n Clicking the Correction button on the DragonBar Extras toolbar
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Managing Smart Format Rules
Dragon 12 can learn from the corrections an end-user makes. If the corrections are format related

or related to alternate written forms, Smart Format Rules may display a prompt to allow an end-

user to set up corresponding format rules for future dictation. When the end-user edits dictated

text that corresponds to an Auto-Formatting option or Alternate Written Form Formatting,

Dragon displays a "hint," asking if the end-user wants to enable or disable the setting. The end-

user can also ignore the hint by continuing dictation, making keyboard edits, or saying "Cancel" to

close the hint.

If an end-user selects a smart format rule, the rewrite rule will apply for their future dictation. To

revert the rule, the end-user can make corrections in a different way. For example, if you have

applied a rule to always rewrite kilogram to kg. Making a correction from “kg” to “kilogram” will

trigger a Smart format rule prompt and you can apply the rule to “always rewrite kg to kilogram”

Smart Format Rules hints display when an end-user edits auto-formatted text using:

n The Correction menu

n The Spelling window

n The keyboard.

Enabling or disabling Smart Format Rules
Both Dragon end-users and administrators can enable or disable Smart Format Rules.

Enabling Smart Format Rules
1. Select Tools menu > Options from the DragonBar.

2. Select Correction.

3. Check the Show Smart Format Rules option.

4. Select OK to close the dialog box and apply your changes.

Disabling Smart Format Rules
1. Select Tools menu > Options from the DragonBar.

2. Select Correction.

3. Uncheck the Show Smart Format Rules option.

4. Select OK to close the dialog box and apply your changes.
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Hiding Dictation Box confirmation
In Dragon 12, Dragon end-users can close the Dictation Box without having to view or respond

to the ‘confirm’ dialog box.

Hide the Dictation Box close confirmation for one
end-user
1. Make sure Dragon is closed.

2. In Windows 7, on the Dragon workstation, navigate to

C:\ProgramData\Nuance\NaturallySpeaking12\Users\<user_name>\current

or

In Windows XP, on the Dragon workstation, navigate to

C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking12\Users\

<user _name>\current

3. Use a text editor to open the options.ini file.

4. To have Dragon not display the close confirmation dialog box, add the following to the

options.ini file: Confirm Dictation Box Close=0

5. To have Dragon display the close confirmation dialog box again, delete the Confirm Dictation

Box Close line from the options.ini file.

6. Save the options.ini file.

Hide the Dictation Box close confirmation for all
created end-users
1. Start Dragon.

2. In Windows 7, on the Dragon workstation, navigate to

C:\ProgramData\Nuance\NaturallySpeaking12

or

In Windows XP, on the Dragon workstation, navigate to

C:\Documents and Settings\All Users\Application Data\Nuance\NaturallySpeaking12

3. Use a text editor to open the nsdefaults.ini file.

4. To have Dragon not display the confirmation dialog box for all end-userfs created on the

Dragon installation, add the following two lines to the nsdefaults.ini file:

[options.ini Options]

Confirm Dictation Box Close=0.

5. Save the changes and close Dragon.

6. Copy the updated nsdefaults.ini file to a new location so you can use the updated file to push

install Dragon on other workstations. When you push install the Dragon configuration to other

workstations, use the updated nsdefaults.ini file as input for the DEFAULTSINI option. For

example, DEFAULTSINI="c:<path>\nsdefaults.ini".

See step 7 in Install the same Dragon configuration on multiple computers.

For more information about pushing Dragon installations to workstations, see:

42



Chapter 1: Introduction to Dragon 12

n Overview of the Network Installation of Dragon from a Server

n Install the same Dragon configuration on multiple computers
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Sending a notification when the Auto-
Transcribe Folder Agent completes a
transcription job

Administrators can use a command line instruction to send an email notification when the Auto-

Transcribe Folder Agent completes a transcription job. After the transaction job completes, the

agent sends an email to an address specified by the administrator or end-user.

Users need to specify a path to a .cmd file and must specify the email address of the email recip-

ient(s) in the Command line field on the Dragon AutoTranscribe Folder Agent dialog.

When the Auto-Transcribe Folder Agent dialog completes a transaction job, an email is sent to the

email address or addresses in the Command line field.

An email notification can be sent using Microsoft Exchange 2000 Server, SMTP, or Lotus Notes.

Note: The mapisend.exe, blat.exe, bmail.exe tools are third party software and Dragon does not

include them.

Microsoft Exchange command line example
Message syntax
mapisend.exe -u <profile> -p <password> -r <recipient> -s <subject>

Example cmd file content
@echo off

Echo "Output directory - " %1

Echo "Output filename - " %2

Echo "Output format - " %3

If "%3" == "TXT" (

mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s
"Transcribing has been completed"

)

If "%3" == "RTF" (

mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s
"Transcribing has been completed"

)

If "%3" == "DOC" (

mapisend.exe -u Microsoft Outlook Profile - p ********* -r %4 -s
"Transcribing has been completed"

)
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mapisend.exe options

n - u profile - the end-user mailbox of the sender

n -p password - mailbox password of the sender

n -r recipient - email address(s) of the recipient. If more than one recipient - separate

with ';' these must not be ambiguous in the default address book.

n -s subject - subject line of the email message

n -text message [options]

n -text_file [options]

options:

n -i interactive login (prompts for profile and password)

n -c cc: list

n -f File Attachment - path and file name(s)

n -v generates verbose output (an 8 line summary of the message)

SMTP command line example
Message syntax
bmail.exe -s <server_name>-t <recipient> -a <subject> –d

Example cmd file content
@echo off

Echo “Output directory - ” %1

Echo “Output filename - ” %2

Echo “Output format - ” %3

If “%3” == “TXT” (

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been
completed"

)

If “%3” == “RTF” (

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been
completed"

)

If “%3” == “DOC” (

bmail.exe -s smtp.companyname.com -t %4 -a "Transcribing has been
completed"

)
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bmail.exe options

n -s SMTP Server Name - the name of the SMTP server

n -p SMTP Port Number (optional, defaults to 25) - the port number of the

SMTP server

n -t To: Address - email address(s) of the recipient

n -f From: Address - email address(s) of the sender

n -b Text Body of Message (optional) - text for the body of the email message

n -h Generate Headers

n -a Subject (optional) - subject line of the email message

n -m Filename (optional) - use file as Body of Message

n -c - Prefix above file with CR/LF to separate body from header

n -d Debug -Show all mail server communications

See the Dragon Help for details.
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The Dragon Support Packager
Dragon 12 provides a new tool to improve customer support interaction should you experience a

problem.

The Dragon Support Packager (dragon_support_packager.exe) collects and important files and

data and places them into an encrypted package. This encrypted package can then be sent to

Nuance Technical support to help resolve any issues you might be experiencing.

Starting the Dragon Support Packager
You can run the Dragon Support Packager without starting Dragon, and even if there are no User

Profiles. If there are no User Profiles or if there is only one profile, the packager automatically

presses Proceed.

1. On the Start Menu, select Dragon NaturallySpeaking 12.0 > Dragon NaturallySpeaking

Tools > Gather files for support.

2. In the Choose the User Profile to investigate dialog box, select a User Profile.

3. Click Proceed.

4. In the Save As dialog, Choose a place to save the Dragon archive file.

5. Click Save.
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6. When the progress bar reaches 100%, click Finished.

7. Find the .dgnarc file and email it to Nuance Technical Support.

What to do if the Dragon Support Packager
produces an error
The Dragon Support Packager creates a log file every time it runs. If the packager fails to run prop-

erly, the packager creates a log file. You can use the log file and the dump file to view error infor-

mation if the packager crashes. Every time the packager runs, it overwrites both the log file and

the dump file.

Location of the Dragon Support Packager log file

<Windows OS User Temp>\DragonSupportPackager_log.txt

For example, on Windows 7:

C:\Users\<user_name>\AppData\Local\Temp\DragonSupportPackager_log.txt

Location of the Dragon Support Packager dump file

<Windows OS User Temp>\DragonSupportPackager_crash_000.dmp

Setting the amount of information to log

You can control the amount of data that the packager logs. From a command line, run dragon_sup-

port_packager.exe, using the /vl argument to specify the verbosity level of the log file.

You can set /vl to 0, 1, 2, or 3.

0 means no data is placed in the log file.

3 places the maximum amount of data in the log file.

The default verbosity level is 1.

For example:
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dragon_support_packager.exe /vl=3
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Creating Windows shortcuts to User
Profiles and Vocabularies

If Dragon NaturallySpeaking is shared with other people, or if a person has more than one User

Profile, you can create Windows Shortcuts on the Desktop to start Dragon NaturallySpeaking and

open particular User Profiles. If User Profiles have multiple Vocabularies, you can also specify the

Vocabulary to open.

To create a shortcut to a User Profile and
Vocabulary
1. Right-click the Dragon NaturallySpeaking shortcut icon on the Windows Desktop and then

click Properties to open the icon's Properties dialog box.

2. Click the Shortcut tab of the Properties dialog box.

In the Start In box, at the end of the path type "natspeak.exe /user <User Profile name>".

The text in the target box should look similar to the following line:

"C:\Program Files\Nuance\NaturallySpeaking12\Program\Natspeak.exe"

/user "David"for Windows XP

"C:\Program Files (x86-

)\Nuance\NaturallySpeaking12\Program\Natspeak.exe/user "David"" for
Windows Vista, Windows 7, or Windows Server 2008.

David is the name of the User Profile.

For Roaming User Profiles:

Or, if Roaming User is enabled, type the path to the Master Roaming User Profile loca-

tion, then /user, then the sub-folder if applicable, and then the User Profile name on

the network. The text in the target box should look similar to the following:

"C:\Program Files\Nuance\NaturallySpeaking12\Program\NatSpeak.exe"
/user "\\<server_name>\<subfolder_path>\<user_profile_name>" for

Windows XP.

"C:\Program Files (x86)\Nuance\NaturallySpeaking12\Pr-
ogram\Natspeak.exe/user "\\<server_name>\<subfolder_path>\<user_pro-
file_name>"for (Windows Vista, Windows 7, or Windows Server 2008)

For Vocabularies

To specify a Vocabulary, follow the User Profile name with "/Vocabulary" and the

name of the Vocabulary. The text in the target box should look similar to the fol-

lowing:
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"C:\Program Files\Nuance\NaturallySpeaking12\Program\NatSpeak.exe"
/user "David" /Vocabulary Politics

If the User Profile or Vocabulary name contains a space, enclose the name in quotation

marks. For example, enter: /user "Mike Workman" /Vocabulary "American History"

If the User Profile name contains a space, enclose the name in quotation marks. For

example, type: /user "Mike Workman"

3. Click OK.

When finished, double-click the shortcut icon to start Dragon NaturallySpeaking. The User Pro-

file opens along with the Vocabulary specified.

Types of Paths
The path can be a UNC, HTTP, or HTTPs path:

UNC

"C:\Program Files\Nuance\NaturallySpeaking12\Program\Natspeak.exe" /user
"\\<directory>\<directory>\<username>"

For example:

"C:\Program Files\Nuance\NaturallySpeaking12\Program\Natspeak.exe" /user
"\\Roaming\Profiles\Roaming1"

HTTP or HTTPS

"C:\Program Files\Nuance\NaturallySpeaking12\Program\Natspeak.exe" /user
"http://<url_of_server>\<user_name>"

For example:

"C:\Program Files\Nuance\NaturallySpeaking12\Program\Natspeak.exe" /user
"http://test01.roam.test\Roaming1"

The path to an HTTP or HTTPS location must only contain forward slashes - the same as the Network

Location dialog.

Precede the username with a backslash.

TIP

It is possible to add a shortcut to the top of the Start menu by dragging the shortcut icon onto the

Start button.
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Using multiple acoustic models with a
User Profile

If the computer that an end-user dictates on meets certain system requirements, Dragon Nat-

urallySpeaking uses two acoustic models with a User Profile. Using two acoustic models instead

of one improves recognition and dictation accuracy. Acoustic models that can be added in pairs to

a User Profile are called BestMatch IV models.

Any time you add a new dictation source to a User Profile that uses two BestMatch IV models,

the dictation source will also be associated with the two models.

A User Profile with two BestMatch IV models uses more computer resources, including RAM

memory, than a User Profile with one acoustic model. Dragon NaturallySpeaking uses two Best-

Match IV models on a multi-core computer with at least 2 GB RAM. Dragon NaturallySpeaking

recognizes when it is installed on a computer that meets these system requirements and selects

the BestMatch IV acoustic model as the default.

Acoustic Optimization for User Profiles with
BestMatch IV acoustic models
If a User Profile includes BestMatch IV models, you must run the Acoustic and Language Model

Optimizer (ACO) on a computer with multi-core processors. Dragon NaturallySpeaking uses two

BestMatch IV models only on a multi-core computer with at least 2 GB of RAM.

If the ACO processes a User Profile that was created on a computer with multi-core processors,

the optimizer always selects the BestMatch IV models to optimize.

If a User Profile is associated with BestMatch III models without accents, and you run the opti-

mizer on a computer that supports BestMatch IV models, if automatic acoustic model selection is

enabled, the optimizer will automatically choose a BestMatch IV model to optimize.

Multiple acoustic models and User Profiles on single
and multi-core computers
If an end-user creates a User Profile on a multi-core computer, when the end-user opens the User

Profile on a single-core computer, Dragon uses the first acoustic model for recognition. Dragon

does not load the second acoustic model.

If an end-userf creates a User Profile on a single-core computer, when the end-user opens the

User Profile on a multi-core computer, Dragon uses the single acoustic model for recognition.

If an end-user selects BestMatch IV models for a User Profile and trains the profile on a multi-

core computer, when the end-user opens the User Profile on a single-core computer, Dragon dis-

plays the following warning message:

"Your computer has a single core processor. You have opened a User Profile created on a com-

puter with a multi-core processor.
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Dragon NaturallySpeaking will work normally on this computer but you may see some change in

performance and accuracy".
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Installing, modifying and upgrading
Dragon

To install Dragon NaturallySpeaking:

1. Be sure your systems meet the system requirements.

2. Prepare for the installation or upgrade by backing up User Profiles before upgrading.

3. Install or upgrade the software by choosing the type of installation. See the table below for

installation options.

4. Become familiar with the Dragon file structure and carry out other post installation tasks.

Note: When an administrator installs Dragon NaturallySpeaking, installation instructions appear in

the primary language for the product. An administrator cannot install Dragon using a language that

is different than the primary language. For example, when an administrator installs Dragon, Eng-

lish, installation instructions appear in English.

Installation topic Topic link

Installation checklists Installation checklists

System requirements System requirements

Preparing for an installation or upgrade Preparing for an installation or

upgrade

Installing Dragon on a single computer
This topic describes the basics steps for installingDragon on a single
computer. It covers both a Typical/Complete installation and a Cus-
tom installation, sometimes linking you to further detail in another
topic.

Installing on a single com-

puter

Installing using the Windows Installer (MSI)
Dragon includes a native Windows Installer (MSI) that lets an admin-
istrator customize installations as well as install across a network to
multiple client computers. In addition, an administrator can use this
service to upgrade, modify, repair, or remove an existingDragon
installations.

Using the Windows Installer

(MSI) to install Dragon

Upgrading from a previous version
An administrator can upgrade installations to Dragon Nat-
urallySpeaking from Dragon NaturallySpeaking version 10.x and 11.x
.

Upgrading from a previous

version

View the Dragon file structure and carry out post
installation tasks

Post Installation Tasks
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Troubleshooting silent install errors
If an error occurs during a silent install of Dragon, the installer does not display any error infor-

mation. You will not see any error messages.

You can find information about the error in the dgnsetup.log file in the Temp directory. Use the

information to resolve the problem yourself or supply the log file to Nuance Technical Support

for additional investigation. Whenever a new install or upgrade is performed, information is

appended to the dgnsetup.log file.

You can also review the msi*.log file for information about installation errors. Whenever a new

install or upgrade is performed, a new msi*.log file is created in the Temp directory.

Search for silent install error information in log files
1. On Windows Vista and Windows 7, navigate to C:\Users\<user_

name>\AppData\Local\Temp.
On Windows XP, navigate to C:\Documents and Settings\<user_
name>\\Local Settings\Temp.

2. Use a text editor like Notepad to open dgnsetup.log.

3. Search for the following words: "Error", "Severe", and "Warning".

4. Scroll through to the bottom of the log file to view information about the installation error.

5. In the Temp directory, find the msi*.log file with a 'last modified' date and time stamp that is

similar to the 'last modified' date and time stamp of the dgnsetup.log file.

6. Use a text editor like Notepad to open the msi*.log file.

7. Scroll through to the bottom of the log file to view information about the installation error.
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This section contains information on the prerequisites for installing Dragon, Dragon system require-
ments, and information on which Dragon products you can install on the same computer.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or
earlier to Dragon 12 is not supported.

Preparing for an installation or upgrade 58

Installation checklist 59

Dragon system requirements 61

Storage space required for User Profiles 64

Installing on or upgrading to Windows Vista or Windows 7 66

Coexistence with other Dragon products 67
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Preparing for an installation or
upgrade

Before installing, modifying, or upgrading Dragon NaturallySpeaking:

n Close all open applications.

n Turn off or disable any antivirus software; installation can sometimes trigger a false virus report.

n Look at the supplied Installation Checklist.

Installation restrictions
n Be sure your system meets the hardware requirements before attempting to install Dragon

NaturallySpeaking. See Dragon system requirements

n Administrator rights are not required to create a User Profile or use the software after

installation.

n These restrictions also apply to an upgrade installation: On Windows XP Professional, Windows

Vista, Windows 7, and Windows Server 2008, if you want to create a Dragon User Profile for a

Windows limited user (with restricted privileges), you must log on to Windows using that

limited user account, then create the Dragon User Profile. If you create a Dragon user account for

a Windows limited user while logged in as a Windows administrator, the limited user will not be

able to access that user account.

n Dragon NaturallySpeaking is licensed on a “per individual” basis. You are permitted to install

the software on more than one computer (for example, on a desktop and a laptop computer, or

on a work and a home computer), but you cannot use the software concurrently on more than

one computer.

You are permitted to create multiple User Profiles, so long as each User Profile is for a single

individual. If someone else wants to create or use another User Profile, that person must

purchase a separate license for Dragon NaturallySpeaking.

Volume license agreements are available.

File Structure
Upgrading from Dragon NaturallySpeaking 10.x or 11.x automatically relocates some Dragon direc-

tories and files.

For information, see Dragon File Structure.
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Installation checklist

Installation checklist
Do all of your workstations meet the recommended system requirements for Dragon? (

Will you install the Dragon software manually at each computer or will installation be unat-

tended? (If the latter, read Installing, modifying, and upgrading Dragon for information on setup

or MSI command-line parameters.)

Which features will you install on each computer?

Which vocabularies do you need to install on each computer?

Note: Installing only selected vocabularies helps conserve disk space consumption

and shortens setup time. A full installation with all vocabularies uses about 4800 MB

and takes about 20 minutes, while an installation with only one vocabulary uses less

than 1800 MB. See Dragon system requirements for more information on disk size

requirements.

Will you install the tutorial (recommended)?

Will you install the text-to-speech component?

Will you set up roaming User Profiles? (Read Setting up the Roaming feature)

If so, where will you place the User Profiles?

In a shared network directory?

In multiple shared network directories? (for example, one per

department or clinic)

In each end-user’s Windows home directory?

Note: Placing each end-user’s profile in his or her Windows home direc-

tory is not recommended, because this makes it more difficult for the

administrator to perform operations on multiple User Profiles, such as

running the Acoustic and Language Model Optimizer or upgrading User

Profiles to a new version.

On an Internet server running WebDAV (HTTP roaming)?

If not, what location will you designate as the backup directory for each User

Profile?
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Where will you place the data distribution directory for distributing word lists

and command sets?

Will you be collecting data for the acoustic optimizer?

Will you restrict end-userfs from modifying commands and vocabularies?

Which default end-user-specific options will you set at installation time? (See

the Dragon Help on the Options dialog.) Which Administrative options will you set?.

Note:Where you store User Profiles will also depend on other factors. Each User

Profile requires about 160 MB hard disk space if it is local, 55 MB if it is roaming.

With default settings, acoustic optimizer data can take up to an additional space per

workstation, to a total of 1000 MB in the master Roaming User Profile (more pre-

cisely, 1000 MB per dictation source per master Roaming User Profile). Acoustic

optimizer data contains text and audio data that can be read or heard by anyone with

access to the User Profiles.

Upgrade checklist

Are there User Profiles that need to be upgraded from a previous version?

If so, will an administrator upgrade them or will each end-user upgrade his/her

own?

Support Checklist

Who will be responsible for running the Acoustic and Language Model Optimizer?

Who is responsible for collecting word lists and commands?

Who is responsible for distributing word lists and commands?

Will words and commands be distributed through the data distribution directory or by some

other means, such as email?

Who will Dragon end-users contact if they need help?
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Dragon system requirements
During the installation process, the software checks that your system meets the following require-

ments. If they are not met, Dragon will not be installed. Note that at least 1 GB of RAM is

required for installation in Windows XP and at least 2 GB of RAM is required for installation in

Windows Vista, Windows 7 and Windows Server 2008. See Operating systems and RAM, below.

Processor
Minimum

Intel® Pentium® 1 GHz or equivalent AMD processor or 1.66 GHz Atom® processor (SSE2

instruction set required).

Recommended

Intel Pentium 2.4 GHz (dual 1.8 GHz core processor) or equivalent AMD processor.

Faster processors produce faster performance.

If your computer has two or more processors and at least 4 GB of RAM, Dragon automatically

selects the dual-pass BestMatch V speech model during User Profile creation. See the Dragon

Help for details.

NOTE

Streaming SIMD Extensions (SSE) are not supported.

Processor cache
Minimum: 512 KB

Recommended: 2 MB

Operating systems and RAM

Operating system 32-bit 64-bit RAM min
RAM

recommended

Windows 7

(SP1 or higher)

√ √ 2 GB 4 GB

Windows Vista

(SP2 or higher)

√ √ 1 GB 2 GB

Windows XP

Home (SP3 or

higher)

√ X 1 GB 2 GB

Windows XP

Professional

(SP3 or higher)

√ X 1 GB 2 GB
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Operating system 32-bit 64-bit RAM min
RAM

recommended

Windows

Server 2008,

including SP1

and SP2

√ √ 2 GB 4 GB

Windows

Server 2008

R2 (SP1 or

higher)

√ √ 2 GB 4 GB

Note: Windows Vista, Windows XP SP2 and Windows XP 64-bit, Windows 2000, Windows

2000 Server, Windows Server 2003, and Windows XP 64-bit are not supported and installation

is blocked on those systems.

NOTE

* If your computer has less than the recommended amount of RAM, Dragon will install but dis-

plays a message recommending that you install additional RAM for optimum performance.

Free hard disk space
n 5 GB minimum for a custom installation where you install only the program files and one User

Profile. Installations can range from 800 MB (US English Home Edition) to 5 GB Dragon

NaturallySpeaking.

n 5 GB minimum for non-English versions.

Microphone
n Nuance-approved noise-canceling microphone. For a complete listing of Dragon-compatible

audio input devices, including Bluetooth microphones, Tablet PCs, and other hardware, visit

http://support.nuance.com/compatibility on the Dragon Support Web pages.

n Dragon NaturallySpeaking has built-in support for the Dictaphone PowerMics. For more

information, see the following topics in the Dragon Help:

l Using the Dictaphone PowerMic (the beige PowerMic)

Only newer beige PowerMics work with Dragon NaturallySpeaking on Windows

Vista.

l Using the Dictaphone PowerMic II (the black PowerMic)

PowerMic II packaging should display compliance labeling. If you are unsure

about the compatibility, confirm that the firmware version is v. 2.02 or greater.

Refer to http://support.nuance.com/compatibility

n The 16 kHz Plantronics Calisto II Bluetooth wireless microphone. See the Dragon Help for

more details about using Bluetooth microphones with Dragon.

Please consult your Plantronics Calisto Bluetooth user guide for setup and operational details

for your device. The Plantronics Calisto Bluetooth user guides are posted on the Nuance User

Documentation page.

62

http://support.nuance.com/compatibility
http://support.nuance.com/compatibility


Chapter 2: Preparing to Install Dragon

Sound card
Sound card capable of supporting 22 kHz 16-bit audio recording.

Other requirements
n Microsoft® Internet Explorer 7 or higher (free download available at www.microsoft.com).

n Creative ® Labs Sound Blaster ® 16 or equivalent sound card supporting 16-bit recording

n DVD-ROM drive required for installation.

n Nuance-approved headset microphone (included in purchase). See details at

support.nuance.com/compatibility/ (includes Bluetooth microphones, recorders, and Tablet

PCs).

n Speakers (optional for playback of recorded speech and Text-To-Speech features).

n An Internet connection for product activation. Note that product activation is not required for

Enterprise editions.
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Storage space required for User
Profiles

Adequate storage space must be available for Dragon User Profiles (that store information about

each particular person's voice, vocabulary, custom commands (if applicable), and option settings.

The space needs to exist on:

n Stand-alone installations where end-users work on dedicated computers.

AND

n Only for Enterprise Profile Management Central computers (sometimes servers) where Master

Roaming User Profiles are stored.

Having Roaming User Profiles lets end-users run Dragon on more than one computer or device by

accessing centrally stored provider-specific voice and speech information, rather than requiring

that the profile be on each computer.

Roaming User Profiles also let end-users with one computer use Dragon from different locations

that have a connection to the network, for example, the office, at home, or different locations

with the office or home.

The following information should be treated as guidelines for allocating disk space on your sys-
tem. The actual amount of disk space will vary from site to site.

For each Master Roaming User Profile (User Profiles stored on the central computer), you should

plan to have this much space:

n 55 MB for each Roaming User Profile

n 18 MB for each additional vocabulary you add for this User Profile

n 35 MB for each additional dictation source you add for this User Profile

n 1000 MB for Acoustic Optimizer data associated with each dictation source of each User

Profile

To set how much data you have elected to store:

1. On the DragonBar, select Tools > Administrative Settings.

2. When the Administrative Settings dialog box opens, check the Disk space reserved for net-

work archive option.

In addition, for the Local Roaming User Profile, you should plan to have the following space on

each PC where the end-user dictates:

n 55 MB for each Roaming User Profile

n 18 MB for each additional vocabulary added for this user profile

n 35 MB for each additional dictation source added for this user profile

n 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

The settings in the Data tab of the Options dialog box control how much acoustic optimizer data

Dragon retains locally:
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1. To set the number of minutes of audio to retain locally, click the Archive size... button and

position the slider.

2. To turn off retaining this data locally, check the Conserve disk space required by User pro-

file (for portability) option.

A non-Roaming User Profile requires approximately three times as much disk space as a local

Roaming User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile

and stores the copy on the local computer. On the other hand, a Roaming User Profile is stored in

a network storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.
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Installing on or upgrading to
Windows Vista or Windows 7

Dragon NaturallySpeaking version 9.5 and higher are compatible with several editions of Windows

Vista and Windows 7. Dragon runs on 32-bit and 64-bit computers for these operating systems.

You cannot install Dragon NaturallySpeaking 12 on Windows Vista SP 1 or earlier, Windows XP SP

2, Windows 2000, Windows 2000 Server, Windows Server 2003, and Windows XP 64-bit.

Earlier versions of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista or Win-

dows 7.

Note: You can only upgrade from Dragon 10.x or greater to Dragon NaturallySpeaking 12.

Upgrading from Dragon 9.x or earlier is not supported.

Upgrade considerations
If you upgrade a computer from a previous version of Windows to Windows Vista or Windows 7,

and that computer has Version 8.x, 9.x, or 10.x of Dragon installed, that version of Dragon will not

work after upgrading to Windows Vista or Windows 7.

All your User Profiles from these previous versions remain intact and can be upgraded when you

install Dragon NaturallySpeaking.

See "Upgrading User Profiles to Dragon NaturallySpeaking" in Dragon - What's New for admin-

istrators for more information.

Roaming User Profiles in an MSI Installation on
Windows Vista or Windows 7
For more on carrying out an MSI installation on Windows Vista or Windows 7, see Modifying

Roaming User Profile, Miscellaneous, Schedule Settings in the INI File.
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Coexistence with other Dragon
products

Coexistence with previous versions of Dragon
You can have only one version of Dragon installed on your system.

Note: Running Dragon 10.x or 11.x concurrently with Dragon NaturallySpeaking is

not supported.

Coexistence with Dragon SDK Client Edition
You can install Dragon SDK Client Edition 11 on the same computer where Dragon Nat-

urallySpeaking is installed. In addition, Dragon and Dragon SDK Client Edition can share User Pro-

files.

If you are running Dragon SDK Client Edition, you can not display the DragonBar.

Note: Dragon NaturallySpeaking can coexist with Dragon SDK Client Edition 9.x. and

10.x.

Run Dragon SDK Client Edition 11 on a computer
with Dragon NaturallySpeaking
You must have administrator privileges to perform the following step. In Windows Vista and Win-

dows 7, make sure to elevate the command prompt.

At a command prompt, type the following command:

C:\Program Files\Nuance\Dragon SDK Client Edition11\Program\natspeak.exe /fi-
xguids

Run Dragon NaturallySpeaking on a computer with
Dragon SDK Client Edition 11
You must have administrator privileges to perform the following step. In Windows Vista and Win-

dows 7, make sure to elevate the command prompt.

At a command prompt, type the following command:

C:\Program Files\Nuance\NaturallySpeaking12\Program\natspeak.exe /fixguids
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This section provides information on how to install Dragon, post-installation tasks, the Dragon file struc-
ture, sample commands.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or
earlier to Dragon 12 is not supported.
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Installing Dragon on a single
computer

This topic presents the basic steps for installing Dragon NaturallySpeaking on a single computer.

For a complete step-by-step procedure of installing Dragon on a single computer, please see the

Dragon Getting Started Guide, available in printed form, or the Dragon User Guide, available on the

DVD in \documentation\enx\User Guide.pdf.

Notes:
n In Dragon NaturallySpeaking, the installation process does not present the QuickStart option. If

you wish to enable this option, you can do so after Dragon is installed.

n You must have Windows Administrator rights to install or uninstall Dragon NaturallySpeaking

on Windows XP, Windows Vista, Windows 7, or Windows Server 2008. For more information

about how Administrator rights impact the creation of Dragon User Profiles, refer to Preparing

for an installation or upgrade.

n When you install Dragon NaturallySpeaking, Dragon installs using the primary language for the

product. You cannot install Dragon using a language that is different than the primary language.

For example, when you install Dragon NaturallySpeaking, English version, Dragon installs using

the English language.

If you attempt to use the setup.exe with the /l option on the command line to install 5 using a
non-primary language, the installation process uses the primary language for that edition of

Dragon and ignores the /l option.

Installing on Windows Vista or Windows 7

For information about installing the product on Windows Vista or Windows 7, refer to Installing

or Upgrading to Windows Vista or Windows 7.

Installing Dragon on a single computer

To install Dragon NaturallySpeaking on a computer:

1. Insert the first Dragon DVD into your DVD drive.

If the installation does not start automatically, use the Windows Explorer to find and double-

click setup.exe on the DVD.

When you start the installation, you might see a message from your operating system saying A

program needs your permission to continue. Click Continue to start the installation.

2. After the installation Wizard begins, click Next to proceed to the License Agreement. Read the

text of the agreement and select I accept..., then click Next again.

3. Enter your customer information—User Name and Organization—then the Serial Number

supplied to your Dragon installation.

4. Choose your installation directory. If there are no previous versions of Dragon on your system,

the default directory in Windows XP is:
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C:\Program Files\Nuance\NaturallySpeaking12
See Dragon file structure on page 93

5. Choose your Setup Type:

If you decide not to install some Dragon components by selecting Custom installation, you can

install them later by running the Setup program again and choosingModify.

l Typical/Complete: Installs all options and User Profiles and requires the most disk space.

l Custom: Lets you select options and User Profiles to install. Customizing your installation

options can greatly reduce the disk space required.

In the Professional and Legal editions of Dragon, you can modify the following settings dur-

ing a custom installation. These settings are applied to all User Profiles created with this

installation of Dragon, including User Profiles created from Windows XP, Windows Vista,

Windows 7, and Windows Server 2008 limited accounts:

l Modify the application's settings for all users displays the Options

dialog box at the end of the installation. The Options dialog box lets you

change the product's standard behavior:
l Change hot key settings

l Customize how text is formatted

l Choose initial microphone settings

l Set how often your User Profiles are backed up

l Set where you can dictate commands, such as in web pages

or other windows

l Modify the administrative settings displays the Administrative settings

dialog box at the end of the installation. The Administrative settings dialog

box lets you:
l Set up the Roaming feature

l Set the backup location of your User Profiles

l Restrict end-users from modifying commands and vocab-

ularies

l Schedule the Acoustic Optimizer and Data Collection tasks

l Modify the Auto-Formatting options for all users displays the Auto-For-

matting dialog box at the end of the installation. In this dialog box, you can

choose ways that text should be automatically formatted (such as postal

codes in US or UK format) and the number of spaces after a period.

l Enable or disable the Dragon interactive tutorial and the language tutorial.

See Enable or disable tutorials during a custom Dragon installation for

details.

6. Continue following the on-screen instructions. The setup program will install the files for

Dragon on your computer.

7. If you are upgrading and chose to upgrade User Profiles, when the message about upgrading

your User Profiles pops up, click OK.

8. If you did a Custom installation one or more of the following windows opens immediately:

l If you checkedModify the application's settings for all users, the Options dialog box

opens. For more information on the Options dialog box, see the main Dragon Help file.
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l If you checkedModify the administrative settings, the Administrative Settings dialog

box opens. For more information on setting administrative settings under the Roaming,

Miscellaneous, and Scheduled Tasks tabs:
l See Administrative Settings: Roaming tab

l See Administrative Settings: Miscellaneous

l See Administrative Settings: Scheduled Tasks

l If you checkedModify the Auto-formatting options for all users on the Custom Setup

page, the Auto-Formatting dialog box opens. For more information on the Auto-For-

matting dialog box, see the main Dragon Help file.

9. After you click Finish, the installation process displays a screen that allows you to register your

copy of Dragon. There are many benefits to registering Dragon including receiving updates from

Nuance, special deals on product upgrades, and notifications about upcoming product releases.

You can choose to register online, through a printed form, or opt to register at a later time.

Select a registration option and Click OK. If you choose one of the first two options, you are

shown an online registration site or a form that you fill out and print.

10. After you select OK, if you are prompted to restart your computer, restart it now. Otherwise,

skip to the next step.

11. Start the product:

Select Start > All Programs > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking 12.0.

12. If you have User Profiles from Dragon 10.x or 11.x and you chose the Upgrade existing

speech files to work with the installation check box earlier, the User Profile Upgrade
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Wizard opens automatically. Otherwise, if you do not have any User Profiles to upgrade, the

New User Profiles wizard opens automatically so that you can create the first User Profile.

Activating Dragon

The first time you start Dragon, you will be prompted to activate your copy of Dragon. If you do

not activate the software, Dragon will stop working after you start the product fives times.

For more information on activation, please see the Dragon User Guide.
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Enable or disable tutorials during a
custom Dragon installation

You can choose to enable both Dragon interactive tutorial and the language tutorial when you per-

form a custom installation of Dragon.

1. In the Dragon installation wizard, on the Select the program features you want installed

screen, perform one of the following steps:

l To install and enable both the Dragon interactive tutorial and the language tutorial, select

Tutorial Files.

l To turn off both the Dragon interactive tutorial and the language tutorial, click the down

arrow beside Tutorial Files, and select This feature will be installed when required.
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l To install and enable the Dragon interactive tutorial and turn off the language tutorial, click

the down arrow beside <Language> Tutorial and select This feature will be installed

when required.

2. Click Next.
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Sample custom installation of Dragon
Note: This is an example only and is provided to give administrators an overview of a typical

installation and the kind of decisions you have to make. Though the example provides rec-

ommendations it is not meant as a substitute for your own planning.

For more information, see:

n Installation checklists

n Installing Dragon on a single computer

n Step-by-Step Command Line Installation

n Overview of Pushing Client Installation from Server

Preparing for the Roaming feature
1. Create network storage location for Master Roaming User Profiles. For example, you can create

a shared drive that all Dragon end-users will have read/write access to. In this example, we'll

name this shared folderDragon.

2. In the shared Dragon folder, you can create 2 sub-folders; Dragon Profiles and Data Direc-

tory.

l Dragon Profiles is the location for the master copies of the User Profiles. (For

planning purposes allow for 1100 MB per User Profile.)

l Data Directory is the location for custom commands and word lists that auto-

matically update the User Profiles by use of the Data Distribution Tool.

For more information, see Setting up the Roaming feature.

Install Dragon
 To install Dragon NaturallySpeaking on a computer:

1. Insert the first Dragon DVD into your DVD drive or if installing from network drive, click on

setup.exe.

2. When you have the option, choose Custom installation. For example:

Custom lets you select options and User Profiles to install. Customizing your installation

options can greatly reduce the disk space required.

Click Next to continue.

3. On the Additional options screen, select all three options. For example:
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Click Next to continue.

Setting the Dragon Options
When the installation is complete, the three customization dialog boxes will open. The first to

open is the Options dialog box.

Corrections tab:

You use this tab to control how the correction feature and spelling features work.

In this example:

n Check Enable double-click to correct. Selecting this checkbox gives the end-user a way to

correct with the mouse.
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The Commands tab:

You use this tab to set options that control how Dragon interprets commands. Unless otherwise

indicated, changing these options only affects the current end-user; any other end-users keep their

existing settings.

The following example shows the default settings:
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The View tab:

You use the View tab to control the behavior and appearance of the DragonBar and the Results

Box.
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The Hot keys tab:

You use the Hot keys tab to specify hot key assignments.

If your end-users will be using Dragon on a Notebook, then click Microphone on/off and hit

the F10 key to change the hotkey.
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The PowerMic I and II tabs:

If you are using Dragon and you are using a Dictaphone PowerMic for dictation, the Options

dialog box displays the PowerMic I and II tabs. Dragon has built-in support for PowerMic or Pow-

erMic II microphones. You can use the PowerMic II microphone buttons to perform predefined

actions (described in the table below) or program the buttons to take custom actions.

The following example shows the default settings for the PowerMic II:
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The Playback/Text-to-Speech tab:

You use the Playback/Text-to-speech tab to adjust the attributes of text-to-speech and playback.

In this example, increase the Speed slider slightly. The default value is a little too slow. For exam-

ple:
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The Miscellaneous tab:

You use this tab to set miscellaneous options.

In this example

n Leave the Have the microphone on but asleep option unchecked unless the end-user cannot

or does not want to use their hands to turn the microphone on and off.

For example:
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The Dictation Box tab:

On the Dictation tab, you can define how the Dictation Box operates.

You access the Dictation tab by selecting Tools > Dictation Box from the Dragon menu.

For more information on the Dictation Box, see the Using the Dictation Box topic in Dragon

help file.

The following example shows the default settings for the Dictation Box:
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The Data tab:

You use the Data tab to instruct Dragon to store corrections in an archive, conserve disk space

for better portability of User Profiles, and control how Dragon adapts training, saves recorded dic-

tation, and backs up User Profiles.

In this example:

n Set the Automatically back up user profile every "n" saves to nothing if your end-users are

using the Roaming feature. When you have an end-user with a Roaming User Profile, the Master

Roaming User Profile most likely resides on a server that should be backed up every night.

For example:
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Setting the Administrative Options: Roaming User
Profiles
The second dialog to open at the end of the installation is the Administrative Settings dialog box.

This section describes the Roaming tab of the Administrative options dialog box

You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want end-users to dictate

with a Roaming User Profile. For more information, see Administrative Settings: Roaming tab.

In this example:

1. Select Enable to activate the Roaming feature and the Roaming User Profile options.

2. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon. In this
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example, we'll use the network storage location we initially created.
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3. The Administrative Settings dialog box also contains several options that you can choose from

to indicate how you want a Roaming User Profile to function at each Roaming User Profile loca-

tion.

In addition to the default settings, also enable the Access network at user profile

open/close only and Always copy acoustic information to network options. For example:

l

Click OK to continue.

5. You will be prompted to create the default directory if it does not already exist, when you see

the following message, always click Yes:
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Setting the Administrative Options: Miscellaneous
options
When the installation is complete, the three customization dialog boxes will open. The second to

open is the Administrative Settings dialog box. This section describes the Administrative options

dialog box

In this example, click Change... to set the location of the Data Distribution Location to the net-

work directory that you created at the beginning.

Also make sure to deselect the Check for product updates at startup option to disable Dragon

from automatically checking the Nuance web site for product updates if you want to control

which updates your end-users can get.
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Setting the Administrative Options: Scheduled
Tasks 
When the installation is complete, the three customization dialog boxes will open. The second to

open is the Administrative Settings dialog box. This section describes the Scheduled Tasks tab

of the Administrative options dialog box

The following example shows the default settings for the Scheduled Tasks tab:

For more information, see the Dragon Help file.

Setting Auto-Formatting Options
The third dialog to open at the end of the installation is the Auto-Formatting dialog box. For

example, this version of the Auto-Formatting dialog box displays when you are installing a non-

medical edition of Dragon:

To set Auto-Formatting Options
1. Set the Auto-Formatting options.

2. Click Apply to save your changes and leave the Auto-Formatting dialog box open.

3. Click OK to save your changes in the current tab, close the Auto-Formatting dialog box, and

have the changes take effect. Your changes do not take effect until after you close the dialog

box.
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Nuance recommends that you review these tabs to make appropriate choices for your site.
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Post Installation Tasks
Once you have installed or upgraded Dragon, you might want to carry out some of these tasks

before you proceed:

n Cleaning up after uninstalling Dragon

n Dragon File Structure

n Turning off Dragon's use of Microsoft Active Accessibility Service

Cleaning up after uninstalling
Dragon NaturallySpeaking

The following files will remain on your computer after you uninstall Dragon NaturallySpeaking.

C:\Windows\Speech

n VText.dll

n Vdict.dll

n WrapSAPI.dll

n XTel.dll

n Xcommand.dll

n Xlisten.dll

n Xvoice.dll

n spchtel.dll

n speech.cnt

n speech.dll

n speech.hlp

n vcauto.tlb

n vcmd.exe

n vcmshl.dll

n vtxtauto.tlb

Dragon installs these files for Microsoft SAPI4 support. If you do not have other speech appli-

cations that require SAPI4, you can safely remove these files manually. If have installed other

speech applications that require SAPI4 support, you may need to re-install those applications if

you remove the files.
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Dragon file structure
Upgrading Dragon automatically relocates some directories and files.

The following directory structures and file locations assume an installation to a default location.

V10 Windows 2000/XP Pro/XP Home/Windows Server
2003 directory structure

The V10 directory structure on Windows 2000/XP Pro/XP Home/Windows 2000 Advanced

Server/Windows Server 2003 before upgrading Dragon:

C:\Program Files\Nuance\NaturallySpeaking10

\Ereg

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking10\

\Custom

\Data

\Data\Training

\Users

C:\Documents and Settings\<username>\Application Data\N-

uance\NaturallySpeaking10\

\Results

V10 Windows Vista and Windows 7 directory structure

The V10 directory structure on Windows Vista before upgrading Dragon:

C:\Program Files(x86)\Nuance\NaturallySpeaking10

\Ereg

\Help

\Program

\Tutorial (optional)

C:\ProgramData\Nuance\NaturallySpeaking10\

\Custom

\Data

\Data\Training

\Users

C:\Users\<-

username>\AppData\Roaming\Nuance\NaturallySpeaking10\

\Results
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Dragon Windows XP Pro/XP Home/Windows Server
2003 directory structure

The Dragon directory structure on Windows XP Pro/XP Home/Windows Server 2003:

C:\Program Files\Nuance\NaturallySpeaking11

\Ereg

\Help

\Program

\Tutorial (optional)

C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking11\

\Custom

\Data

\Data\Training

\Users

\RoamingUsers

C:\Documents and Settings\<username>\Application Data\N-

uance\NaturallySpeaking11\

\results

Dragon on Windows Vista, Windows 7 and Windows
Server 2008 directory structure

The Dragon directory structure on Windows Vista and Windows 7:

C:\Program Files(x86)\Nuance\NaturallySpeaking11

\Ereg

\Help

\Program

\Tutorial (optional)

C:\ProgramData\Nuance\NaturallySpeaking11\

\Custom

\Data

\Data\Training

\Users

C:\Users\<-

username>\AppData\Roaming\Nuance\NaturallySpeaking11\

\results

Dragon 12 on Windows Vista, Windows 7, and Windows
Server 2008 directory structure

The Dragon 12 directory structure on Windows Vista, Windows 7 and Windows Server 2008:
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C:\Program Files(x86)\Nuance\NaturallySpeaking12

\Ereg

\Help

\itutorial

\Program

\Tutorial

C:\ProgramData\Nuance\NaturallySpeaking12\

\BadUsers

\Data

\RoamingUsers

\upgrade_data

\Users

C:\Users\<username>\AppData\Roaming\Nuance

\NaturallySpeaking12\results
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Turning off Dragon's use of Microsoft Active
Accessibility Service

Dragon NaturallySpeaking use Microsoft Active Accessibility Service to let you control certain

menus and dialog boxes by voice. Without Microsoft Active Accessibility Service, you would be

unable to use Dragon to select menu commands and dialog box controls with your voice.

If you don't need to control the menus and dialog boxes by voice, you can speed up Dragon per-

formance by turning off Microsoft Active Accessibility Services.

To turn off Active Accessibility Services in Dragon for
all applications

1. Open the Options dialog box by selecting Tools > Options on the DragonBar.

2. Click theMiscellaneous tab.

3. Clear the Voice enable menus, buttons, and other controls, excluding box if it is selected.

4. Click OK. You will need to exit and re-start Dragon for this change to take effect.

Use a command line to turn off Active Accessibility in
Dragon for specific applications

1. Exit Dragon.

2. Open nssystem.ini in a text editor. In Windows XP, by default, nssystem.ini is located in:

C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12

See Dragon file structure for information on Dragon paths in other Windows operating

systems.

3. Under [MSAAModules Disabled], add a line similar to the following for each application

where you want to disable the use of Active Accessibility Services:

<executable_name>=1

4. Save and close nssystem.ini.

5. Re-start Dragon.

For example, to disable Dragon use of Active Accessibility Services in Microsoft Word and Micro-

soft Excel, you would add the following lines to nssystem.ini:

[MSAA Modules Disabled]

winword=1

excel=1
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Note: If you do not know the name of an application's executable file, you can start the appli-

cation from the Windows Start menu and then use the Windows Task Manager to view the list of

current Windows applications. The executable names are listed under Image Name on the Proc-

esses tab. You can also right-click the application's icon and select the shortcut tab—the Target

field will provide the name of the executable.

Use a GUI to turn off Active Accessibility in Dragon for
specific applications

1. On the Dragon Bar, select Tools > Options.

2. Select theMiscellaneous Tab.

3. Check the Voice-enable menus, buttons, and other controls, excluding option.

4. Below the Voice-enable menus, buttons, and other controls, excluding option, open the

drop-down list. The list contains installed and running applications, and also the following static

applications:

- Microsoft Outlook

- Lotus Notes

- Internet Explorer

- Microsoft Word

- Microsoft Excel

- WordPerfect

5. To turn off Active Accessibility for an application, place a check mark beside the application.

6. Click OK.
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Enhancing the privacy of patient data

When an end-user dictates with Dragon NaturallySpeaking, Dragon automatically saves all audio

and transcribed text in Dragon Recorded Audio (.DRA) files. If the end-user corrects any of the

dictated text, Dragon automatically stores these corrections in .enwv files. Both these files are

saved in the background.

These automatically created .DRA and .enwv files are used by Dragon to optimize the User Pro-

file. For example, Dragon uses these files when an end-user runs the Acoustic and Language

Model Optimizer.

Dragon encrypts these automatically created .DRA and .enwv files before storing them in the

local or Roaming User Profile directories to ensure they do not become a back door into patient

data and violate the patient's privacy. These files are also encrypted when an end-user dictates into

a supported application like Microsoft Word or an Electronic Medical Record (EMR) application.

Due to the restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv

files can only be opened by Dragon for its internal use. For example, they cannot be accessed by

the non-Medical versions of Dragon, the Dragon NaturallySpeaking SDK Client Edition (DSC), or

the Dragon NaturallySpeaking SDK Server Edition (DSS). In addition, any encrypted .DRA and

.enwv files automatically created by Dragon, cannot be opened in DragonPad.

Notes:

n Dragon does not encrypt .DRA files explicitly saved by an end-user. For example, if an end-user

saves recorded dictation when saving a document (for example, in Word, WordPerfect, or

DragonPad), these saved .DRA files are unencrypted. The end-user that created these files has

the responsibility of saving these files in a secure location.

n Nuance does not guarantee that the file encryption provided in Dragon will ensure total HIPAA

compliance. Other security measures are required for full compliance.

Security Considerations
As long as other adequate security protections are in place to protect patient data, you can avoid

saving excess patient data by choosing to:

1. Turn off encryption of patient data (not recommended)

2. Turn off creation of .DRA files and set options to conserve disk space, resulting in fewer saved

files

3. Turn off creation of unencrypted .nwv files

Turning on/off encryption of patient data

It is possible to turn off the encryption of these background speech recognition files by un-check-

ing the Encrypt Patient Health Information check box in the Miscellaneous tab of the Administrative

Settings Dialogue.

Nuance can not guarantee HIPAA compliance when this feature is turned off.
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For more information, see the Miscellaneous tab of the Administrative Settings dialog box.

Turning on/off creation of .dra patient data files

You can choose to turn off creation of the .DRA files containing patient data to further protect

the patient's privacy when other security measure are in place, by:

n Turning off data collection, which sends data to Nuance for future product improvements. The

check box to enable/disable data collection is on the Scheduled Tasks tab of the

Administrative Settings dialog box. For more information, see:

l About Data Collection and Other Scheduled Tasks

__and

n Checking settings to conserve disk space, which automatically stops creating files that require

large amounts of storage space:

i. On the DragonBar, select Tools > Options and click the Data tab.

ii. Check the Conserve disk space required by user profiles (for portability) option. For

more information on the Data tab of the Options dialog box, refer to the main Dragon

Help file's topic on the Data tab in the Options dialog box.

Turning on/off creation of unencrypted text correction .nwv archive
files

To further ensure privacy, any end-user can turn of creation of archive files that might contain

patient data:

1. On the DragonBar, select Tools > Options and click the Data tab.

2. Uncheck the Store correction in archive option. For more information on the Data tab of the

Options dialog box, refer to the main Dragon Help file's topic on the Data tab in the Options

dialog box.
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This section contains information on how to upgrade Dragon and Roaming User Profiles, as well as how
to upgrade third-party Vocabularies. You can update Dragon 10.x and 11.x User Profiles to Dragon Nat-
urallySpeaking .

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or
earlier to Dragon 12 is not supported.

Upgrading Dragon 102

Installing on or upgrading to Windows Vista or Windows 7 104

Upgrading multiple User Profiles 105

Preparing to upgrade Roaming User Profiles 111

Upgrading master Roaming User Profiles 114

Upgrading end-user systems 119
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Upgrading Dragon
An administrator performs the following steps to upgrade a User Profile from Dragon 10.x or 11.x

to Dragon NaturallySpeaking :

n Prepare to upgrade:
n Based on the version of Dragon being upgraded from, determine how to proceed

(see What you should know before upgrading from a previous version)

n If upgrading to Windows Vista or Windows 7, see Installing on or upgrading to

Windows Vista or Windows 7

n Carry out one of these procedures:
n Upgrade multiple User Profiles (see Upgrading multiple User Profiles)

n Upgrade Roaming User Profiles (see Upgrading Roaming User Profiles )

n Upgrade User Profiles with custom or customized vocabularies (see Upgrading User

Profiles with Custom and Customized Vocabularies )

Administrators can work with the User Profile Upgrade Wizard (see Upgrading multiple User

Profiles)

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon

9.x or earlier to Dragon 12 is not supported.

Note: If upgrading from Dragon version 8.x or earlier to Dragon NaturallySpeaking , version 8.x

or earlier custom words and commands can be re-used in Dragon NaturallySpeaking :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon NaturallySpeaking , create a new User Profile

3. In Dragon NaturallySpeaking , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.

What you should know before upgrading from a previous version

An administrator can upgrade to Dragon NaturallySpeaking from Dragon NaturallySpeaking version

10.x or 11.x by following the installation instructions for Dragon NaturallySpeaking, but first, be

sure to:

n Uninstall the previous version, when it is required for the version the administrator is upgrading

from.

n Retain existing User Profiles, to be updated after the installation completes.

n Check that it is possible to upgrade from the existing edition to the edition the administrator is

installing.
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See "Upgrading User Profiles to Dragon NaturallySpeaking" in Dragon - What's New for admin-

istrators for more information.

Upgrading from Dragon 10.x

Uninstall Dragon version 10.x before installing Dragon NaturallySpeaking .

Upgrading from Dragon 11 or 11.5 to Dragon 12

Uninstall Dragon version 11.x before installing Dragon NaturallySpeaking .

Edition considerations

An administrator must upgrade to the same edition or greater and to the same language.

For example, if upgrading from Dragon 10.x German/English to Dragon NaturallySpeaking . Eng-

lish only, the Dragon 10.x German User Profiles are not upgraded. Upgrading to Dragon Ger-

man/English upgrades both German and English User Profiles. After upgrading, an administrator

can install other Dragon languages.

Notes:

n If an end-user is using Dragon version 8.x or earlier, they can re-use custom words and

commands in Dragon NaturallySpeaking :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon NaturallySpeaking , create a new User Profile

3. In Dragon NaturallySpeaking , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.

n When an administrator installs Dragon NaturallySpeaking , Dragon installs using the primary

language for the product. An administrator cannot install Dragon using a language that is

different than the primary language. For example, if an administrator installs Dragon , English

version, Dragon installs using the English language. If the administrator attempts to use the /l
option with setup.exe to install Dragon using a non-primary language, the installation process

uses the primary language for that edition of Dragon and ignores the /l option.
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Installing on or upgrading to
Windows Vista or Windows 7

Dragon NaturallySpeaking version 9.5 and higher are compatible with several editions of Windows

Vista and Windows 7. Dragon runs on 32-bit and 64-bit computers for these operating systems.

You cannot install Dragon NaturallySpeaking 12 on Windows Vista SP 1 or earlier, Windows XP SP

2, Windows 2000, Windows 2000 Server, Windows Server 2003, and Windows XP 64-bit.

Earlier versions of Dragon (version 8.x, 9.0, 9.1) will not install or run on Windows Vista or Win-

dows 7.

Note: You can only upgrade from Dragon 10.x or greater to Dragon NaturallySpeaking 12.

Upgrading from Dragon 9.x or earlier is not supported.

Upgrade considerations
If you upgrade a computer from a previous version of Windows to Windows Vista or Windows 7,

and that computer has Version 8.x, 9.x, or 10.x of Dragon installed, that version of Dragon will not

work after upgrading to Windows Vista or Windows 7.

All your User Profiles from these previous versions remain intact and can be upgraded when you

install Dragon NaturallySpeaking.

See "Upgrading User Profiles to Dragon NaturallySpeaking" in Dragon - What's New for admin-

istrators for more information.

Roaming User Profiles in an MSI Installation on
Windows Vista or Windows 7
For more on carrying out an MSI installation on Windows Vista or Windows 7, see Modifying

Roaming User Profile, Miscellaneous, Schedule Settings in the INI File.
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Upgrading multiple User Profiles
You use the User Profile Upgrade Wizard to upgrade a Dragon 10.x or 11.x User Profile to Dragon

NaturallySpeaking 12. You do not need to upgrade Dragon 11 User Profiles to Dragon 11.5.

There are two ways you can start the User Profile Upgrade Wizard:

n In the Open User profile dialog box, select a User Profile to upgrade. Dragon displays a dialog

that gives you the option of upgrading the User Profile now (by pressing OK) or upgrading the

User Profile later (by pressing Cancel). If the end-user selects OK. Dragon displays the User

Profile Upgrade Wizard.

n In the Start menu, select Programs > Dragon NaturallySpeaking 12.0 > Dragon

NaturallySpeaking Tools > Upgrade User Profiles. Dragon displays the User Profile

Upgrade Wizard.

Using the User Profile Upgrade Wizard
The User Profile Upgrade Wizard guides you through the process of upgrading User Profiles from

Dragon 10.x and 11.x.

The wizard cannot upgrade User Profiles created by versions of Dragon prior to Dragon 10.x.

User Profile Upgrade Wizard: Select the profile(s)
to upgrade
On the Select the profile(s) to upgrade page, you see these elements:

User profiles to upgrade

This screen displays the location and name of all the User Profiles that the wizard will upgrade.

Modify the list of User Profiles to include all User Profiles that you want to upgrade. The wizard

starts by including all the User Profiles in the current folder as candidates to upgrade. You add

User Profiles to the list by clicking the Browse to add a profile button and browsing for addi-

tional User Profiles in other locations. You remove User Profiles from the list by selecting them

and clicking the Remove from list button. Once the list of User Profiles contains the profiles

you want to upgrade, click Next.

Note: If you have end-users with roaming User Profiles in your network, see Upgrad-

ing Roaming User Profiles: Overview

Current Location

The location of the User Profiles to upgrade.

User Profile

Displays the names of all the User Profiles to upgrade.

Total profiles to be upgraded

Displays the total number of User Profiles to upgrade.
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Browse to add a profile

Opens a Browse for Folder window that you use to locate additional User Profiles for the wizard

to upgrade.

Remove from list

Deletes the User Profile you select from the User Profile Upgrade Wizard.

Once you have made a selection, click Next.

If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete.

If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

User Profile Upgrade Wizard: Choose where to store
the upgraded profile(s)

As the User Profile Upgrade Wizard updates a User Profile to Dragon NaturallySpeaking, the wiz-

ard can move a copy of the upgraded User Profile to another location without modifying the old

profile. This allows you to use the original profile if you need to and makes the profile compatible

with operating systems like Windows XP that store all end-user data in the Documents and Set-

tings folder.
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Location for upgraded profile(s)

Click the Browse button or select a new destination from the list if you want to choose a des-

tination other than the suggested destination. You must have read and write access to the location.

Advanced

Click the Advanced button to open the Advanced Options dialog box where you can change

how the wizard upgrades the User Profile.

User Profile Upgrade Wizard: Advanced Options

The Advanced Options dialog box lets you make finer adjustments to how the wizard upgrades

User Profiles.

User profiles to

The User profiles to list box provides information about the location, vocabulary, and the acous-

tic model for each profile you plan to update.

Attribute Name Old Value New Value

Location The name of the User
Profile.

The current location of the
User Profile.

The location where Dragon
will place the updated User
Profile.

Vocabulary The name of the current
vocabulary for the User
Profile.

The name of the base vocab-
ulary for the current vocab-
ulary.

The name of the new base
vocabulary for the current
vocabulary.

Acoustic
model

The name of the audio
input device for the User
Profile.

The name of the current lan-
guage/voice model for the
User Profile.

The name of the new lan-
guage/voice model for the
User Profile.

Setting a location for an upgraded User Profile

When you click on the Location line in the User profiles to list box, Dragon enables the New

Location text box. The text box displays the location that the wizard recommends or that you

chose on the Choose where to store the upgraded profile(s) page. You can click Browse and

choose a new location. You must have read and write access to the location.

Setting a new base vocabulary for a User Profile

When you click on the Vocabulary line in the User profiles to list box, Dragon enables the

New Base Vocabulary text box. The text box displays the current vocabulary of the User Profile

or the one that the User Profile Upgrade Wizard assigns to the upgraded User Profile if Dragon

does not support the old vocabulary.

You can select a new base vocabulary from the drop-down list.

Setting a new acoustic model for a User Profile

When you click on an Acoustic model line in the User profiles to list box, Dragon displays the

New Acoustic Model text box. The text box displays the current language (such as US English),
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language model, and accent of the User Profile. You can choose a new acoustic model from the

drop-down list.

After you modify the information for each User Profile in the list box, click OK to return to the

wizard, and click Next to proceed.

User Profile Upgrade Wizard: Begin profile
upgrading
On the Begin profile upgrading page, click Begin upgrading to start the upgrade process. The

wizard requires approximately 12 to 24 minutes to upgrade each User Profile.When the process is

complete, click Finish.

If the User Profile Upgrade wizard starts automatically after you upgrade and start Dragon, the

Open User Profile window opens and displays a list of the User Profiles you can choose from to

begin dictation.

Upgrading Roaming User Profiles: Overview

This section describes how to upgrade Roaming User Profiles from Dragon NaturallySpeaking 10.x

or 11.x to Dragon NaturallySpeaking .

When you use the Roaming feature, each Dragon User Profile has a master Roaming User Profile

that can be opened from multiple networked computers where Dragon is installed. These master

Roaming User Profiles are stored on a network location made accessible to your Dragon users. 

When a master Roaming User Profile is opened from that central network location, Dragon trans-

fers a copy of that profile to the Local Roaming User Profile on the local computer.

Since the Local Roaming User Profile is a copy of the User Profile data taken from the master

Roaming User Profile, you cannot directly upgrade the Local Roaming User Profile when you

upgrade the local Dragon installation from Dragon 10.x or 11.x to Dragon NaturallySpeaking .

Notes:

n You can only upgrade from Dragon 10.x or greater to Dragon 12 Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported.

n If upgrading from Dragon version 8.x or earlier to Dragon NaturallySpeaking , version 8.x or

earlier custom words and commands can be re-used in Dragon NaturallySpeaking . See the

Dragon Help for information on exporting and importing custom words and commands. 

i. In Dragon 8.x or earlier, export the custom words and commands

ii. In Dragon NaturallySpeaking , create a new User Profile

iii. In Dragon NaturallySpeaking , import the custom words and commands

n Upgrading a set of Dragon 10.x or 11.x master Roaming User Profiles to Dragon

NaturallySpeaking leaves the Dragon 10.x or 11.x master Roaming User Profiles unchanged and

intact. This allows the end-users in your network to run Dragon 10.x or 11.x while you plan

your upgrade.

n Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by

end-users, for example during the night or on a weekend.
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n Even though the Dragon NaturallySpeaking User Profile Upgrade Wizard supports both mapped

drives and UNC paths, Nuance strongly recommends that you upgrade your Master Roaming

User Profiles on a drive on a computer where Dragon NaturallySpeaking is locally installed.

Nuance does not recommend that you upgrade your Master Roaming User Profiles across a

network to either a mapped drive or UNC path; upgrading over a network will take an

undetermined length of time. In addition, the User Profile Upgrade Wizard does not support

upgrading User Profiles over an HTTP connection.

Step 1: Preparing to upgrade Roaming User Profiles

To upgrade your Master Roaming User Profiles from a previous version of Dragon, Nuance rec-

ommends that you install Dragon NaturallySpeaking directly on the network computer where the

Dragon 10.x or 11.x Master Roaming User Profiles are located and upgrade those Master Roaming

User Profiles directly to Dragon NaturallySpeaking Master Roaming User Profiles.

If you are unable to install Dragon where your Dragon 10.x or 11.x Master Roaming User Profiles

are located, Nuance recommends that you:

1. Install Dragon NaturallySpeaking on a separate computer where you will perform the upgrades.

2. Copy the Dragon 10.x or 11.x Master Roaming User Profiles from their network location to the

computer where Dragon NaturallySpeaking is installed.

3. Upgrade the Dragon 10.x or 11.x Master Roaming User Profiles on the computer where Dragon

NaturallySpeaking is installed.

4. Copy the upgraded Dragon NaturallySpeaking Master Roaming User Profiles to a network acces-

sible directory on the original network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles

As administrator you must separately upgrade the master Roaming User Profiles to Dragon Nat-

urallySpeaking using the User Profile Upgrade Wizard.

After you upgrade the Dragon 10.x or 11.x Master Roaming User Profiles, you can then proceed

to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems
After you have upgraded the master Roaming User Profiles, you can then proceed to upgrade end-

user systems that deploy the Roaming feature.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon

9.x or earlier to Dragon 12 is not supported.

For more information:

See Upgrading end-user systems.
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See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.
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Preparing to upgrade Roaming User
Profiles

Step 1: Install Dragon NaturallySpeaking on the
computer where you upgrade the Dragon 10.x or
11.x Master Roaming User Profiles
Nuance recommends that administrators install Dragon NaturallySpeaking on the computer where

the Dragon 10.x or 11.x Master Roaming User Profiles are located. If that is not possible, Nuance

recommends that administrators install Dragon NaturallySpeaking on a separate computer where

they will perform the upgrades.

For more information on installing, see Installing Dragon on a single computer.

Notes:

n If during the installation or upgrade, you see the Upgrade existing speech files to work with

this installation prompt, be sure to leave this option unchecked. You can manually running

the User Profile Upgrade Wizard in a later step.

n If you are unable to install Dragon where the Dragon 10.x or 11.x Master Roaming User Profiles

are located, Nuance recommends that you install Dragon NaturallySpeaking on a separate

computer where you perform the upgrades. For more information, see Upgrading Roaming User

Profiles: Overview.

n You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

n If upgrading from Dragon 8.x or earlier to Dragon NaturallySpeaking , version 8.x or earlier

custom words and commands can be re-used in Dragon NaturallySpeaking . See the Dragon

Help for information on exporting and importing custom words and commands:

i. In Dragon 8.x or earlier, export the custom words and commands

ii. In Dragon NaturallySpeaking , create a new User Profile.

iii. In Dragon NaturallySpeaking , import the custom words and commands

Step 2: On the Dragon 10.x or 11.x end-user
systems that use the Roaming feature
On the end-user systems where the end-users dictate using the Dragon 10.x or 11.x Roaming fea-

ture, save and close any open User Profiles on each Dragon 10.x or 11.x system that uses the Roam-

ing feature.

Note: If there is no time when all the Roaming User Profiles are not in use (for example, in a hos-

pital where some physicians use Dragon during a night shift), administrators can upgrade different

groups of Roaming User Profiles at different times.
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Step 3: On the central network storage location for
the Dragon 10.x or 11.x Master Roaming User
Profiles
1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any

system backup utility that is implemented at your facility or by using the Dragon TheManage

User Profiles dialog.

Note: You do not need to back up the Roaming User Profiles because the upgrade retains the

Dragon 10.x or 11.x User Profiles in a directory that is separate from the Dragon Nat-

urallySpeaking User Profiles.

2. Create a new directory on the shared network drive to store the upgraded Dragon Nat-

urallySpeaking Master Roaming User Profiles. Although you can store the upgraded User Pro-

files in the same location as the current User Profiles — this would make two versions of each

User Profile visible to the end-user and lead to confusion — Nuance recommend creating a loca-

tion that is different from the location that stores the current (Dragon 10.x or 11.x) User Pro-

files.

Step 4: Copy the Dragon 10.x or 11.x Master
Roaming User Profiles to the Dragon
NaturallySpeaking client computer
If you install Dragon NaturallySpeaking on the computer where the Dragon 10.x or 11.x Master

Roaming User Profiles are located, then proceed to Step 5 below.

If Dragon NaturallySpeaking is not installed on the computer where the Dragon 10.x or 11.x

Master Roaming User Profiles are located, perform the following steps on the Dragon Nat-

urallySpeaking client computer:

1. Create a directory to store all the Master Roaming User Profiles you plan to upgrade.

2. Copy the Dragon 10.x or 11.x Master Roaming User Profiles from the network location to the

directory.

Step 5: On the administrator system where you
plan to upgrade the Dragon 10.x or 11.x Master
Roaming User Profiles
1. Start Dragon and make sure the Roaming feature is off.

To turn off the Roaming feature:

i. Close any open User Profiles.

ii. Click Administrative Settings on the DragonBar Tools menu. This action dis-

plays the Administrative Settings dialog box.

iii. On the Roaming tab, make sure Enable is not selected.
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2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.
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Upgrading master Roaming User
Profiles

You must use the User Profile Upgrade Wizard to upgrade Dragon 10.x or 11.x master Roaming

User Profiles to Dragon NaturallySpeaking .

Before you proceed with the tasks in this topic, complete the procedure in Preparing to upgrade

Roaming User Profiles.

After you upgrade the Dragon 10.x or 11.x Master Roaming User Profiles and optionally copy

them back to their network location, you can proceed to upgrade your end-user systems that use

the Roaming feature. For more information, see Upgrading end-user systems.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

Step 1: Upgrade the Dragon 10.x or 11.x Master
Roaming User Profiles
On the computer with the Dragon 10.x or 11.x Master Roaming files and where Dragon Nat-

urallySpeaking is installed:

1. Select Start > Programs  > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking Tools > Upgrade User Profiles.

2. On the Select the profile(s) to upgrade page, click Browse to add a profile to select the

location of the Dragon 10.x or 11.x Master Roaming User Profiles. The Select the profile(s) to

upgrade page now displays a list of User Profiles in the selected directory:
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Continue to add User Profiles from other local locations or use the Remove from list button to

remove specific User Profiles. Click Next to continue.
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3. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete the upgrade.

4. If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

5. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded

profile(s) text box, choose the local location you previously created to contain the upgraded

Dragon NaturallySpeaking master Roaming User Profiles. If a location is not visible, click
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Browse, find the correct location, and click Next.

6. The Begin profile upgrading page displays the number of User Profiles that the wizard is pre-

pared to upgrade.

Click Begin upgrading to start the upgrade process. The upgrade process can take 2-3 min-

utes or more per User Profile, depending on the speed of the computer system and the speed of

the network. Click Stop at any time to interrupt this process. The upgrade process creates new

master Roaming User Profiles in the destination you selected.

7. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard names each Dragon NaturallySpeaking master Roaming User

Profile as follows: <name> (v12). For example, Dragon copies and upgrades a Dragon 10.x
Master Roaming User Profile with a filename of roaminguser1 to roaminguser1 (v12). Dragon does not

change the name of the Dragon 10.x Master Roaming User Profile.

Do no store the Dragon 10.x or 11.x Roaming User Profiles in the same directory as the upgraded

Dragon NaturallySpeaking Roaming User Profiles. The Open User Profile dialog box displays all

the Dragon 10.x and 11.x profiles. A Dragon end-user may not be sure of the profile they should

select for dictation.

Step 2: Clean up the Dragon 10.x or 11.x locations
for master Roaming User Profiles (optional) 
When the User Profile Upgrade Wizard modifies the Dragon 10.x or 11.x master Roaming User

Profiles, it create a copy of the upgraded User Profile and does not change the original profiles.

This ensures the original profiles are available in case someone requires them.
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An administrator can optionally rename or remove the Dragon 10.x or 11.x master Roaming User

Profiles through theManage User Profiles dialog box.

Step 3: Copy the Dragon NaturallySpeaking Master
Roaming User Profiles to their network location
(Optional)
If you were unable to install Dragon NaturallySpeaking where you store the Dragon 10.x or 11.x

Master Roaming User Profiles, and you instead copy them to a different computer with Dragon

NaturallySpeaking installed, you must now copy the Dragon NaturallySpeaking Master Roaming

User Profiles back to the new network directory. This is the directory you created on their original

network location.

You can skip this step if you installed Dragon NaturallySpeaking on the computer where the

Dragon 10.x or 11.x Master Roaming User Profiles are located and you upgraded those Master

Roaming User Profiles directly to Dragon NaturallySpeaking .

Step 4: Upgrade end-user systems to Dragon
NaturallySpeaking
After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that

use the Roaming feature.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported.

For more information, see Upgrading end-user systems.
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Upgrading end-user systems
After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that

use the Roaming feature.

Before proceeding with this section, make sure you perform the procedure in Upgrading master

Roaming User Profiles.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon

9.x or earlier to Dragon 12 is not supported.

Step 1: Upgrade Dragon 10.x or 11.x systems that
use the Roaming feature
Since the User Profile Upgrade Wizard does not change or move the Dragon 10.x or 11.x

master Roaming User Profiles, your Dragon 10.x or 11.x systems can continue to use the Roaming

feature until you upgrade to Dragon NaturallySpeaking .

To upgrade a Dragon 10.x or 11.x system to Dragon NaturallySpeaking , follow the installation

instructions under Installing Dragon on a single computer .

Notes:

n When prompted, choose to remove the Dragon 10.x or 11.x Dragon installation. If you choose

not to remove the previous installation, you cannot continue to upgrade.

Step 2: Enable the Roaming feature on the Dragon
systems

When you upgrade to Dragon NaturallySpeaking , the Roaming feature is off by default.

To turn on the Roaming feature, perform the following steps on each Dragon NaturallySpeaking

client computer:

1. Start Dragon.

2. Close all User Profiles.

3. Click Administrative Settings on the DragonBar Tools menu. This displays the Admin-

istrative Settings dialog box.

4. On the Roaming tab, select Enable.

5. The Network Directories list displays the network location of the Dragon 10.x or 11.x master

Roaming User Profiles.

If you created a new network directory for the Dragon NaturallySpeaking master Roaming User

Profiles, you can either click the Add button to add the new network location or select a listed

directory and then click Edit to change the path to the new location. When you have finished,

click OK to close the Administrative Settings dialog box. You should also remove any Dragon

10.x or 11.x master Roaming User Profile directories that are not in use.
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6. Select Profile > Open User Profile on the DragonBar. This action displays the Open User

Profile dialog box. If you allow end-users to select both non-roaming local and Roaming User

Profiles, make sure they select the correct location (the Dragon NaturallySpeaking Roaming

User Profile location) from the Location of user profile field.

7. Select a User Profile and click Open.

Note: If you did not upgrade the Roaming User Profiles and store them in the new master Roam-

ing User Profile directory, when you click Open, the User profile needs to be upgraded

dialog box appears. Since you cannot upgrade Roaming User Profiles locally, you should click Can-

cel and return to Upgrading master Roaming User Profiles. If you click OK instead of Cancel,

you receive a message stating You cannot upgrade a roaming user because you cannot upgrade

Roaming User Profiles on a workstation where the Roaming feature is on.

Upgrading User Profiles that use third-party vocabularies

Vocabularies Created by a Third Party (other than by
Nuance)

Note: Any installation can use vocabularies that are not provided by Nuance, but

created by a third party specifically for a particular installation.

Using a custom vocabulary from Dragon 10.x or
earlier with Dragon 12
You cannot use a custom vocabulary created in Dragon 10.x or earlier with Dragon 12. You must

recreate the custom vocabulary in Dragon 12. If you have a custom vocabulary from a Nuance

VAR, you should contact the VAR to obtain a new version of the vocabulary.

Upgrading User Profiles with third party
vocabularies
When you upgrade a User Profile whose base vocabulary was created by a third party, all custom

words and other changes to that vocabulary will be maintained but the vocabulary's base type will

be changed. For example, Dragon 10.x or 11.x User Profiles that use the US English | Large |

Nuance vocabulary with a topic ID of 9005 are upgraded to use the General—Medium vocab-

ulary; that upgraded User Profile's vocabulary also contains all customizations in the Dragon 10.x

or 11.x vocabulary.

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.

To further modify and re-distribute customizations to vocabularies created by third parties, you

can follow the steps outlined below on your Dragon NaturallySpeaking User Profiles.
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Step 1: Export custom words added to the custom
vocabulary

If you added any additional custom words to the vocabulary created by a third party, you must

first export those words. To export custom words:
n On the DragonBar menu, select Vocabulary > Export custom word and phrase

list. This action displays the Export Custom Words dialog box.

n Enter the path and name of the file containing the custom words to add to the

vocabulary that you want to create, or use Save in list to find a location for the file you

want to create.

Step 2: Upgrade a User Profile that uses a custom
vocabulary

To upgrade Dragon 10.x or 11.x User Profiles with a third party vocabulary:

1. Run the User Profile Upgrade Wizard. To run the wizard, select Dragon Nat-

urallySpeaking 12.0 > Dragon NaturallySpeaking Tools > Upgrade User Profiles.

2. In the User Profile Upgrade Wizard, select a Dragon 10.x or 11.x User Profile that uses a

vocabulary from a third party.

3. Click Next and follow the on-screen prompts.

The User Profile Upgrade Wizard displays the original vocabulary deployed to create the User

Profile and lets you choose a Dragon NaturallySpeaking base vocabulary that the User Profile

Upgrade Wizard should assign to the upgraded User Profile.

Step 3: Import custom words to the upgraded User
Profile

If you exported words in Step 1, you now must import those words. To import a word list:

1. On the DragonBar, click Vocabulary > Import list of words or phrases. This displays the

Add Words fromWord Lists wizard.

2. Click Next to add the file you created in Step 1.

Step 4: Export the customized vocabulary

You can share vocabularies among different User Profiles by first exporting a vocabulary from one

User Profile and then importing it to a new User Profile. Use the following procedure to export a

vocabulary. To export a vocabulary:

1. Create a folder in which to save the exported vocabulary files.

2. Open the upgraded Dragon 10.x or 11.x User Profile that uses the custom vocabulary.
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3. On the DragonBar, select Vocabulary >Manage Vocabularies or say "Manage Vocab-

ularies."

4. In theManage Vocabularies dialog box, select the vocabulary you want to export and then

export it.

5. Locate and open the target folder, enter a name for the exported vocabulary in the File Name

box, and then save it.

6. In theManage Vocabularies dialog box, click or say "Close" to save and close it.

Note: Exporting a vocabulary creates a copy of the four files that make up the vocabulary in the

new location. You can access these files via the Data Distribution Tool or the nsadmin tool to

create new custom base vocabularies.

Step 5: Use nsadmin or the Data Distribution tool to
copy the vocabulary you export

Using the nsadmin command line or the Data Distribution Tool, you can import the vocabulary

you created in Step 2 as a base vocabulary on any Dragon installation.

Once you add a base vocabulary to a Dragon installation, you can then use the new vocabulary to

create new User Profiles or add a new vocabulary to an existing User Profile.

When you run nsadmin or the Data Distribution Tool to import the exported vocabulary to

your Dragon installation, be sure to give the new vocabulary the same name and topic ID that the

Dragon 10.x or 11.x customized vocabulary had.

For example, if your Dragon 10.x or 11.x custom vocabulary was named US English | Large |

Nuance topic ID 9005, you would use nsadmin or the Data Distribution Tool to create a new

base vocabulary with that same name and topic ID number.
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using the Windows installer

(MSI)

This section provides information on using MSI files to install Dragon over a network, modifying Roam-
ing User and other options, using .ini file to install Dragon with a specific configuration, creating and
using MST files to install Dragon, installing Dragon from a command-line using natspeak.exe or msiex-
ec.exe, upgrading Dragon and Roaming User Profiles from the command-line, and other related topics.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or
earlier to Dragon 12 is not supported.
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Natspeak.exe command line reference 163
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Overview of Installing Dragon using
the Windows Installer (MSI)

Dragon NaturallySpeaking includes a native Windows Installer (MSI) that lets you customize your

installations as well as install across a network to multiple client computers. In addition, you use

this service to modify, repair, or remove any existing installations.

Although you have several choices when deciding how you want to install Dragon Nat-

urallySpeaking on the command line, Nuance recommends that you follow the approach presented

initially in this document.

You can use this procedure to install the software on one computer at a time or combine it with

Systems Management Server (SMS) or Windows Active Directory Service to install the software

across a network to multiple client computers. Also, if you have already installed the product, you

use this process to upgrade, modify, repair, or remove any existing installations.

Before You Begin
To ensure a smooth installation, before you proceed, you should gather the following information

regarding your network and Dragon settings.

n Preferred settings for Dragon options, including any PowerMic or PowerMic II button actions

to be programmed. You set these settings in the Options dialog box of Dragon.

n Preferred settings for Dragon Windows Auto-Formatting options to be applied to the

recognized text. You set these settings in the Auto-Formatting dialog box of Dragon.

n Path to and/or mapped drive of the location where Roaming User Profiles are stored or are

going to be stored, are normally set in the Network Settings sub-dialog of the Roaming tab in

the Administrative Settings dialog box.

n Information about your http or https connection to the Roaming User Profiles storage location,

if applicable, normally viewed in the Roaming User Network Location sub-dialog of the

Administrative Settings dialog box, accessible when clicking on “Add” for a Network

Directory.

n Preferred settings for collecting dictation data to be sent back to Nuance Communications for

improving the future accuracy of Dragon, are normally set under the Scheduled Tasks tab of

the Administrative Settings dialog.

n Install a third-party indexing/search software before you install Dragon; if no third-party

indexing/search is installed, when you try to set Dragon options, the Enable Desktop Search

commands check box will not be available for selection. Dragon supports Google Desktop

and Microsoft Vista Search.

Finding the MSI Installer on the DVD
The compiledMSI file is located on your installation DVD. The files for each edition are named:

n : Dragon NaturallySpeaking 12.msi
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You can double click on one of these .msi files to start the InstallShield Wizard; however, to

instead take advantage of available command line options, you can pass the file name as the appli-

cation to install to the msiexec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking12.msi"

Entering Command Lines

Unless otherwise noted:

n All command line options are case-insensitive (unless otherwise noted) and can be combined.

n No options require special values based on the values of other options.

n In the examples, user-supplied information is displayed between angle brackets. Do not use

angle brackets (<,>) as part of the command line.

n Do not use quotation marks unless you are explicitly instructed to.

n If a path name contain spaces, place a backslash followed by a quotation mark ( \"), before each

space in the path.

n Whenever you set an option to an .ini file, you must give the full path to that .ini file.

n All msiexec.exe command-line options you pass with /v must be prefaced with a forward slash

(/) only.

Windows Vista and Windows 7 Notes
Dragon setup is designed so that msiexec.exe can be run from an elevated command prompt in

Windows Vista and Windows 7.

To launch an elevated command prompt in Windows Vista or Windows 7:

Select Start > All Programs > Accessories > Command Prompt (without releasing the

mouse), then right click Command Prompt and select Run As. Choose an Run as admin-

istrator
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Overview of the Network Installation
of Dragon from a Server

Overview of Pushing Client Installation from a
Server
You can install the Dragon runtime in a network environment, in other words, push the software

application out to client computers without having to install it separately on each client system.

Dragon includes a native Windows Installer (MSI) that lets you both install across a network to

multiple client computers and customize your installations. Several servers support this type of

network installation:

n Windows Server 2008

n System Management Server (SMS)

n Active Directory Services

The administrator carrying out the installation creates an image of the installation program on the

server and then configures the server to automatically push the application onto the client sys-

tems. You can also configure network installations to modify, repair, or remove an existing instal-

lation.

Support for SMS and Windows Server with Active
Directory
Systems Management Server (SMS) provides a mechanism for pushing application installations out

from the server to client systems. SMS supports using the Windows Installer (MSI) to push client

installations on clients using all versions of Windows, from Windows XP to Windows 7. SMS

requires that a client application be installed on all client computers.

Active Directory Services is a feature of Windows Server 2008. The Group Policy component of

Active Directory Services includes a Software Installation snap-in that lets an administrator create

a network installation. Administrators can use this feature to install software to Windows XP, Win-

dows Vista, and Windows 7 clients.

Dragon supports the Active Directory Services Assign to Computers installation option. This

option successfully installs the software when the computer is rebooted. You (as administrator)

can delay installation on Windows XP, Windows Vista, and Windows 7 clients by enabling logon

optimization for group policy; for this type of installation, an entry for the installation can be

viewed in the event log after the first reboot. The installation is then performed on the second

reboot. The installation takes place silently, and the software is installed for all end-users on the

computer. When you perform a silent installation of Dragon, the installation process does not dis-

play any messages. To view installation messages, administrators should view the setup log.
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Overview of Alternative Ways to Carry Out
Administrative Installation
Dragon NaturallySpeaking includes a native Windows Installer (MSI) that lets you install across a

network to multiple client computers and customize your installation in the process. In addition,

you can use this service to modify, repair, or remove any existing installations. You can use any of

the following command line approaches to installing Dragon over a network:

n Carrying Out an Administrative Installation with .bat File

n Configuring Installation of Product Updates

n Creating Custom Installation Using Microsoft Custom Install Wizard

Once you have installed the server image, you can configure your installation, then use SMS or a

similar product to install Dragon. If the product you use to push the installation out to a server

requires it, you can install Dragon with msiexec (see Step-by-Step Command Line Installation

with msiexec.exe) instead of setup.exe.
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Modifying Roaming User Profile,
Miscellaneous, Schedule Settings in
the INI File

Suppose you have a large installation that involves several departments. Three departments

require one group of configure settings and two others require modifications. After you complete

the installation on the three departments requiring the same configuration, you might want to edit

your configuration files before using them on the additional two departments.

To edit the settings, you can use the natspeak command again. You can either return to the com-

puter where you carried out the initial installation to use natspeak or install the configuration from

the first three departments on the first computer in the two departments with different settings.

Modify the settings using:

n natspeak /setdefaultoptions

n natspeak /setdefaultadministrativeoptions

Then copy the new nsdefaults.ini file and roamingdef.ini files to a location accessible from all the

client computers to have the alternative configuration. For example, if you want these files to be

accessible to the MSI installer from a mapped network drive. copy the files to that location before

installing to the client PCs.

Or, if the Roaming User Profile network settings are not changing, you can edit any of the other

Roaming User Profile, Miscellaneous, and Scheduled Tasks settings of your configuration by rerun-

ning Dragon with any command listed above. (You cannot make changes to the roamingdef.ini

file, where the network settings reside.) Lists of the options in the nsdefaults.ini and roam-

ingdef.ini files are provided in the tables that follow:

Caution: Be sure to use the full path to the file if you set an option to an .ini file name.

Understanding and applying the
Roaming User Options

You can set Roaming User options during an MSI installation of Dragon NaturallySpeaking . In

the command line:

n Set the /SETDEFAULTS option to 1 display the Options dialog box at the end of the

installation. The Options dialog box lets you change Dragon’s standard behavior, including

specifying hot keys, customizing how text is formatted, changing initial microphone settings,

and setting the how often your User Profiles are backed up.

n Set the /SETADMINS option to 1 to display the Administrative settings dialog box at the end

of the installation. The Administrative settings dialog box lets you set up the Roaming feature.
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In the Roaming, Miscellaneous, and Schedule tabs of the Administrative Settings dialog box,

you set default values for the Roaming User options in the table below. The default values are

then written to the nsdefaults.ini file, the roamingdef.ini file, and the roaminguser.ini file.

After the MSI installation is finished, you can use the nsdefaults.ini file, the roamingdef.ini file, and

the roaming.ini file to install Dragon on other computers using the same settings that are in the .ini

files.

See Overview of Installing Dragon using the Windows installer (MSI) and its subtopics for more

information on installing Dragon using an MSI installation.

See MSI Options Specific to Dragon for more information on options that can be set during an

MSI installation of Dragon.

Do not attempt to manually modify the .ini files. Manually modifying the .ini files may

cause unpredictable or undesirable results.

Option Description and UI equivalent

RoamingUserOn=0 (or 1) Turns on the Roaming feature.

Default 0 = Off

Same as the Roaming Tab - Enable option.

Roaming User Local Cache

Directory

="<existing

directory>"

Sets the location of the local copy of the Roaming User Profile. The

default location is:
Documents and Settings\All Users\Application Data\N-
uance\Dragon NaturallySpeaking12\RoamingUsers\

Same as the Roaming Tab - Local directory (for cache) option.

Open User Large Col-

lection

=0 (or 1)

Same as the Roaming Tab - Display Classic Open User Pro-

files dialog. option.

See Dragon - What's New for administrators for more information.

Roaming User Restrict

Local

User Access=1 (or 0)

Permits non-Roaming User Profiles to be opened when the Roam-

ing feature is active. Default of 1 restricts access to Roaming User

Profiles only, preventing non-roaming (local) end-users from dic-

tating by accident.

Same as the Roaming Tab - Allow non-roaming user profiles to

be opened option.

Roaming User Incorporate

Voc Delta=0 (or 1)

When the vocdelta.voc file reaches 90% of its maximum size (1000

KB, or 1 GB), incorporates the contents of the local vocdelta.voc

file into the master Roaming User Profiles (acoustic model for the

User Profile), without running the Acoustic and Language

Model Optimizer. After it incorporates the contents of the file

into the master Roaming User Profile, it clears that data from the

local User Profile, where new data is pulled from subsequent dic-

tation. If the data is being incorporated when you open a roaming

User Profile, the process can be time consuming.
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Option Description and UI equivalent

Default 0 = On

Same as the Roaming Tab - Merge contents of vocdelta.voc

into network user profile when file is full option.

Roaming User Limited

Network Traffic=0 (or 1)

Transfers local Roaming User Profile changes to the master Roam-

ing User Profile to synchronize the local and the master Roaming

User Profile only when you open or close the User Profile. This

includes the changes an end-user makes locally from the Options

dialog box. For more information, see the Dragon Administrator

Guide Help file topic on Synchronizing Master and Local Roaming

User Profiles. Excessive network slowdowns can be alleviated by

checking this option because it limits multiple interim syn-

chronization of local and master Roaming User Profiles.

Default 0 = Off

Same as the Roaming Tab - Access network at user profile

open/close only option.

Roaming User Always

Break

Lock=0 (or 1)

Ask before breaking locks on network User Profiles (rec-

ommended). A network lock prevents opening a Roaming User Pro-

file that is already open. Network problems can cause a lock to

become "stuck" and not release even after opening the User Profile

is complete. Default of 0 produces a prompt that states the User

Profile is locked and asks you to override the lock. A setting of 1

does not produce the prompt, but breaks the lock automatically.

Same as the Roaming Tab - Ask before breaking locks on net-

work user profiles (recommended for UNC and mapped

drives)option.

ASW Override=0 (or 1) (ASW is short for Audio Setup Wizard.) Runs a Volume and Qual-

ity Check on the microphone each time you open a Roaming User

Profile. This setting affects all end-users. Turn this option on if

your end-users experience reduced accuracy because of differences

in the microphone, sound card, and ambient sound levels at dif-

ferent locations.

Default 0 = Off.

Nuance recommends you set this option to 1.

Same as the Roaming Tab - Set audio levels on each machine

option.

Roaming ASW Override

=0 (or 1)

Runs a Volume and Quality Check on the microphone each time

you open a Roaming User Profile. Set to 1 if the Roaming feature is

enabled and ASW Override is 1. ASW Override and Roaming

ASW Override should always have the same setting.

131



Dragon 12 Administrator Guide

Option Description and UI equivalent

Same as the Roaming Tab - Set audio levels on each machine

option.

Roaming User Save Acous-

tics

=0 (or 1)

When set to 1 (by default), when an end-user dictates on a com-

puter, acoustic adaptation that occurred as Dragon 'adapted' to the

end-user's voice, is saved. Acoustic optimization on the master

User Profile applies the acoustic adaptation data from dictation to

the acoustic model for the profile. When set to 0, the .usr and .sig

files created during dictation are not saved. Acoustic optimization

on the master User Profile does not apply the acoustic adaptation

data from dictation to the acoustic model for the profile.

Same as the Roaming Tab - Save acoustic information option.

See Dragon - What's New for administrators for more information.

Roaming User Copy

Dragon

Log=0 (or 1)

Copies the dragon.log file from the local Roaming User Profile loca-

tion to the master Roaming User Profile location at the same time

that the program synchronizes the local and the master Roaming

User Profiles.

Default 0 = Off

Same as the Roaming Tab - Copy Dragon log to network

option.

RoamingUserCopyAcoustic

Always=0(or 1)

Copies the User Profile’s acoustic information to the master Roam-

ing User Profile location when you do not want to run the Acous-

tic and Language Model Optimizer on the master Roaming

User Profiles. The local Roaming User Profile acoustic information

is stored in:
Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\RoamingUsers\<display
name>\<username>\current\voice

The <display name> is the name you defined for the master Roam-

ing User Profile location. You can have multiple network storage

locations. The <username> contains the names of an individual

master Roaming User Profile.

Default 0 = Off.

If you chose not to copy the User Profile’s acoustic information to

the network, corrections you make on one computer are not avail-

able on other computers used by that particular Roaming User Pro-

file until you run the Acoustic and Language Model Optimizer

on the master Roaming User Profile location and the local and

master Roaming User Profile synchronize. When this option is set

to 1 (on), the latest acoustic information is always available and auto-
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Option Description and UI equivalent

matically synchronized when the master Roaming User Profile is

opened from another location. The transfer of acoustic information

is not limited by setting the Disk space reserved for network

archive option.

Same as the Roaming Tab - Always copy acoustic information

to network option.

Roaming User Do Not

Copy

Dra Files=0 (or 1)

Prevents making files that contain acoustic data from the latest dic-

tation session available to the Acoustic Optimizer when the pro-

gram synchronizes the local and master Roaming User Profiles. You

use this option to prevent the transfer of acoustic optimization data

to local User Profiles.

Same as the Roaming Tab - Conserve archive size on network

option.

Roaming User Max Con-

tainer Size=1000 MB

Controls the maximum size for each container directory in the

master Roaming User Profile directory. Defaults to 1000 MB.

Same as the Roaming Tab - Disk space reserved for network

archive option.

Allow Users to Configure

Tasks=0 or 1

An administrators enables this option to allow end-users to access

the Scheduled Tasks tab in the Administrative Settings dialog

box. Users can use the options in the Scheduled Tasks tab to set

schedules for tasks, including the accuracy tuning task and the data

collection task. If an administrator does not enable this option, end-

users cannot access the Scheduled Tasks tab and the tasks will

use the default schedule.

Same as the Scheduled Tasks Tab - Let the user choose when

to run Accuracy Tuning and Data Collection option.

Custom Directory

=<full path>

Sets the location of the Data Distribution directory used by the

Data Distribution Tool or the nsadmin command. The Data Dis-

tribution directory can be set to any directory that Windows has

read and write access to. This includes portable devices such as Zip

drives and CD/DVD burners. In enterprise installations, the Data

Distribution directory is likely set to mapped network drives and

UNC paths.

Same as theMiscellaneous Tab - Data Distribution location

option.
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Editing Miscellaneous and Scheduled
Task Settings in nsdefaults.ini File

Of the settings in the nsdefaults.ini file retrieved from the Administrative Settings dialog box, sev-

eral settings are from the Miscellaneous and Scheduled Tasks tabs of the dialog box. You can mod-

ify the following settings in the nsdefaults.ini file:

Options Description UI

AO Archive Time

Limit

Maximum audio

archive size in min-

utes. The same

option in the

options.ini file for

a particular end-

user contains the

size of the current

audio archive for

that end-user.

Default max is

3600000 minutes.

Archive Size dialog

box, displaying the

range of audio archive

sizes

Disable command

changes for restricted

users=0 (or 1)

Turns on or off the

option that lets

non-administrative

end-users add or

modify commands.

Do not allow

restricted users to add

or modify commands

Disable vocabulary

changes for restricted

users=0 (or 1)

Turns on or off the

option that lets

non-administrative

end-users modify

vocabularies.

Do not allow

restricted users to

modify vocabularies

Global Enable Pause

Results=0

(or 1)

Turns on or off rec-

ognition when the

speaker pauses.

Record wave data

between utterances

Custom

Directory=<full path>

Sets the location of

the Data Dis-

tribution directory

used by the Data

Distribution Tool

or the nsadmin

command.

Data Distribution loca-

tion
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Options Description UI

Current Status

Ctfmngr=0 (or 1)

Turns on or off

Windows advanced

text services. Turn-

ing off these serv-

ices prevents

conflict between

them and Dragon

(Windows XP

only).

Disable Windows

advanced text services

No Dictation=0 or 1 When No Dic-

tation is on (set to

1) the end-user can-

not dictate, but can

only correct dic-

tation; used to des-

ignate an end-user

as a tran-

scriptionist.

Correction Only

Mode

Global MyCommands

MacroRecorder=0 or

1

Allows or does not

allow the end-user

to modify Macro

Recorder com-

mands. The end-

user should still be

able to dictate with

those commands,

even when not

allowed to modify

them.

Disable use of Macro

Recorder commands

Global MyCommands 

StepByStep Script-

ing=0 or 1

Allows or does not

allow the end-user

to modify Step-by-

Step commands.

The end-user

should still be able

to dictate with

those commands,

even when not

allowed to modify

them.

Disable use of Step-

by-Step commands

Global MyCommands

VBA Scripting=0 or 1

Allows or does not

allow the end-user

Disable use of

Advanced Scripting

commands
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Options Description UI

to modify

Advanced Scripting

commands. The

end-user should

still be able to dic-

tate with those

commands, even

when not allowed

to modify them.

enx ACO uses Auto

Accent AM selec-

tion=0 or 1.

When set to 1, the

Acoustic Opti-

mizer engine can

automatically select

an acoustic model

that it believes is

more suited to your

speech. To avoid

having this switch

occur, set the

option to 0.

In Dragon Nat-

urallySpeaking , spe-

cial conditions

apply if you run the

Acoustic Opti-

mizer on a User

Profile that has two

acoustic models.

See Using multiple

acoustic models

with a User Profile

for more infor-

mation.

Disable automatic

acoustic model selec-

tion in Acoustic Opti-

mizer
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Options Description UI

Encrypt Patient

Health Information=0

or 1

When set to 1,

Dragon auto-

matically encrypts

interim files it auto-

matically creates, to

avoid the pos-

sibility of those

files being inad-

vertently accessed

by unauthorized

personnel.

Encrypt patient health

information

Data Collector

Batch Mode=0 or 1

When set to 1,

turns on a process

that automatically

collects data to

help improve

speech recognition

in the future. The

process sends the

data to Nuance

over the Internet,

but does not send

any personal infor-

mation - it collects

recorded dictation

and the cor-

responding text.

Collecting data for

Nuance is optional.

Enable scheduled

Data Collection

Allow Users to Opti-

mize=0 or 1

When set to 1,

turns on a process

that automatically

runs an opti-

mization process

on speech rec-

ognition for the cur-

rently open User

Profile.

Enable scheduled

Accuracy Tuning

Allow Users to Con-

figure Tasks=0 or 1

Turning this option

on lets end-users

set the schedule for

accuracy tuning and

data collection

Let the user choose

when to run Accuracy

Tuning and Data Col-

lection
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Options Description UI

tasks. Otherwise,

these tasks take

place on a default

schedule.
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Understanding Network and
Connection Settings in roamingdef.ini
File

Although you cannot edit the roamingdef.ini file because it is encrypted, you should know that

the following information is in the file. You can modify these settings through the Administrative

Settings dialog only. For more information on values for each option, refer to the Dragon Admin-

istrator Guide Help file available through the product menu:

Options Description and UI

[<Network Settings>] Display Name assigned to the network directory

where Roaming User Profiles are stored, in the

Network Directories box.

location Address. Path to a network directory, web server,

or secure web server where Roaming User Pro-

files are stored.

HTTP Settings (HTTP)

type Authentication Type.

authscheme=1 Indicates authentication is required.

queryforuserpassword Prompt for user and password check box.

authuser <domain>\<username> required to log in.

authpassword Actual password required to log in.

followredirects Follow Redirects. Never, Always, or Same Scheme

Only.

keepalive Keep Connection Alive check box.

locktimeout Lock under Timeouts. Number of seconds after

timeout expires to lock the connection.

connectiontimeout Connection under Timeouts. Number of seconds

after timeout expires to close the connection.

connectiontimeoutinactivity Type under Timeouts. Set if you selected Inactivity

option.

connectiontimeoutabsolute Type under Timeouts. Set if you selected Absolute

option.

firewall Firewall and Proxy Servers. Set if a firewall is con-

figured.
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Options Description and UI

proxy Use Proxy Server check box. Set if checked.

proxyserver Network Location. URL to the web server.

firewalltype Type. Type of firewall represented by a number.

firewallhost Server. Name of server for the firewall.

firewallport=1080 Port. Port used by the proxy server or firewall.

1080 is the default.

firewalluser Username. Login name of the administrator that

can access the firewall.

firewallpassword Password. Password to log in to the firewall.

firewalldata Firewall Data or Proxy Authorization. Special authen-

tication string for firewall or proxy server, if appli-

cable.

SSL Settings (HTTPS)

sslcertstore Certificate store text box with no label. Name of

the certificate.

sslcertstorepassword Certificate Store Password.

sslcertstoretype Certificate Store Type, indicated by numeric des-

ignation.

useopenssl Using OpenSSL check box.

opensslcipherlist Cipher List.

opensslcafile Certificate Authority File.

opensslcadir CA Directory.

tls1

ssl3

ssl2

pct1

SSL Enabled Protocols
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Carrying Out an Administrative
Installation with .bat File

A straightforward way to install Dragon from the command line to a server is to carry out an admin-

istrative installation using a .bat file.

Caution: Only advanced administrators should attempt any type of administrative installation.

Note: A script for carrying out a full administrative installation is provided in the admininstall.bat

file at the top of the directory structure on the DVD. The script includes a bare minimum of the

options available, so you might want to read through the Installation using the Dragon command

line to find out about other options you might use.

Understanding the script in admininstall.bat
Below are some of the lines from the script in the admininstall.bat file, a batch file that de-com-

presses setup files into a network location for installation using SMS or another service.

To run the batch file, you enter admininstall.bat and follow it with the location of the Dragon .msi

file.

Near the top of the batch file, you see the lines that check the parameters entered and if the param-

eters passed are not acceptable, execute a routine that handles that situation:

:rem //Check and analyze input parameters if .%1.==.. goto bad_args if
.%2.==.. goto bad_args if .%3.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the

NETWORK_DNS_DIR to the location of the Dragon .msi file:

set NETWORK_DNS_DIR=%1%

When you run the admininstall.bat file, the file installs Dragon using a single line of code that calls

the setup.exe command and passes it:

n /a option — Indicates administrative install

n /s option for a silent no-GUI installation

n /v option to indicate msiexec options follow, enclosed in quotation marks

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the setup log.

The msiexec options with /v include /qb for display of a basic GUI during the process, the TAR-

GETDIR setting, and a /L with a series of log file options, including the name and location for

the log file:

echo Installing Dragon NaturallySpeaking... setup.exe /a /s /v"/qb TAR-
GETDIR=%NETWORK_DNS_DIR% /L*v %TEMP%\admininstall.log"
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When the installation of Dragon succeeds or fails, the batch file displays an appropriate message.

The remainder of the file handles errors and cases where bad arguments are passed on the com-

mand line.

Modifying admininstall.bat
You can modify the admininstall.bat file by adding to and changing the options you pass for install-

ing Dragon. You can add more options and/or modify the options shown here. For more on instal-

lation options, refer to Installation using the Dragon command line or these summaries:

n MSI Options Specific to Dragon

n MSI Options for Installing Dragon Features/Advanced Options

n Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

142



Chapter 5: Installing Dragon using the Windows installer (MSI)

Install Dragon on an initial computer
and choose the default settings

Before you proceed, you should be familiar with installing the product on a single computer from

the DVD. For more information, see Installing, modifying and upgrading Dragon.

The initial installation is used to set default values for the Administrative, end-user, and Auto-For-

matting options. These options can then be used to install on other computers using the same

values.

Even if you are installing from a server, you should run through the initial installation below first.

For more information on installing from a server, proceed to Overview of the Network Instal-

lation of Dragon from a Server.

Caution: If you want to set any administrative settings, be sure you have Windows administrator

privileges. Administrator rights are not required to create a User Profile or use the software after

installation.

Before you begin:

n Install any pending Windows updates and reboot the computer when you are finished.

n Close all open applications.

n Turn off or disable antivirus software; the installation process can sometimes trigger a false virus

report.

Note: An alternative to this approach is to use msiexec.exe to install Dragon, covered under Step-

by-Step Command Line Installation with msiexec.exe.
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Extracting MSI/MST Files from the
Dragon setup.exe

Some minor release of Dragon, Service Pack 1 of Dragon 10 for example, do not include a .MSI

file, they are supplied with a setup.exe.

You can carry out an administrative installation using setup.exe, as follows:

n Create a server image of Dragon files for later installing clients. You create the image by

executing setup.exe and passing it the /a option and a Dragon-specific option that extracts MST

and MSI files from the Dragon setup.exe file provided.

n Use the options to extract the MSI/MST Files from the Dragon setup.exe.

Extracting MSI/MST Files from setup.exe
The following setup.exe options are designed to extract .msi/.mst files for Windows Installer-

oriented distributions.

Note: When you install Dragon NaturallySpeaking , Dragon installs using the primary language for

the product. You cannot install Dragon using a language that is different than the primary lan-

guage. For example, when you install Dragon, English version, Dragon installs using the English

language.

If you attempt to use the /l option with setup.exe to install Dragon NaturallySpeaking using a
non-primary language, the installation process uses the primary language for that edition of Dragon

and ignores the /l option.

These options do not install any files, but rather extract an installable set of files into the server

directory you specify.

Option Description

/a Administrative installation. Instructs

setup.exe to perform an administrative instal-

lation to a network for use by a workgroup

instead of a normal installation. This option is

required when trying to extract the .msi files.

An administrative installation installs a source

image of the application onto the network. The

image is similar to a source image on a CD or

DVD. Users in the workgroup who have

access can then install the product over the net-

work from this source image.

/a Administrative installation. Instructs

setup.exe to perform an administrative instal-

lation to a network for use by a workgroup
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Option Description

instead of a normal installation. This option is

required when trying to extract the .msi files.

An administrative installation installs a source

image of the application onto the network. The

image is similar to a source image on a CD or

DVD. Users in the workgroup who have

access can then install the product over the net-

work from this source image.

/v"<msiexec options>" Passes msiexec options to Windows Installer.

See table ofmsiexec options for details. This

option is required when trying to extract the

.msi files.

/l<Windows Language Code>  Specifies the language to use for installing

Dragon. For example, to launch the installation

in French, the command line would include

/L1036. The language codes supported for

installing Dragon are:

1031=German

1033=English

1034=Spanish

1036=French

1040=Italian

1043=Dutch

Also creates an MST file for the language you

specify, such as 1036.MST.

EXTRACTFILES="c:\xyz" For installing Version 10 Service Pack 1 only.

Indicates the directory where the extracted

.msi/.mst files are to be written. Long path

names containing spaces need to be in quo-

tation marks escaped by having a backslash pre-

cede each quotation mark (\"). This property is

required to extract the .msi files. If the direc-

tory you specify does not exist, the installer

creates it.

Here is a sample command line to extract msi

files from a single executable:

setup.exe /a /s /v"-
EXTRACTFILES=c:\temp\msifiles"

145



Dragon 12 Administrator Guide

Option Description

TARGETDIR=”C:\xyz” Use with administrative installations only. Indi-

cates the full path to where to install the image

of Dragon.
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Using .MSI/.MST Files for Custom
Installations Example

Using .MST files you can tailor the MSI installation without changing the setup.exe file that

Nuance provides.

Note: When you install Dragon NaturallySpeaking , Dragon installs using the primary language for

the product. You cannot install Dragon using a language that is different than the primary lan-

guage. For example, when you install Dragon , English version, Dragon installs using the English

language.

If you attempt to use the /l option with setup.exe to install Dragon NaturallySpeaking , using a
non-primary language, the installation process uses the primary language for that edition of Dragon

and ignores the /l option.

Step1: Running setup.exe to Extract .MSI and .MST
Files
The following sample command line extracts the French .MSI file, Dragon NaturallySpeaking

10.msi , and the .MST file used for installing Dragon in French :

The following sample command line extracts the Dragon NaturallySpeaking 10.msi and the .MST

file used for installing Dragon :

setup.exe /a /s /l1036 /v"EXTRACTFILES=c:\temp\MSIfiles /qn"

setup.exe /a /s /v"EXTRACTFILES=c:\temp\MSIfiles /qn"

Caution: The first time you try any command line, you should not run it in Silent mode, because if

you have neglected to provide required information, you then receive a GUI prompt for that infor-

mation.

(The character that immediately follows the third slash is a lowercase L.)

Next, you specify the extracted .MSI and .MST files in a command line to install Dragon . The

next two examples show how these files are used running first setup.exe, then msiexec.exe.

Step 2: Passing MST File to setup.exe to Install
Dragon
This sample command line launches setup in French and installs Dragon into the C:\Dragon direc-

tory:

This sample command line launches setup and installs Dragon into the C:\Dragon directory:

setup /a /s /v"INSTALLDIR=\"C:\<full_path>\Dragon\" TRANSFORMS=1036.MST /qn

setup /a /s /v"INSTALLDIR=\"C:\<full_path>\Dragon\" /qn

147



Dragon 12 Administrator Guide

Installation using the Dragon
installation process

Perform the following steps to use the user interface of the Dragon installation process:

1. Insert the product DVD in the DVD drive. If the installation does not start, run setup.exe from

the DVD.

2. Choose the Custom installation with appropriate languages and vocabularies.

3. Choose the Custom installation with appropriate vocabularies.

4. Choose the following check boxes under Additional options to have additional dialog boxes

pop up at the end of the installation, where you can make changes that affect all end-users dic-

tating on this computer.

l Modify the application's settings for all user profiles - Displays the Options dialog box

at the end of the installation.

l Modify the administrative settings - Displays the Administrative Settings dialog box at

the end of the installation, where you set up the Roaming feature, where to backup your

User Profiles, and who can modify commands/vocabularies.

l Auto-Formatting options - Displays the Auto-Formatting dialog box at the end of the

installation, where you apply uniform formatting to all documents dictated at this instal-

lation; for example, formats for dates, times, and phone numbers.

5. When the Options dialog box appears, select the default options that should apply to all client

installations and click OK. This dialog box is where you set up all the options under the various

tabs (Correction, Command, and so on). In Dragon, you can also program custom actions into

the buttons on the PowerMic I and PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-

Speech as a feature of your installation, work with options in Summary: MSI Options for Install-

ing Dragon Features/Advanced Options.

Note: At least one supported third-party indexing/search software should be installed on the

system before you install Dragon, or the Enable Desktop Search commands check box will not

only be unchecked, but will not be available to be checked. Dragon supports Google Desktop

and Microsoft Vista Search.

6. When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all

client installations and click OK.

7. When the Administrative Settings dialog box appears, if you want to set up Roaming User Pro-

files, set the options under Roaming User Profile (to set the HTTP or HTTPS settings under

the HTTP Settings or HTTPS Settings button, you must have either http:// or https:// in

front of the network directory path); whether you have Roaming User Profiles or not, set the

options under Miscellaneous and Scheduled Tasks tabs and click Apply for each; then, when

you have set all the settings, click OK.

8. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini

and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User
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Profiles). You can find these .ini files under
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\.
These .ini files are now considered customized files, because they now contain the custom set-

tings that will be applied to each of the DNS client installations you deploy. Retrieve the nsde-

faults.ini and roamingdef.ini files and copy them to a directory where you can access them from

the other client computers. (If you did not run natspeak.exe on the command line, you do not

find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing installation

whose settings you’d like to replicate. If you did not change the Network Settings, you do not

need a roamingdef.ini or roaming.ini file at all.)

You are now ready to install the same configuration you just established here onto other com-

puters.

Notes:

n If you are installing Dragon on more than one client computer and over a network, you can use

the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another server-

based program that pushes the installation out to several clients at once. Even if you are

installing from a server, you should run through the initial installation before you carry out the

administrative installation. Then, for more information on installing from a server, proceed to

Overview of Pushing Client Installation from Server.

n When you install Dragon NaturallySpeaking , Dragon installs using the primary language for the

product. You cannot install Dragon using a language that is different than the primary language.

For example, when you install Dragon, English version, Dragon installs using the English

language. If you attempt to use the /l option with setup.exe to install Dragon
NaturallySpeaking using a non-primary language, the installation process uses the primary

language for that edition of Dragon and ignores the /l option.

149



Dragon 12 Administrator Guide

Install the same Dragon configuration
on multiple computers

Note: If you chose Enable Desktop Search Commands on the Commands tab during the initial

installation, you must install Google Desktop or Microsoft Vista Search before you install Dragon;

otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer

you will be installing on or copy the files to a local path on the client computer where you are

about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing

Dragon to multiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the installation.

4. Install any pending Windows updates and reboot the computer.

5. Open a command line window (Start > Run cmd).

6. Insert the product DVD in the DVD drive and search the DVD for the path where the Dragon

setup.exe is located.

7. On the computer where you are installing Dragon, to install the same configuration you created

during the initial installation, enter the following on the command line (using the customized

nsdefaults.ini file) of a single client. You pass the Dragon serial number for the SERI-

ALNUMBER option and the full path to the nsdefaults.ini file using the DEFAULTSINI

option (this line assumes no Roaming User Profiles):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon12\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

/L*v C:\Logs\logfile.log

Note: The full path for the DEFAULTSINI setting uses escaped out quotation marks (pre-

ceded by a backslash) only when there are spaces in the full path.

Caution: The first time you test any installation, you should pass /q rather than /qn so that if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information.

8. If you entered a network address in the Network Directories box and set up HTTP or HTTPS

settings in the Roaming tab of the Administrative Settings dialog during the initial installation,

those settings are transferred to your client computers only if you include the ROAM-

INGUSERINI option, set to roamingdef.ini:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon12\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

/L*v C:\Logs\logfile.log
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You include the bolded portion of the above command lines so that if something goes wrong

during the installation, you receive messages about it. You pass /L and a series of sub-options

followed by a log file name to have the installation log errors and other messages related to the

process. (You can send the log file to technical support should any issues arise.)

Note: You can also use the /qn option to install the product in Quiet mode, where no GUI or

other messages appear. Another option, the /passive mode, runs the entire installation unat-

tended, but displays a progress bar. However, the first time you run any installation command

line, you should not use the /qn option, because turning off the GUI also turns off any mes-

sages that help you determine any problems with that command line. To use the /qn option,

add it to the end of the command line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon12\" DEFAULTSINI=\"C:\<full_path>\ns-
defaults.ini\"
/L*v C:\Logs\logfile.log /qn

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon12\" DEFAULTSINI=\"C:\<full_path>\ns-
defaults.ini\"

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\" /L*v C:\Logs\logfile.log
/qn
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Creating Custom Installation Using
Microsoft Custom Install Wizard

If you are installing Dragon on a network, you can create a custom installation program using a set

of tools available from Microsoft.

1. Download and install the tools

2. Run the wizard

You are then ready to use the custom installer to install the product.

Installing the Microsoft Custom Installation Wizard
The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To

install the Custom Installation Wizard:

1. Download the Office Resource Kit Tools (OrkTools.exe) from:

http://www.microsoft.com/office/orkarchive/xpddl.htm. The OrkTools.exe self-
extracting executable (EXE) file installs the core Office XP Resource Kit tools on your com-

puter through a single Setup program.

2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or

select Start > Programs >Microsoft Office Tools >Microsoft Office XP Resource Kit

Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom instal-

lation. For details on using the wizard, proceed to Modifying setup Properties for Custom Instal-

lation.

Modifying setup Properties for Custom Installation
The following explains how to modify setup properties for a custom installation of Dragon. This

example shows how to add to the installer configuration one of the many MSI options you can set

for installing Dragon, the SERIALNUMBER property. (You can add any options available to MSI

on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs >Microsoft

Office Tools >Microsoft Office XP Resource Kit Tools, and then click Custom Instal-

lation Wizard. The Custom Installation Wizard screen displays:
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2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to

use to create a custom installation. The compiled .MSI file is located on your installation CD.

The files are named:
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4. The following example uses Dragon NaturallySpeaking 10.msi.

5. Click Next.

6. Click Yes when you see the following message:

7. On the Open the MST File page of the wizard, select Create a new MST file.

8. Click Next to continue.

9. On the Select MST File to Save page of the wizard, select a file name and path for the MST file

you are creating:
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10. Click Next.

11. On the Specify a Default Path and Organization page, select the default path for the installation.

By default, Dragon installs in \Program Files\Nuance\NaturallySpeaking12.
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12. Click Next.

13. On the Remove Previous Versions page, keep the default selections and click Next. This page

applies only to Microsoft Office and does not affect the Dragon installation.

14. Click Next to keep all the defaults when you come to the Set Features Installation States page,

where you select particular components to install.

15. On the next several pages of the wizard, click Next on each, and proceed until you reach the

Modify Setup Properties page. All the pages in between apply only to Microsoft Office.
n Customize Default Application Settings page

n Change Office User Settings page

n Add/Remove Files page

n Add/Remove Registry Entries page

n Add, Modify, or Remove Shortcuts page

n Identify Additional Servers page

n Specify Office Security Settings page

n Add Installations and Run Programs page
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16. Use the Modify Setup Properties page, shown below, to add, modify, and set the MSI options

of your custom installation.

17. Click the Add button to display the Add/Modify Property Value dialog box, where you modify

the MSI installation options. In this example, we add and set the SERIALNUMBER option.

18. In the following Add/Modify Property Value page, enter the new property name SERI-

ALNUMBER and a valid serial number, then click OK:

19. Note that the Modify Setup Properties page re-displays with the updated information. For exam-

ple:

20. Continue adding or modifying other MSI options that apply for your environment. Once you are

done, click Next.
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21. On the Save Changes page, click Finish.

22. When the Custom Installation Wizard page appears, click Exit. This screen displays the location

of Windows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a

Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.
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Installation using the Dragon
command line

When you install Dragon NaturallySpeaking , Dragon installs using the primary language for the

product. You cannot install Dragon using a language that is different than the primary language.

For example, when you install Dragon , English version, Dragon installs using the English lan-

guage.

If you attempt to use the /l option with setup.exe to install Dragon NaturallySpeaking using a
non-primary language, the installation process uses the primary language for that edition of Dragon

and ignores the /l option.

Perform the following steps to use the Dragon command line:

1. Open a command line window (Start > Run and enter cmd).

2. Insert the product DVD in the DVD drive, search the DVD for the path where the Dragon

setup.exe is located, and switch directories to the path on the product DVD where the Dragon

setup.exe is located.

3. Enter the following command line to install Dragon on this initial computer (ignore any errors

you receive regarding the serial number, as it is not required for this in initial installation, unless

you plan to dictate later):

setup.exe /s /v"INSTALLDIR=c:\Dragon12 /L*v C:\Logs\logfile.log /qn"

The /s option sets the silent option for every .exe that setup.exe provides a wrapper for - so that

no GUI pops up.When you perform a silent installation of Dragon, the installation process does

not display any messages. To view installation messages, administrators should view the setup log.

By contrast the /qn inside the quotation marks after /v sets the silent option for the Dragon instal-

lation.

The /v option introduces any series of msiexec.exe options you want to pass to the Windows

installer, all enclosed in quotation marks after the /v, with no space allowed between the /v and

the opening quotation mark. Among the options inside the quotation marks are:

n INSTALLDIR — Indicates the full path to where you want Dragon installed

n /L*v — (either upper or lowercase) Indicates the log file where messages about the installation

should be written

n /qn — (Quiet mode—also called Silent mode—no GUI) Turns off the Dragon GUI

Caution: The first time you test any installation, you should not run it in Silent mode, because if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information. You should initially pass the /L*v option because it

runs the entire installation GUI. When the Welcome dialog appears, you can stop and look into

the log file., where you can search for Command line to verify that all command line parameters

are being incorporated. The line you find will have this format:
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MSI (c) (##:##)[##:##:##:###] Command Line: <OPTION>=<value>
<OPTION>=<value> ...

The above command line is to install the primary language of the Dragon product.

For changes required to install another language, see Silent Installation with Language Other Than

US English.

Logging errors and other messages

Sub-options for /L indicate the types of messages to send to the log:

Sub-option Message type sent to log file

i Status messages

w Nonfatal warnings

e All error messages

a Start up actions

r Action-specific records

u User requests

c Initial UI parameters

m Out-of-memory or fatal exit information

o Out-of-disk-space messages

p Terminal properties

v Verbose output

x Extra debugging info (Windows Server 2000 only)

+ Append to existing log file

* Wildcard. Log all info except v and x options

*vx Log all info including v and x options

Running natspeak.exe to Set Options
When the installation completes, you then set up the configuration on this initial computer by run-

ning natspeak up to three times, in the steps that follow. All steps are optional; by skipping a step,

you are choosing to accept the default values for the options applicable for associated options.

1. On a workstation PC where Dragon is installed, close Dragon if it is running.

2. From the Windows Start menu, select All Programs > Accessories > Command Prompt to

open the Command Prompt window.

3. Switch to the Program directory. The default is:

C:\Program Files\Nuance\NaturallySpeaking12\Program
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4. Enter the following natspeak command:

natspeak.exe /setdefaultsoptions

5. When the Options dialog box appears, select the default options that should apply to all client

installations and click OK. This dialog box is where you set up all the options under the various

tabs (Correction, Command, and so on). In Dragon, you can also program custom actions into

the buttons on the PowerMic I and PowerMic II microphones.

Note: Settings under the Playback/Text-to-Speech tab are not saved. To include Text-to-

Speech as a feature of your installation, work with options in Summary: MSI Options for Install-

ing Dragon Features/Advanced Options.

Note: At least one supported third-party indexing/search software should be installed on the

system before you install Dragon, or the Enable Desktop Search commands check box will not

only be unchecked, but will not be available to be checked. Dragon supports Google Desktop

and Microsoft Vista Search.

6. Enter another natspeak command:

natspeak /SetDefaultFormattingOptions

When the Auto-Formatting dialog box appears, select Auto-Formatting options to apply to all client instal-

lations and click OK.

7. Enter a final natspeak command:

natspeak /setdefaultadministrativeoptions

8. When the dialog box appears, if you want to set up Roaming User Profiles, set the options

under Roaming User Profile (to set the HTTP or HTTPS settings under the HTTP Settings or

HTTPS Settings button, you must have either http:// or https:// in front of the network direc-

tory path); whether you have Roaming User Profiles or not, set the options under Miscellaneous

and Scheduled Tasks tabs and click Apply for each; then, when you have set all the settings,

click OK.

9. Dragon has saved the configuration you created with running natspeak.exe in the nsdefaults.ini

and roamingdef.ini files (the roamingdef.ini file is created only if you set up Roaming User Pro-

files). You can find these .ini files under
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\.

Note: If you do not find the nsdefaults.ini file in the sub-folders under All Users, navigate to

All Users.WINDOWS, or administrator, or any other Documents and Settings sub-folders for

other end-users on this workstation until you locate the nsdefaults.ini file. It’s possible that the

workstation was configured so that a different “user” folder is the default for application data
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for Nuance and other applications.

These .ini files are now considered customized files, because they now they contain the custom

settings that will be applied to each of the DNS client installations you deploy. Retrieve the

nsdefaults.ini and roamingdef.ini files and copy them to a directory where you can access them

from the other client computers. (If you did not run natspeak.exe on the command line, you do

not find a roamingdef.ini file; in that case, you can use a roaming.ini file from an existing instal-

lation whose settings you’d like to replicate. If you did not change the Network Settings, you

do not need a roamingdef.ini or roaming.ini file at all.)

10. When you have located the nsdefaults.ini file, verify that your option settings have been

changed. Double-click the nsdefaults.ini file to open it in a text editor. You should see values

defined for the options you changed.

Example: If the Capitalize ‘allergy’ and ‘allergies’ as ‘ALLERGY’ and ‘ALLERGIES’ option has

been turned on, the nsdefaults.ini file contains this statement:

11. Include the newly created nsdefaults.ini file in your MSI package to distribute the file to all

end-user workstations where Dragon is installed.

For more on natspeak.exe command line options, refer to natspeak Command Line Switches.

You are now ready to install the same configuration you just established here onto other com-

puters.

Note: If you are installing Dragon on more than one client computer and over a network, you can

use the same .ini files with the MSI Installer (msiexec). You also use SMS Server or another

server-based program that pushes the installation out to several clients at once. Even if you are

installing from a server, you should run through the initial installation before you carry out the

administrative installation. Then, for more information on installing from a server, proceed to

Overview of Pushing Client Installation from Server.
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Natspeak.exe command line reference
You can use command line options to modify the way that Dragon NaturallySpeaking starts.

These switches are used in the following syntax:

natspeak /switch

where /switch is one or more switches from table below (each switch is a single word without

spaces or hyphens):

Switch Function

/diagnose Runs Dragon in diagnostic mode to output

info to Dragon.log file and exits.

/user <user> Automatically loads the User Profile.

/topic <topic> Automatically loads the topic (Pro-

fessional/Legal editions only).

/quick Runs Dragon in QuickStart mode, a mode

that starts Dragon without loading a User

Profile or any speech models on startup of

your computer.

/SetDefaultOptions Displays the Options dialog box.

/SetDefaultAdministrativeOptions Displays the Administrative settings dialog

box.

/SetDefaultFormattingOptions Displays Auto-Formatting dialog box.
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Other Actions You Can Take on
Command Line

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the log files. See Trou-

bleshooting silent install errors for details.

Here are other (optional) actions you can take on the command line as part of a silent installation:

Note: In Dragon NaturallySpeaking , the installation process does not present the QuickStart

option. If you wish to enable this option, you can do so after Dragon is installed.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of the computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

n Silent Installation with Language Other Than US English

Additional Options with Extensive Settings for Silent Installations

n Revising Day/Time of Scheduled Tasks (Optional)

n Configuring Local or On-Demand Install of Vocabularies/Text-to-Speech (Optional)

164



Chapter 5: Installing Dragon using the Windows installer (MSI)

Modifying Default Installation
Directory

If you want to set an installation directory other than the default, pass INSTALLDIR="<full path

to install>" on the command line (note that the quotation marks are required only if you have

spaces in the path):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\" /L*v C:\Logs\logfile.log /qn"

Note: If the installation directory does not have spaces, note how the INSTALLDIR directory is

designated in the command line:

setup.exe /v"INSTALLDIR=C:\Dragon12 ADDLOCAL=ALL"

If the installation directory has space(s), it is surrounded in quotation marks that are escaped out

by having backslashes precede them (shown in bold):

setup.exe /v"INSTALLDIR=\"C:\NaturallySpeaking12\" ADDLOCAL=ALL"

Caution: The first time you try any installation, you should not run it in Silent mode, because if

you have neglected to provide information about a setting that does not have a default, you

receive a GUI prompt for that information.
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Configuring Installation of Product
Updates

If you want the individual client computer to download product updates to Dragon over the web,

you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you

prefer to install the updates on the servers and later distribute them to client computers, set this

option to 0 (unchecks the check box). If your enterprise does not install service packs provided

by Nuance, Nuance recommends you set this flag to -1:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\"
PRODUCTUPDATEFLAG=-1 /L*v C:\Logs\logfile.log /qn"
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Suppressing Reboot of the computer
After Installation

To suppress rebooting of the computer after installation of Dragon completes, you can pass Micro-

soft's REBOOT option set to ReallySuppress. Using this option is highly recommended if you are

executing a silent installation ( if system updates are pending, rebooting is required for DNS to

work normally).

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
/L*v C:\Logs\logfile.log /qn"
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Installing the same Roaming User
Profile Configuration on Additional
computer(s)

Use the roamingdef.ini file you created during the initial installation as the input for the ROAM-

INGUSERINI option in this format (be sure to use the full path to the file when you pass the

option):

ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"

The default is empty (no .ini file will be used). Include the ROAMINGUSERINI option in the

installation command line:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
/L*v C:\Logs\logfile.log /qn"

The example above assumes that the full path has spaces in it, so it has escaped out quotation

marks around the option value. After you have completed the installation, verify that all options

are correctly set on the client computer.
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Silent Installation with Language
Other Than US English

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the log files. See Trou-

bleshooting silent install errors for details.

By default Dragon installs in the language that matches the language of your operating system; to

install it in another language, you must purchase that kind of license, then use the /L option fol-

lowed by a numeric language ID, outside the quotation marks:

setup.exe /L1031 /s /v"SERIALNUMBER=#####-###-####-####-##
INSTALLDIR=\"C:\<full_path>\Dragon12\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\" /qn"
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Revising Day/Time of Scheduled
Tasks (Optional)

This section describes how to modify the schedule for Dragon tasks to later take place on each dic-

tation client computer by passing particular options in a command line installation. This section is

a continuation of Installation using the Dragon command line. When you finish this section, you

might want to proceed to Configuring Local or On-Demand Install of Vocabularies/Text-to-

Speech (Optional).

Note: You take the following actions on the client computer to install Dragon on client PCs, not

on the computer where you installed the initial installation and configured default option settings

for end-users.

You can include an additional option on the command line to run one or more of the following

tasks on a particular schedule:

n Acoustic model optimization (ACO) — This task optimizes the acoustic files used to recognize

words that the end-user trains and speaks. You can set a particular date and time for this

optimization to occur. When a speaker is new to Dragon, you might want to run the

optimization more often, after the speaker has worked with Dragon for a while.

n Language model optimization (LMO) — This task optimizes the language model (vocabulary

files) used to help recognize words that the end-user speaks. The model incorporates data from

the end-user’s speech into the language model he or she is using, ultimately customizing the

model for that User Profile.

n Data Collection (DC) — This task automatically collects data that helps improve Dragon’s

ability to recognize speech. You can choose to allow this data to be sent back to Nuance over

the Internet on a particular schedule or choose not to send the data. This process does not

collect your personal information.

You turn on/off the above tasks and set the schedule for those you turn on by passing an option

called PERIODIC_TASK to the MSI installer. You set PERIODIC_TASK to a string containing

short acronyms for the types of tasks, aco | lmo | dc, separated by vertical bars. If you do not

pass the acronym for the feature, that feature is set to its default.

After the acronyms for the tasks to schedule, the string for PERIODIC_TASK should include the

administrator login and password, then the schedules that correspond to the acronyms, in the

order that they occur in the string. The schedules use three-letter weekday abbreviations and 24-

hour time with two digits for the hour and two for the minute, separated by a colon. The two

schedules are separated by vertical bars and presented in the same order as their corresponding

acronyms. While the acronyms for the tasks are separated from each other by vertical bars, sem-

icolons separate the group of tasks from the admin user name, password, and group of schedules.

For instance, to retain the default schedule for data collection and modify schedules for acoustic

model optimization to Mondays at 1 AM and language model optimization to Mondays at 6 AM,

you would set PERIODIC_TASK as follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An installation command line including this task setting option might look like the following:
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setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v C:\Logs\logfile.log /qn"

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User

Profile, Tuning, and Data Collection Setup.
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Configuring Local or On-Demand
Install of Vocabularies/Text-to-
Speech (Optional)

This section describes how to enable Roaming User Profiles in a command line installation and is

a continuation of Installation using the Dragon command line.

Note: You take the following actions on the client computer where you want to install Dragon,

not on the computer where you carry out the initial installation.

Installing only particular vocabularies locally,
others on-demand
When you install Dragon on a client computer as outlined in Installation using the Dragon com-

mand line, by default you install all the available vocabularies locally.

If you do not want all of those vocabularies to be installed locally, but to instead have them

installed only if/when an end-user attempts to deploy a particular vocabulary, you can indicate

that fact on the installation command line by adding the ADDLOCAL option and setting it to the

names of the vocabularies to install locally.

For example, say you want to do a partial installation of Dragon and you only want to install the

General vocabulary. You set ADDLOCAL to NatSpeak, ENUGeneral, and the command line

would appear as follows (NatSpeak must be in the setting of ADDLOCAL, unless you set ADD-

LOCAL to ALL; otherwise, the installation fails):

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"

Note: There must not be any spaces between the arguments specified for ADDLOCAL.

If you want other vocabularies to be available, you set ADDLOCAL to ALL and set the ADVER-

TISE property to a list of additional vocabularies. The command line might look like the fol-

lowing:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress ADDLOCAL=ALL
ADVERTISE=<Additional vocabularies separated by commas>
/L*v C:\Logs\logfile.log /qn"

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the

list. The names you must use for the vocabularies consist of a prefix for the language, then the
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name of the vocabulary, such as ENU for English and General to form ENUGeneral. For a list of

the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the

command line, refer to MSI Options for Installing Dragon Features/Advanced Options.

Installing Text-to-Speech feature
To install Text-to-Speech locally, you would include the feature in the list of features for ADD-

LOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\"
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v C:\Logs\logfile.log /qn"

For more information, see these summary topics:

n MSI Options Specific to Dragon.

n Feature Variables to Set Through the ADDLOCAL or ADVERTISE Properties

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup
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Upgrading Your Dragon Installation
from the Command Line

There are two command line upgrade scenarios:

n Major Upgrade—Upgrading from Version 10, 10.x, 11, or 11.x to Dragon NaturallySpeaking .

n Minor Upgrade—Upgrading to a higher point release within the same edition and version of

Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon

9.x or earlier to Dragon 12 is not supported

All of these types of upgrades can either display the GUI or be silent (not display the GUI),

except the minor upgrade, which does not support the silent option.

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the log files. See Trou-

bleshooting silent install errors for details.

An administrator cannot upgrade User Profiles with the command line installation. For more infor-

mation on upgrading Roaming User Profiles, see the section below. If User Profiles are not Roam-

ing User Profiles, administrators run the User Profile Upgrade Wizard after installation

completes.

Upgrading Roaming User Profiles
Before upgrade User Profiles, administrators must upgrade Roaming User Profiles in the Roaming

User Profile directory. Afterwards, administrators can upgrade Dragon on the client computers

and the Roaming User Profiles become available as soon as the upgrade is complete.

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.

Background on Roaming User Profiles

Before administrators upgrade Roaming User Profiles from Dragon NaturallySpeaking 10.x or 11.x

to Dragon NaturallySpeaking , they need to recall some basics about how the Roaming feature

works: Each Dragon end-user has a master Roaming User Profile that can be opened from any net-

worked computer where Dragon is installed. The master Roaming User Profiles are stored on a net-

work location. When a master Roaming User Profile is opened from that central network location,

Dragon transfers a copy of that User Profile to the Local Roaming User Profile on the computer

where the end-user is dictating.

Recommended Approach

Since the Local Roaming User Profile is a copy of the end-user data taken from the master Roam-

ing User Profile, it does not make any sense to directly upgrade the Local Roaming User Profile

when upgrading the local Dragon installation.
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Instead, administrators should install Dragon NaturallySpeaking directly on the network computer

where the Dragon 10.x or 11.x Master Roaming User Profiles are located and upgrade those

Master Roaming User Profiles directly. After upgrading the master Roaming User Profiles, admin-

istrators can then proceed to upgrade end-user systems that deploy the Roaming feature.

Notes:

n Even though the User Profile Upgrade Wizard supports both mapped drives and UNC paths,

Nuance strongly recommends upgrading the Master Roaming User Profiles on a drive on a

computer where Dragon NaturallySpeaking is locally installed. Nuance does not recommend

upgrading the Master Roaming User Profiles across a network to either a mapped drive or UNC

path; upgrading over a network will take a undetermined length of time. In addition, the User

Profile Upgrade Wizard does not support upgrading User Profiles over an HTTP connection.

n Upgrading the master Roaming User Profiles to Dragon NaturallySpeaking leaves the 10.x or

11.x master Roaming User Profiles unchanged, so that the end-users in the network can run

Dragon 10.x or 11.x while the administrator plans the upgrade.

n If upgrading from Dragon version 8.x or earlier to Dragon NaturallySpeaking , version 8.x or

earlier custom words and commands can be re-used in Dragon NaturallySpeaking :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon NaturallySpeaking , create a new User Profile

3. In Dragon NaturallySpeaking , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.
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Step-by-Step Process for Upgrading
Roaming User Profiles

1. Plan to upgrade the master Roaming User Profiles at a time when they are not being opened by

end-users, for example during the night or on a weekend. Nuance recommends backing-up User

Profiles before upgrading them.

2. Install Dragon NaturallySpeaking on the computer where the Dragon 10.x or 11.x Master Roam-

ing User Profiles are located. If that is not possible, Nuance recommends that you install

Dragon NaturallySpeaking on a separate computer where you will perform the upgrades.

OR

If unable to install Dragon where the Dragon 10.x or 11.x Master Roaming User Profiles are

located, Nuance recommends administrators:

n Install Dragon NaturallySpeaking on a separate computer where they will perform

the upgrades.

n Copy the Dragon 10.x or 11.x Master Roaming User Profiles from the network

location to the computer where Dragon NaturallySpeaking is installed.

n Upgrade the Dragon 10.x or 11.x Master Roaming User Profiles on the computer

where Dragon NaturallySpeaking is installed.

n Copy the upgraded Dragon NaturallySpeaking Master Roaming User Profiles to a

network accessible directory on the original network location.

In Dragon NaturallySpeaking or earlier, if the upgrade installation displays an option

to upgrade existing User Profiles to work with this installation, ignore the option, as

it does not affect Roaming User Profiles. Administrators manually run the User Pro-

file Upgrade Wizard later.

3. On the end-user systems where the end-users dictate, save and close any open User Profiles on

each Dragon 10.x or 11.x system that uses the Roaming feature.

If there is no time when all of the Roaming User Profiles are not in use (for example, in a hos-

pital where physicians use Dragon during a night shift), administrators can upgrade different

groups of Roaming User Profiles at different times.

4. On the central network location that stores Dragon 10.x or 11.x master Roaming User Profiles,

back up the master Roaming User Profiles to a separate location by using any system backup util-

ity that is implemented at your facility.

5. On the central network location that stores Dragon 10.x or 11.x master Roaming User Profiles,

create a new directory to store the upgraded Dragon NaturallySpeaking Master Roaming User

Profiles.

Always be sure the upgraded User Profiles are in a different location from the current User Pro-

files. If end-users see two versions of each User Profile, they may become confused when they

try to open a User Profile. Nuance recommends storing User Profiles, from different versions of

Dragon, in different locations.

6. If Dragon NaturallySpeaking is not installed on the computer where the Dragon 10.x or 11.x

Master Roaming User Profiles are located, create a directory on the local computer where

Dragon NaturallySpeaking is installed. The directory stores all the Master Roaming User Profiles
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you plan to upgrade. Copy the Dragon 10.x or 11.x Master Roaming User Profiles from the net-

work location to this directory.

7. On the administrator system where you upgrade the Master Roaming profiles to Dragon Nat-

urallySpeaking , start Dragon and make sure the Roaming feature is turned off.

To turn off the Roaming feature:
n Close any open User Profiles.

n Click Tools > Administrative Settings on the menu to display the Administrative

Settings dialog box.

n On the Roaming tab, make sure Enable is not selected.

8. Close Dragon.

9. On the computer where both the 10.x or 11.x Master Roaming profiles and Dragon Nat-

urallySpeaking are installed, select Start > Programs > Dragon NaturallySpeaking 12.0 >

Dragon NaturallySpeaking Tools > Upgrade User Profiles. The User Profile Upgrade Wiz-

ard opens.

If you do not turn off the Roaming feature in the Administrative Settings dialog box before

attempting to start the User Upgrade Wizard, you see an error message stating that you cannot

upgrade a Roaming User Profile. If you see the message, go back to the Administrative Settings

dialog and make sure the Enabled check box is not checked.

10. On the Select the profile(s) to upgrade page, click Browse to add a profile to select the

location of the Dragon 10.x or 11.x Master Roaming User Profiles. The Select the profile(s) to

upgrade page now displays a list of User Profiles in the selected directory:
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Continue to add User Profiles from other local locations or use the Remove from list button to

remove specific User Profiles. Click Next to continue.

11. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete the upgrade.

12. If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

13. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded

profile(s) text box, choose the local location you previously created to contain the upgraded

Dragon NaturallySpeaking master Roaming User Profiles. If a location is not visible, click the
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Browse button, find the correct location, and click Next.

14. The Begin profile upgrading page displays the number of User Profiles that the wizard is pre-

pared to upgrade.

Click Begin upgrading to start the upgrade process. The upgrade process can take 2-3 min-

utes or more per User Profile, depending on the speed of the computer system and the speed of

the network. Click Stop at any time to interrupt this process. The upgrade process creates new

master Roaming User Profiles in the destination you selected.

15. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard renames Dragon NaturallySpeaking master Roaming User

Profile as follows: <name> (v12). For example, Dragon copies and renames a 10.x Master
Roaming User Profile named roaminguser1 to roaminguser1 (v12) when the profile upgrades to

Dragon NaturallySpeaking . Dragon does not change the 10.x Master Roaming User Profile

named roaminguser1.

16. (Optional) If you cannot install Dragon where the original Master Roaming User Profiles are

located and those User Profiles were copied to another computer where Dragon Nat-

urallySpeaking was installed, copy the upgraded Master Roaming User Profiles back to the new

network-accessible directory that you created to store them.

17. Since the User Profile Upgrade Wizard leaves the Dragon 10.x or 11.x master Roaming User

Profiles unchanged and in their original network location, the Dragon 10.x and 11.x systems can

continue to use the Roaming feature until you upgrade the systems to Dragon Nat-

urallySpeaking Follow the steps in "Major and Minor Upgrades: Silent Upgrade" and be sure to

enable the Roaming feature. In the Network Directories settings, set the correct path to the

upgraded Roaming User Profiles.

18. Run Dragon on the end-user system and open a User Profile.
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If upgrading from Dragon version 8.x or earlier to Dragon NaturallySpeaking , Dragon 8.x or ear-

lier custom words and commands can be re-used in Dragon NaturallySpeaking :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon NaturallySpeaking , create a new User Profile

3. In Dragon NaturallySpeaking , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and commands.
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Major and Minor Upgrades: Silent
Upgrade

To upgrade from Dragon Version 10.x to Dragon NaturallySpeaking (major upgrade), you can use

either msiexec.exe or setup.exe. You can carry out this installation with a GUI or silently. The pro-

cedure presented here shows how to upgrade silently using msiexec.exe.

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

Overview of Silent Upgrade
If your environment requires that you perform a silent installation and use msiexec.exe, rather

than setup.exe, take these high-level actions in this order:

n Uninstall the older version of Dragon.

n Version 10 only: Uninstall the older version of Visual C++ Runtime for Dragon.

n For major upgrades only: Perform an initial installation of the new version of Dragon on a single

computer and establish the configuration you want to use by calling natspeak.exe on the

command line and passing it these options:
n /setdefaultoptions

n /setdefaultformattingoptions (to set only the general Auto-Formatting options)

n /setdefaultadministrativeoptions

When you run the Dragon command line installation silently, the msiexec.exe installer auto-

matically retains User Profiles from the previous version. Afterwards, individual end-users can

upgrade their local (but not Roaming) User Profiles when they start Dragon. (For updating Roam-

ing User Profiles, see Before You Upgrade.)

When you perform a silent installation or upgrade of Dragon, the installation process does not dis-

play any messages. To view installation messages, administrators should view the log files. See

Troubleshooting silent install errors for details.

GUIDs for uninstalling Dragon
The table below lists GUIDs that you pass to the /x option of msiexec for each version of Dragon

and Visual C++ Runtime for Dragon. Make sure to use the /x option with the GUID.

Products and versions GUID

DNS V11 {EFFA53BC-8C04-2E21-3D90-A13B1697B0CA}

DNS V10 and 10.x {E7712E53-7A7F-46EB-AA13-70D5987D30F2}

DNS V9 and 9.x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}
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Products and versions GUID

VC-Runtime 32-bit {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

VC-Runtime 64-bit {4A5A427F-BA39-4BF0-9A47-7777FBE60C9F}

Step-by-Step Upgrade Process
You must follow these steps to set options for your end-users:

1. If you are upgrading from a previous version of Dragon, copy the nsdefaults.ini and roam-

ingdef.ini files to a central location so they can accessed later.

2. Open a command line window (Start > Run and enter cmd).

3. Uninstall Dragon Version 10.x with msiexec.exe by passing the installer the /x option followed

by the old version’s GUID and the /qn option to turn off any GUI.

The correct GUID for each Version you can upgrade to Dragon NaturallySpeaking on the com-

mand line is shown in the adjacent table and the example below uses the Dragon 9.x GUID:

msiexec /x {DDDD90B2-80F2-413A-8A8E-38C5076A7DBA}

/L*v "C:\updatelog.log" /qn

msiexec automatically retains User Profiles when you use the silent option.

Caution: The first time you try any upgrade, you should not run it in Silent mode, because if

you have neglected to provide required information, you then receive a GUI prompt for that

information.

4. The example below shows uninstalling the 32-bit Visual C++ Runtime for Dragon:

msiexec /x {4A5A427F-BA39-4BF0-9A47-9999FBE60C9F}

/L*v "C:\updatelog.log" /qn

To uninstall the 64-bit version, use the alternative GUID shown in the adjacent table.

5. Be sure you have the Dragon serial number (or the group serial number, if you are upgrading

Dragon on multiple networked computers).

6. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the upgrade.

7. Install any pending Windows updates on clients and reboot as needed before continuing.

8. If you are performing a minor upgrade, skip this step. If you are performing a major upgrade, per-

form an initial installation on a single computer where you configure the settings of User Profile

options, Auto-Formatting options, and administrative settings. You can follow the instructions

in Install the Same Configuration on Additional computers under Installation using the Dragon

command line.

9. Be sure you can access the .ini files from the old installation (minor upgrades) or the .ini files

you just created in the initial installation (major upgrades) from all computers you will be upgrad-

ing. (Or copy the files to a local path on the client computer where you are about to upgrade.)
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10. For a major upgrade, install the new version of Dragon with msiexec.exe by passing the installer

the /i option followed by the name of the Dragon .msi file and options like those shown in the

sample below:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-## REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon12"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"

REMOVEOLDPROD=1 /L*v "C:\logfile.log" /qn

To ensure that the entire old version of the product is removed, you pass REMOVE-

OLDPROD=1 (major upgrades only, not minor upgrades) so that the process removes the old

version of Dragon before installing the new. In addition, you should be sure to provide the full

path to each .ini file you are using.

11. For a minor upgrade, install the new version of Dragon with msiexec.exe the same way as you

would the major upgrade, only passing both REINSTALL or REINSTALLMODE options, as

shown in the sample below. Here REINSTALL is set to ALL and REINSTALLMODE is set to

vemus, where /v indicates to reinstall from the source (reupdating cache), e indicates to install

the newer file if one is available, mu means to rewrite the registry settings, and s means to rein-

stall all shortcuts and recache all icons. For more information on the REINSTALL and REIN-

STALLMODE settings, refer to MSI Options for Installing Dragon Features/Advanced

Options.

Here is a typical minor upgrade installation line:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR="C:\<full_path>\Dragon12"

DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
REINSTALL=ALL REINSTALLMODE=vamus

/L*v "C:\logfile.log" /qn

Caution: If you do not pass the REINSTALL and REINSTALLMODE options, the minor

upgrade will fail.
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Using setup.exe for Upgrades
Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

Although the upgrade does not migrate forward the configuration and Roaming User Profile set-

tings from the earlier version, you can reuse the nsdefaults.ini and roamingdef.ini files you used to

install Dragon NaturallySpeaking . You can also create new .ini files or update existing ones.

When you run setup.exe with a GUI to install a minor upgrade, setup.exe can detect when a pre-

vious version of Dragon exists on a target computer. Once it detects a previous version, setup.exe

runs the rest of your installation in minor upgrade mode, automatically overwriting older files with

newer files and adding any missing files. .

Using setup.exe for Silent Upgrades
If you are upgrading a previous version of Dragon, you must use the REINSTALL=ALL option

and REINSTALLMODE set to the sub-options that indicate which files to reinstall, usually

REINSTALLMODE=vamus. If you did not originally install in the default location, the

INSTALLDIR option is also required. Here is the command line using setup.exe:

To upgrade silently with setup.exe, you pass the /s option, then pass REINSTALL or REIN-

STALLMODE options. When you perform a silent installation of Dragon, the installation process

does not display any messages. To view installation messages, administrators should view the

setup log.

setup.exe /s /v"/i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
REBOOT=ReallySuppress
INSTALLDIR=\"C:\<full_path>\\Dragon12\"
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
ROAMINGUSERINI=\"C:\<full_path>\roamingdef.ini\"
REINSTALL=ALL REINSTALLMODE=vamus
/L*v C:\logfile.log /qn"

When you perform a silent installation or upgrade of Dragon, the installation process does not dis-

play any messages. To view installation messages, administrators should view the log files. See

Troubleshooting silent install errors for details.
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Step-by-Step Command Line
Installation with msiexec.exe

Another way to install Dragon from the command line on several dictation client computers is to

use the msiexec.exe program from Microsoft. You are required to use msiexec.exe instead of

setup.exe if you are installing Dragon from a server across a network to a single or multiple com-

puters.

In the sections that follow, you carry out these two tasks:

n Install Dragon on Initial computer and Establish Configuration

n Install Same Configuration on Additional computer(s)

Finding the MSI Installer on the Dragon DVD
The compiledMSI file is located on your installation DVD. The files for each edition are named:

n : Dragon NaturallySpeaking 12.msi

You can double click on one of these .msi files to start the InstallShield Wizard; however, to

instead take advantage of available command line options, you can pass the file name as the appli-

cation to install to the msiexec.exe command using the /i option:

msiexec.exe /i "Dragon NaturallySpeaking12.msi"

Install Dragon on Initial computer and Establish
Configuration
Follow the steps outlined under Installation using the Dragon command line.

Then return here and continue with the next section to install the same configuration on individ-

ual client computers using msiexec.exe instead of setup.exe.

Install Same Configuration on Additional
computer(s)
If you chose Enable Desktop Search Commands on the Commands tab during the initial instal-

lation, you must install Google Desktop or Microsoft Vista Search before you install Dragon;

otherwise, that option does not take effect.

1. Be sure you can access the .ini files you created in the previous procedure from the computer

you will be installing on or copy the files to a local path on the client computer where you are

about to install Dragon.

2. Be sure you have the Dragon serial number (or the group serial number, if you are installing

Dragon to multiple computers on a network).

3. Be sure all mapped drives you plan to use are mapped on individual client computers where you

are distributing the installation.

4. Install any pending Windows updates/reboot the computer.
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5. Open a command line window by selecting Start > Run and entering cmd.

6. On your product DVD, locate the compiled .msi file for the edition of Dragon you want to

install and switch to that directory.

7. Retrieve the customized nsdefaults.ini and roamingdef.ini files from the computer where carried

out the initial installation.

8. To install Dragon, enter the following command line, using the /i option also using the /qn

option to install the product in Quiet mode, where no GUI appears. You also pass the Dragon

serial number for the SERIALNUMBER option, the full path to the nsdefaults.ini file for the

DEFAULTSINI option, and the full path to the roamindef.ini file for the ROAMINGUSERINI

option:

msiexec /i "Dragon NaturallySpeaking 12.msi"

SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\Logs\logfile.log" /qn

Notes:

n For an administrative installation, you pass the /a option to msiexec rather than the /i option.

You also need to pass the TARGETDIR option instead of the INSTALLDIR option.

n The first time you test this installation, you should pass /q rather than /qn so that if you have

neglected to provide information about a setting that does not have a default, you receive a

prompt asking for that information.

The bolded portion of the preceding command line is included so that if something goes wrong

during the installation, you receive messages about it. You pass /L and a series of sub-options to

have the installation process log errors and other types of messages related to the process. (You

can then send the log file to Nuance Technical Support should any issues arise.)

Here are other optional actions you can take on the command line that link you to further instruc-

tions, below:
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Additional Options for Installations
with msiexec.exe

Note: In Dragon NaturallySpeaking , the installation process does not present the QuickStart

option. If you wish to enable this option, you can do so after Dragon is installed.

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the log files. See Trou-

bleshooting silent install errors for details.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

n Installing Some Vocabularies Locally/Others Only On Demand

n Installing Text-to-Speech Feature

n Reinstalling Dragon with Particular Set of Features

n Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation
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Additional Options for Silent
Installations

Note: In Dragon NaturallySpeaking , the installation process does not present the QuickStart

option. If you wish to enable this option, you can do so after Dragon is installed.

When you perform a silent installation of Dragon, the installation process does not display any

messages. To view installation messages, administrators should view the log files. See Trou-

bleshooting silent install errors for details.

Additional Options for Silent Installations

n Modifying the Default Installation Directory

n Configuring Installation of Product Updates

n Suppressing Reboot of computer After Installation

n Installing Same Roaming User Profile Configuration on Additional computer(s)

Additional Options with Extensive Settings for Silent Installations

n Installing Some Vocabularies Locally/Others Only On Demand

n Installing Text-to-Speech Feature

n Reinstalling Dragon with Particular Set of Features

n Setting Day/Time of Scheduled Tasks

Additionally, you can launch the Online Registration Form After Installation

Modifying Default Installation Directory
If you want to set an installation directory other than the default, pass INSTALLDIR="<path to

install>" to msiexec on the command line:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12"
/L*v "C:\Logs\logfile.log" /qn

Note: For an administrative installation, you should pass the TARGETDIR option instead of the

INSTALLDIR option.

Configuring Installation of Product Updates
If you want the individual client computer to download product updates to Dragon over the web,

you would set the PRODUCTUPDATEFLAG option to 1 (option checks the check box). If you

prefer to let the server download the updates and later distribute them to client computer, set this

option to 0 (unchecks the check box). To not even display the check box, set the option to -1.

For enterprise sites, choose -1 to prevent product updates from being downloaded.
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msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12"
PRODUCTUPDATEFLAG=-1 /L*v "C:\Logs\logfile.log" /qn

Suppressing Reboot of computer After Installation
To suppress rebooting of the computer after installation of Dragon completes, you can pass Micro-

soft's REBOOT option set to ReallySuppress. Using this option also suppresses the reboot some-

times required by the installation of Visual C++ Runtime for Dragon, which setup.exe installs in

the background. Using this option is highly recommended if you are executing a silent installation

(But if system updates are pending, rebooting is required for DNS to work normally.

REBOOT=ReallySuppress

The altered command line would look like this:

setup.exe /s /v"SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI=\"C:\<full_path>\nsdefaults.ini\"
INSTALLDIR=\"C:\<full_path>\Dragon12\" /qn
PRODUCTUPDATEFLAG=-1 REBOOT=ReallySuppress

/L*v C:\Logs\logfile.log /qn"

Suppressing Reboot of computer After Installation
To prevent the computer where you are installing Dragon from rebooting automatically after the

installation ends, you can pass Microsoft’s REBOOT option set to ReallySuppress:

REBOOT=ReallySuppress

The altered command line would look like this:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12"
PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
/L*v "C:\Logs\logfile.log" /qn

Installing the Same Roaming User Profile
Configuration on Additional computer(s)
Use the roamingdef.ini file you created during the initial installation as the input for the ROAM-

INGUSERINI option in this format (be sure to use the full path to the file when you pass the

option):
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ROAMINGUSERINI="Y:\<full_path>\roamingdef.ini"

In the above example, Y: is mapped network drive, accessible from client computers.

Optionally include the ROAMINGUSERINI option in the installation command line. If you do

not use this property, default settings are assumed.

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12"
ROAMINGUSERINI="C:\<full_path>\roamingdef.ini"
/L*v "C:\nuanceLogs\logfile.log" /qn

After you have completed the installation, verify that all options are correctly set on the client

computer.

Launching Online Registration Form After
Installation
To have the online registration form for Dragon pop up on the workstation in its browser imme-

diately after the installation completes, you can pass a option to the WEBREGISTRATION

option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which

means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1

WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

Installing Some Vocabularies Locally and Others On
Demand
When you install Dragon on a client computer, by default you install all the available vocabularies

locally.
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If you do not want all of those vocabularies to be installed locally, but to instead have them

installed only if/when an end-user attempts to create a particular vocabulary, you can indicate that

fact on the installation command line by adding the ADDLOCAL option and setting it to the

names of the vocabularies to install locally.

For instance, to install only an English Legal vocabulary, you would set ADDLOCAL to Nat-

Speak, ENUGeneral and the command line would appear as follows (NatSpeak must be in the set-

ting of ADDLOCAL, unless you set ADDLOCAL to ALL, or the installation will fail):

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress ADDLOCAL=NatSpeak,ENUGeneral
/L*v "C:\Logs\logfile.log" /qn

Separate the features/vocabularies for ADDLOCAL with commas, but do not put spaces in the

list. The names you must use for the vocabularies consist of a prefix for the language, then the

name of the vocabularysuch as ENU for English and General to form ENUGeneral. For a list of

the exact names for features/vocabularies you can assign to ADDLOCAL or ADVERTISE on the

command line, refer to Summary: MSI Options for Installing Dragon Features/Advanced

Options.

Installing Text-to-Speech Feature
To install Text-to-Speech locally, you would include the feature in the list of features for ADD-

LOCAL; for instance, you would add TTSENX for Text-to-Speech in English:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
ADDLOCAL=TTSENX,NatSpeak,ENUGeneral
/L*v "C:\Logs\logfile.log" /qn

Reinstalling Dragon with Particular Set of Features
Sometimes you want to reinstall Dragon and add or remove particular features of the product. You

can also take this action on the command line using the REINSTALL and REINSTALLMODE

options of the MSI installer. You set REINSTALL to those features you want to install or to

ALL.

For example, to install a minor upgrade to Dragon, you might use this command line:

msiexec /i "Dragon NaturallySpeaking12.msi" REINSTALL=ALL REIN-
STALLMODE=vamus /qn
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The vemus options: v indicates to reinstall from the source (reupdating cache), e indicates to

install the newer file if one is available, mu means to rewrite the registry settings, and s means to

reinstall all shortcuts and re-cache all icons. For more information on the REINSTALL and REIN-

STALLMODE settings, refer to Summary: MSI Options for Installing Dragon Fea-

tures/Advanced Options.

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

Setting Day/Time for Scheduled Tasks
To retain the default schedule for data collection and modify schedules for acoustic model opti-

mization to Mondays at 1 AM and language model optimization to Mondays at 6 AM, you would

set the PERIODIC_TASK string as follows:

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"

An MSI installation command line including the option setting this schedule would look like this:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
INSTALLDIR="C:\<full_path>\Dragon12"
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
ROAMINGUSERINI="C:<full_path>\roamingdef.ini"
PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 06:00"
/L*v "C:\Logs\logfile.log" /qn

For more information on the PERIODIC_TASK option, refer to MSI Options for Roaming User

Profile, Tuning, and Data Collection Setup.

Launching Online Registration Form After
Installation
To have the online registration form for Dragon pop up on the workstation in its browser imme-

diately after the installation completes, you can pass a option to the WEBREGISTRATION

option and set it to 1 (applies only if you do not use the /qn option). The default is 0 which

means registration will not be launched.

WEBREGISTRATION=1

The revised command line would look like this:

msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1
REBOOT=ReallySuppress
WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"
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msiexec /i "Dragon NaturallySpeaking 12.msi"
SERIALNUMBER=#####-###-####-####-##
DEFAULTSINI="C:\<full_path>\nsdefaults.ini"
INSTALLDIR="C:\<full_path>\Dragon12" PRODUCTUPDATEFLAG=-1

WEBREGISTRATION=1 /L*v "C:\Logs\logfile.log"

193



Dragon 12 Administrator Guide

MSI Options Specific to Dragon
This section describes the fundamental msiexec.exe options that apply to Dragon Nat-

urallySpeaking . Additional options that apply only to a Dragon installation are listed in:

n MSI Windows Installer Options

n MSI Options for Installing Dragon Features/Advanced Options

n MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Dragon command line options do not need to be prefaced by hyphens or slashes.

Notes:

n In Dragon NaturallySpeaking , the installation process does not present the QuickStart option.

If you wish to enable this option, you can do so after Dragon is installed.

n Launching msiexec.exe /i "Dragon NaturallySpeaking 12.msi" XYZ=ABC automatically sets the

property named XYZ to the value of ABC internally and continues the installation. However, if

you use setup.exe to install, you must put all msiexec.exe options you pass it in quotation marks

after the /v option.

Unless noted otherwise, all property values are in UPPERCASE.

Options Description

DEFAULTSINI="c:<path>\

nsdefaults.ini"

Indicates a default settings (nsdefaults.ini ) file

that the installer uses to change the default

behavior of the product for all end-users at

installation time. This file must be in an .ini

file format; any settings you want to take

effect on clients must have a section name

encased in square brackets as well as the

value and data. If only values and data are set

in this file without the section name encased

in brackets, the settings are not propagated

on client computers. Usually, you do not edit

the nsdefaults.ini file directly; instead you

set defaults in Dragon’s Options and Admin-

istrative Settings dialog boxes.

Follow these steps to create a nsdefaults.ini

file for an MSI installation:

Install Dragon on a computer with Windows

administrator privileges.

Set options in the Options and Admin-

istrative Settings dialog boxes as required in

your environment and save them by closing

Dragon.
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Options Description

Copy the nsdefaults.ini file created by this

installation of Dragon to a separate location.

By default, the nsdefaults.ini is located in:
C:\Documents and Settings\All
Users\Application Data\N-
uance\NaturallySpeaking12\

Use the copied nsdefaults.ini as the input

for the DEFAULTSINI option.

SERIALNUMBER=abcde-fgh-

ijkl-mnop-qr

A serial (license) number is required for all

installations. You must specify a valid serial

number on the command line.

Note: Specifying a serial number on the com-

mand line does not bypass the serial number

checking within setup.

PRODUCTUPDATEFLAG=0

(or 1 or –1)

Sets the default state of the product update

check box at the end of installation, to indi-

cate whether the installation should auto-

matically check the web for product updates.

Automatic product updates are not sup-

ported for enterprise installations.

A value of 0 (zero) turns the check box off

by default, 1 (one) turns it on by default.

To disable the option entirely (turn the

option off and suppress the display of the

check box altogether), set the value to –1.

The default setting is 1 (enables the check

box and checks for product updates by

default).

SETDEFAULTS=0 (or 1) If set to 1, sets the default state ofModify

the application’s settings for all users

check box to display the Options dialog box

at the end of the installation. The Options

dialog box lets you change Dragon’s standard

behavior, including specifying hot keys, cus-

tomizing how text is formatted, changing ini-

tial microphone settings, and setting the how

often your User Profiles are backed up.

Applies only if your installation displays the

Installation Wizard.

A value of 0/1 will turn check box off/on

accordingly.
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Options Description

With SETDEFAULTS=1, no dialogs display

during installation if /qn is used for Quiet

mode installation.

SETADMINS=0 (or 1) If set to 1, sets the default state ofModify

the administrative settings check box to

display the Administrative settings dialog

box at the end of the installation. The

Administrative settings dialog box lets you

set up the Roaming feature, set the backup

location of your User Profiles, and restrict

end-users from modifying commands and

vocabularies. Applies only if your installation

displays the Installation Wizard.

A value of 0/1 will turn checkbooks off/on

accordingly.

With SETADMINS=1, no dialogs display

during installation if /qn is used for Quiet

mode installation.

SETFORMATTINGS=0 (or

1)

If set to 1, sets the default state ofModify

the administrative settings check box to

display the Auto-Formatting dialog box at

the end of the installation. The Auto-For-

matting dialog box lets you set up visual for-

mats for the output of the recognized text,

including standard abbreviations and other

preferences. Applies only if your installation

displays the Installation Wizard.

A value of 0/1 will turn check box off/on

accordingly.

With SETFORMATTINGS=1, no dialogs

display during installation if /qn is used for

Quiet mode installation.

WEBREGISTRATION=1 (or

0)

Determines whether or not to launch the on-

line product registration form after the instal-

lation completes. 0 disables the product reg-

istration. The default of 1 enables display of

the form.
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MSI Options for Installing Dragon
Features/Advanced Options

This section describes additional msiexec.exe options that apply to Dragon NaturallySpeaking .

Although these options are for msiexec.exe, they are also available for setup.exe if you use them

with the /v“ option.

Other options are listed under:

n Summary: MSI Windows Installer Options

n Summary: MSI Options Specific to Dragon.

n Summary: MSI Options for Roaming User Profile, Tuning, and Data Collection Setup

Note: A Minor upgrade involves upgrading to a higher point release within the same edition and

version of Dragon. For example, upgrading from Dragon 11.0 to Dragon 11.x.

The following table presents options that apply to a Dragon installation where you select particular

features to install. Unless noted otherwise, all property values are in UPPERCASE.

Options Description

ADDLOCAL=Feature1,Feature2,... or ADD-

LOCAL=ALL

Set the ADDLOCAL property to a list of

features to be installed locally, delimited by

commas. To install all features locally

(including User Profiles), use ADD-

LOCAL=ALL on the command line.

ADVERTISE=Feature1,Feature2,FEATURE3,... Set the ADVERTISE property to a list of

features to be available but not locally

installed, delimited by commas. To install

all features as advertised, use ADVER-

TISE=ALL on the command line. The

ADVERTISE option overrides the ADD-

LOCAL option. The best method for

installing a particular set of features is to

set the ADDLOCAL property to ALL and

then set the ADVERTISE property to

those features you do not want installed

locally. A list of the features that you can

set for installation is listed in the section

after this table.

REINSTALL=Feature1,Feature2,... (or ALL) List of features that are to be reinstalled,

delimited by commas. To reinstall all fea-

tures use REINSTALL=ALL on the com-

mand line.
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Options Description

If you set the REINSTALL property, you

should also set the REINSTALLMODE

property, to indicate the type of reinstall to

be performed. If the REINSTALLMODE

property is not set, then by default all files

that are currently installed are reinstalled

only if the currently installed file is an ear-

lier version (or is not present). By default,

no registry entries are rewritten.

Note that even if REINSTALL is set to

ALL, only those features that were already

installed previously are reinstalled. Thus, if

REINSTALL is set for a product that is yet

to be installed, no installation action takes

place at all.

For more information, see:
http://msdn.microsoft.com/library/
default.asp?url=/library/en-
us/msi/setup/reinstall.asp

REINSTALLMODE={type of rein-
stallation to perform}

String that contains letters indicating the

type of reinstall to perform. Options are

case-insensitive and order-independent.

This property should normally always be

used in conjunction with the REINSTALL

property. However, this property can also

be used during installation, not just during

a reinstall.

See REINSTALLMODE for more details.

REMOVEOLDPROD=1 Removes the old version of the product

before installing the new version. Should

be used in major upgrades only.

/x<Product.msi|ProductCode> Un-installs the currently installed version

of Dragon. You are required to take this

action during upgrading; however, you

should be familiar with the entire upgrade

procedure before proceeding with this

option.

REINSTALLMODE

By default the REINSTALLMODE=omus to reinstall all files whose checksums are missing or

corrupt, rewrite all registry names, reinstall all shortcuts and re-cache icons. Below is a list of the

options with abbreviated definitions:

p — Reinstall only if the file is missing.
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o — Reinstall if the file is missing or is an older version.

e — Reinstall if the file is missing or is an equal or older version.

d — Reinstall if the file is missing or a different version is present.

c — Reinstall only files whose checksums are missing or corrupt.

a — Force all files to be reinstalled, regardless of checksum or version.

u — Rewrite all required registry entries from the Registry Table that go under HKEY_CUR-

RENT_USER or HKEY_USERS .

m— Rewrite all required registry entries from the Registry Table that go under HKEY_LOCAL_

MACHINE or HKEY_CLASSES_ROOT. Regardless of computer or user assignment, rewrite all

info from these tables: Class, Verb, PublishComponent, ProgID, MIME, Icon, Extension, and

AppID . Reinstall all qualified components. When reinstalling an application, run the Reg-

isterTypeLibraries and InstallODBC actions.

s — Reinstall all shortcuts and re-cache all icons, overwriting existing shortcuts and icons.

v — Run from the source package, re-cache the local package. Does not apply to new installation

of a product or feature.

If you set REINSTALLMODE without also setting REINSTALL, then the detection modes

you specify still apply and the overwrite mode is used. The REINSTALLMODE property

affects only those features selected for installation using REINSTALL.

For example, to launch a minor upgrade without using setup.exe, you must set the following

properties on the command line:

REINSTALL=ALL REINSTALLMODE=vamus

To install a minor upgrade using an .msi file, use this command line:

msiexec /i "Dragon NaturallySpeaking12.msi" REINSTALL=ALL REINSTALLMODE=vamus

For more information on REINSTALLMODE and the reinstall option codes, see:
http://msdn.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/reinstallmode.asp
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MSI Options for Roaming User Profile,
Tuning, and Data Collection Setup

This section summarizes the Roaming User Profile, acoustic/language model tuning, and data col-

lection options for command line installations of Dragon NaturallySpeaking . Other options are

listed under:

n Summary: MSI Windows Installer Options

n Summary: MSI Options Specific to Dragon

n Summary: MSI Options for Installing Dragon Features/Advanced Options

Options Description

PERIODIC_TASK=<string> Sets schedule for either one, two, or three tasks— an acoustic
model optimization (ACO) task, language model optimization (LMO)
task, and/or data collection (DC) task. You can schedule each task
to run daily or weekly, but need to set the schedule for each task
only once.

See PERIODIC_TASK for more details.

ROAMINGUSERINI="c:\xyz.ini" Specifies a roaming user .ini file (roamingdef.ini) that contains the
Master Roaming User Profile location and any associated HTTP or
HTTPS settings for a Roaming User Profile. These are the same options
set in theNetwork Directories field of the Roaming tab of the
Administrative settings dialog box and theHTTP and HTTPS Set-
tings dialog boxes.

See ROAMINGUSERINI for more details.

PERIODIC_TASK

The <string> of PERIODIC_TASK contains these arguments, separated by semicolons:

aco | lmo | dc—One, two, or all three of them with a vertical bar separating each. If
you do not pass the acronym for the feature, that feature is set to its default.

Administrator login name. Be sure you use the fully qualified <domain name>\<account
name> in a case where the end-user is a local administrator but the computer is on a
domain.

Administrator password.

When to run the task(s), with times for each of multiple tasks separated by a vertical bar
(|). Each scheduled time should be in the format DayOfWeek, hh:mm, where the day of the
week is the three letter abbreviation (no period), the time is the 24-hour time, and the
comma between them is required.

The task runs once a week on the day/at the time you indicate. If you omit the DayOfWeek,
the task runs every day at the time given.

The first of multiple times becomes the schedule for the first task named in the first param-
eter, the second time the schedule for the second task, the third the schedule for the third
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task. If you omit a time by having two vertical bars with no time between them or by leav-
ing out the first or last time, the corresponding task is scheduled for a default time.

Default Schedules

Acoustic model optimization (ACO) — Mon, 02:00

Language model optimization (LMO) — Every day, 03:00

Data collection (DC) — Fri, 01:00

Examples of PERIODIC_TASK Settings

A string setting this option to perform an acoustic model optimization every Monday at 1
AM and a language model optimization the same day at 4 AM is (notice the comma
between the day of the week and the time):

PERIODIC_TASK="aco|lmo;admin;pswd;Mon, 01:00|Mon, 04:00"

To schedule only data collection and language model optimization tasks and have them occur

every day at 4 PM and 11 PM, respectively, you would enter only the time for each task, without

indicating a particular day:

PERIODIC_TASK="dc|lmo;myadmin;mypswd;04:00|23:00"

A string setting this option to perform an acoustic model optimization every Tuesday at midnight,

data collection every Wednesday at 3 AM, and a language model optimization every Friday night at

10 PM is:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:|Wed, 03:00|Fri,
22:00"

To have the data collection and language model optimization tasks occur at default times, you

modify the previous string by removing the times for those tasks, but leaving space between the

vertical bars and after the last vertical bar:

PERIODIC_TASK="aco|dc|lmo;myadmin;mypswd;Tue, 00:| | "

ROAMINGUSERINI

When you enable the Roaming feature, Dragon creates an encrypted roamingdef.ini file.

Use the following steps to create a roamingdef.ini file to be used for an MSI installation where

the Roaming feature is enabled:

Install Dragon on a computer with Windows administrator privileges.

Enable the Roaming feature options required in your environment. These must include the Master

Roaming User Profile location set in the Network Directories field in the Roaming tab of the

Administrative Settings dialog box and any HTTP or HTTPS settings.

Test these settings to make sure the Roaming User Profile connection works.

Save your settings by closing Dragon.

Copy the encrypted roamingdef.ini or roaming.ini file (use the one that is newer) created by this

installation of Dragon to a separate location. By default, the .ini is located in:
C:\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\
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Set the ROAMINGUSERINI option to the name of the roamingdef.ini file. The default is empty

(no .ini file will be used).

To set these options using ROAMINGUSERINI, the Roaming feature must be enabled in the

nsdefaults.ini file.

202



Chapter 5: Installing Dragon using the Windows installer (MSI)

Feature Variables to Set Through the
ADDLOCAL or ADVERTISE Properties

When specifying features on the command line:

n If a feature does not exist in a particular edition or language, overriding its default property has

no effect.

n Some features (such as Text-to-Speech) have sub-features. Setting these features on the

command line automatically turns on the properties of all sub-features, unless you specify an

additional override for those sub-features.

n Any information in parentheses after the sub-feature is not included in the feature name.

You can specify any of the following features using ADDLOCAL and ADVERTISE properties on

the command line:

Feature Sub-feature

NatSpeak None Dragon NaturallySpeaking :

Sub-features for ENU (US Eng-

lish):

Samples

(Sample Commands
file)

None

TTS (Text-to-
Speech)

TTSDEU (German

Text-to-Speech)

TTSENU (US Eng-

lish Text-to-Speech)

TTSENG (British

English Text-to-Speech)

TTSESP (Spanish Text-to-Speech)

TTSFRA (French Text-to-Speech)

TTSITA (Italian Text-to-Speech)

TTSNLD (Dutch Text-to-Speech)

Tutorial TutDEU (German

Tutorial)

TutENX (English

Tutorial)

TutESP (Spanish Tuto-

rial)

TutFRA (French Tutorial)

TutITA (Italian Tutorial)

TutNLD (Dutch Tutorial)

Speech—DEU
(German)

Sub-features for

DEU (German)

DEUGeneral (Ger-

man General Large,

Swiss German General,

Empty Dictation Gen-

eral)

DEULegal (German

Legal)

)
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Feature Sub-feature

Tutorial TutDEU (German

Tutorial)

TutENX (English

Tutorial)

TutESP (Spanish Tuto-

rial)

TutFRA (French Tutorial)

TutITA (Italian Tutorial)

TutNLD (Dutch Tutorial)

Speech ENX (Eng-

lish)—

ENU (US English)

Dragon Nat-

urallySpeaking : Sub-

features for ENU

(US English)

ENULegal (US Eng-

lish Legal Large)

ENUGeneral (US

English General

Medium, US English

Empty Dictation,

US English Commands

Only)

ENUGenSvc

(US English Large

General)

The ENU sub-feature
includes support for the
following accents:

n General — Use if your

accent is not covered by the

other choices or you are not

sure which accent to select.

n Australian accented English

n British accented English

n Indian accented English

n Inland Northern US (Great

Lakes area)

— Covers Upstate New York

through the Chicago area.

n SEAsian accented English —

South East Asian

n Southern US — Covers most

of the Southern United

States, including Texas.

n Spanish Accented English.

n Teens

Speech ENX
(English)—
ENG (UK
English)

Dragon Nat-

urallySpeaking : Sub-

features for ENG

(UK English):

ENGGeneral (UK

English General

Large, Empty Dic-

tation General, Com-

mands Only

The ENG sub-feature includes

support for the following

accents:

n General — Use if your

accent is not covered by the

other choices or you are not

sure which accent to select.

n Australian accented English.

n Indian accented English.

n SEAsian accented English –

South East Asian.

Speech—ITA
(Italian)

Sub-features for ITA

(Italian):
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Feature Sub-feature

ITA (Italian General

Large and Italian

Empty Dictation Gen-

eral Large)

Speech—NLD
(Dutch)

Sub-features for

NLD (Dutch)

NLDGeneral (Dutch

General Large and

Dutch Empty Dictation

General Large)

Speech—FRA
(French)

Sub-features for

FRA (French):

FRAGeneral (French

General Large, French

Empty Dictation Gen-

eral Large)

Speech—ESP
(Spanish)

Sub-features for ESP

(Spanish)

ESP (Latin American

Spanish General Large)

ESP (Latin American

Spanish Empty

Dictation General

Large)

ESP (Castilian Span-

ish General Large)

Speech—ESP (Spanish)
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using the Roaming feature
and Roaming User Profiles

This section describes how to set up, configure, and enable the Roaming feature on client computers.
This section also provides information on how to create, dictate with, and upgrade Roaming User Pro-
files.

Setting up the Roaming feature 209

Overview of the Roaming feature 211

Setting up the Roaming feature 216

Creating a network storage location for the Master Roaming User Profiles 217

Where to install and configure Dragon NaturallySpeaking 221

Storage space required for the Master and Local Roaming User Profiles 223

How Dragon Synchronizes Master and Local Roaming User Profiles 225

Estimating Network traffic caused by synchronization 229

Enabling the Roaming feature on each computer where an end-user will dictate 232

Administrative Settings: Roaming tab 236

Administrative Settings: Roaming User Network Location 239

Setting up HTTP Connection: HTTP Settings 241

Setting up secure web server connection: SSL Settings 244

Testing and troubleshooting an HTTP connection 246

Setting and selecting Roaming User Profile options 248

Creating a Roaming User Profile on the local computer 254

Creating and training a new Roaming User Profile 255
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Converting a non-roaming local User Profile into a Roaming User Profile 256

Dictating with a Roaming User Profile 257

Opening a Roaming User Profile 258

Using multiple dictation sources with a single User Profile 259

Running the Acoustic and Language Model Optimizer for Roaming User Profiles 260

Controlling access to User Profiles 262

Configuring Internet Information Services and WebDAV for HTTP Roaming 264

Configuring Internet Information Services and WebDAV 265

Configuring Dragon internet roaming 267

Upgrading Roaming User Profiles: Overview 268

Preparing to upgrade Roaming User Profiles 270

Upgrading master Roaming User Profiles 273

Upgrading end-user systems 278
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Setting up the Roaming feature
The Roaming feature lets end-users dictate with Dragon NaturallySpeaking from different network

locations and on different computers without having to create and train individual User Profiles at

each location.

The Roaming feature works by storing User Profiles in a central network location so that the infor-

mation Dragon learns from an end-user dictating on one computer is also available on other com-

puters.

To set up Roaming User Profiles, carry out the steps shown in the table below, in chronological

order.

Topic Link

The Roaming feature Overview of the Roaming fea-

ture

Setting up the Roaming feature:

n Creating a network storage location for the Master
Roaming User Profiles

n Where to install and configure Dragon Nat-
urallySpeaking

n Storage space required for the Master and Local Roam-
ing User Profiles

n How Dragon Synchronizes Master and Local Roaming
User Profiles

n Estimating Network traffic caused by synchronization

Setting up the Roaming feature

Enabling the Roaming feature on each com-

puter where an end-user dictates:

n Setting Roaming User Profile locations
n Setting Roaming User Profile options
n Testing an HTTP or HTTPS connection

Enabling the Roaming feature

on each computer where an

end-user will dictate

Creating Roaming User Profiles:

n Creating and training a new Roaming User Profile
n Converting a non-roaming local User Profile into a
Roaming User Profile

n Copying a non-Roaming User Profile to the Master
Roaming User Profile location

Creating a Roaming User Profile

on the local computer

Dictating with a Roaming User Profile:

n Opening a Roaming User Profile
n Usingmultiple dictation sources with a single User Pro-
file

n Running the Acoustic and Language Model Optimizer
for Roaming User Profiles

n SynchronizingMaster and Local Roaming User Profiles

Dictating with a Roaming User

Profile
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Topic Link

Upgrade Roaming User Profiles from Dragon

NaturallySpeaking 10.x or 11.x to Dragon Nat-

urallySpeaking

Upgrading Roaming User Pro-

files: Overview
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Overview of the Roaming feature
The Roaming feature lets end-users dictate with Dragon from different network locations and on

different computers without having to create and train individual User Profiles at each location.

Some situations that the Roaming feature makes possible:

n A doctor may need to dictate reports in a medical office building using a desktop computer, in a

hospital room using a Tablet PC, or at home using a laptop computer. The Roaming feature

allows the doctor to use the same set of User Profiles containing the same vocabulary words

with the acoustic information from each location.

n An end-user dictates on the same laptop at multiple offices and at home. Before leaving the

office, the end-user loads a set of User Profiles from a central location on the network to his

laptop. Once home, the end-user dictates and corrects as you normally would. When you return

to the office, you reconnect the laptop to the network. The next time the end-user opens a

Dragon user profile, the Roaming feature synchronizes the updated User Profiles on the laptop

with those at the network’s central location.

The relationship between the Master and the Local
Roaming User Profile
With the Roaming feature, each Dragon user profile has a single Master Roaming User Profile that

can be opened from multiple networked computers running Dragon. The Master Roaming User

Profile is stored on a network location accessible to your dictating end-users.

When a Master Roaming User Profile is opened from that central network location, Dragon trans-

fers a copy of that User Profile to the local computer. That local copy is called the Local Roaming

User Profile.

The Local Roaming User Profile is a copy of the end-user data taken from the Master Roaming

User Profile but modified locally by corrections and acoustic data gathered during a dictation ses-

sion.

You can set a central storage device to contain all your Master Roaming User Profiles. By loading a

Dragon User Profile from the central network location, your end-users can dictate at any computer

where Dragon is installed. When end-users exit Dragon and save the changes to their User Profiles,

these changes are saved in that central location. The next time the end-user runs Dragon, all the

changes saved are available regardless of which computer on the network he or she uses for dic-

tation.

Advantages of the Roaming feature
It is important to distinguish the Roaming feature from simply browsing to a network directory

and creating files there. Nuance recommends using the Roaming feature rather than storing non-

Roaming User Profiles in a network directory. Using the Roaming feature, you can:

n Minimize network traffic. When Dragon opens a User Profile, if there is already a copy of the

Roaming User Profile on the local computer, only the updates are downloaded from the

network. When the end-user closes the User Profile at the end of his or her dictation session,
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only the updates from the current session are uploaded to the network. These updates typically

amount to no more than a few KB of data, as opposed to roughly 55 MB of data if the entire

User Profile is opened and closed over the network.

n Allow the end-user to use Dragon even if the network directory is unavailable. In that case,

Dragon opens the local copy of the Roaming User Profile.

n Give the administrator precise control over where end-users can put User Profiles. If the

Roaming feature is enabled, the administrator can specify whether or not to also allow end-users

to browse to any User Profile location; the default is not to allow browsing. This means that the

administrator can easily see how many User Profiles have been created and who created them. If

the Roaming feature is not enabled, end-users can browse to any location to which they have

access and create User Profiles there.

n If HTTP Roaming is configured, it can be used to provide username/password authentication

on User Profiles.

Hosting Master Roaming User Profiles
There are several methods for hosting your Master Roaming User Profiles:

n On a file server you connect to over a Mapped Drive

n On a file server that you connect to over a UNC (Universal Naming Convention) address

n On a web server that you connect to over HTTP (http://)

n On a secure web server that you connect to over SSL (https://)

Why the Master Roaming User Profiles should be in
shared directories
Nuance recommends placing the master Roaming User Profiles in a shared directory to make cer-

tain administrative tasks more efficient. These tasks include:

n Scheduling an Acoustic and Language Model Optimizer task that optimizes multiple User

Profiles

n Upgrading multiple User Profiles to a new major release of Dragon

n Keeping track of how many User Profiles have been created, which helps with licensing

compliance (note that Dragon is licensed per end-user, not per workstation)

It is possible, though not recommended, to place Roaming User Profiles in a non-shared, end-

user-specific location such as the end-user’s home drive, provided every end-user’s home drive is

mapped to the same drive letter (this is because the Roaming User Profile location is an admin-

istrative setting that is per-workstation, not per-user).

Using multiple Roaming User Profile locations

If you have a large number of Roaming User Profiles, you may want to divide them among mul-

tiple shared directories. This facilitates performing tasks such as scheduling the Acoustic and Lan-

guage Model Optimizer on a subset of User Profiles. You can choose how to divide your User

Profiles, for example:
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n By department

n By alphabetical groupings (for example A through H, I through M, N through R, and S through

Z)

On each PC, you can configure any number of Roaming User Profile locations. Make sure you

give each Roaming User Profile location a display name that makes it clear to your end-users

which location to choose from.

Controlling access to User Profiles
If you have multiple Dragon end-users on an end-user workstation, those end-users will have mul-

tiple User Profiles to choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may

be concerned about the ability of an end-user to see and/or open another end-user’s profile as

well as their ability to open the correct profile. There are several ways to address this concern:

n Many of Nuance’s customers address this concern simply through end-user training. Each end-

user should be aware that if they open another end-user’s profile and try to use it, their accuracy

will be poor and end-user-specific customizations will not be available. Therefore, each end-

user has an incentive to use only their own profile. However, this fact does not prevent a

malicious end-user from damaging another end-user’s profile.

n If end-users always log into Windows with a unique Windows user ID, you can use Windows

file permissions to control access to the profiles. Typically, you do this by granting Full Control

or Read/Write/Modify access to the shared directory, but do not allow this permission to

propagate to sub-directories. That way, each end-user becomes the creator owner of any Dragon

User Profile that he or she creates. End-users can still see all of the Dragon User Profiles in the

Open User Profile dialog box, but if they try to select another end-user’s profile, a message will

appear saying that they do not have permission to access that profile. Apply similar file

permissions to the local copy of each Roaming User Profile; the default location for local copies

is under
C:\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking12\RoamingUsers for Windows XP

C:\ProgramData\Nuance\NaturallySpeaking12\RoamingUsers for Windows Vista,
Windows 7, and Windows Server 2008.

n If end-users log in using a shared Windows user ID, the best way to control access is through

HTTP Roaming. In this configuration, you set up a web server running either IIS or Apache

and with the WebDAV file system enabled. On each workstation, you specify a URL on the

web server as the Roaming User Profile location. When an end-user launches Dragon, before

displaying the Open User Profile dialog it prompts for a user name and password, which it uses

to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to

each account on the web server. File security is a function of the web server and the WebDAV

software.
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Making it easier for end-users to select their User Profiles 

As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in

a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there

are more User Profiles than will fit on one screen, you can train end-users to go directly to a spe-

cific User Profile by typing the first few letters of its name.

It is possible to create an icon in the Start Menu and/or the Windows desktop that opens a spe-

cific User Profile. This can be helpful if there are only a few end-users of Dragon who share a par-

ticular workstation. Make a copy of the Dragon icon for each end-user, and place the parameter

/user ″user name″ on the natspeak.exe command line.

In Dragon NaturallySpeaking , you can display and view groups of User Profiles in a tree-style

structure. See "Open User Profiles dialog box optimized for Roaming" in Dragon - What's New

for administrators for more information.

Backing up your Master Roaming User Profiles
Dragon does not backup local Roaming User Profiles on the end-user workstations and does not

backup the Master Roaming User Profiles on the location where they are stored on your network.

It is the responsibility of your local system administrator to backup the Master Roaming User Pro-

files.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:
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n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Setting up the Roaming feature
When setting up the Roaming feature, note the following:

n Creating a network storage location for the Master Roaming User Profiles

n Where to install and configure Dragon

n Storage space required for the Master and Local Roaming User Profiles

n Synchronizing Master and Local Roaming User Profiles

n Estimating Network traffic caused by synchronization

Note: To enable the Roaming feature and set the Roaming User Profile options, you must log into

an account with Windows Administrator privileges.
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Creating a network storage location
for the Master Roaming User Profiles

For any installation of Dragon, you must first determine where on the network the Master Roam-

ing User Profiles should be located. 

Dragon lets you store your Master Roaming User Profiles on:

n Any networked computer.

You are not strictly required to store Master Roaming User Profiles on a server. Any shared

location accessible to other computers on the network is a perfectly acceptable place to store

Master Roaming User Profiles.

n a Windows file server

n A web server (HTTP)

n A secure web server running SSL (HTTPS)

Note: The location(s) you pick must be accessible to all computers where users will dictate with a

Roaming User Profile. Each location must have adequate storage space for Roaming User Profiles.

For more information, see Storage space required for User Profiles.

What to consider for the Master Roaming User
Profile location
To set up a location for the Master Roaming User Profiles, you should first determine:

n The kind of network file server on which you want to store your Master Roaming User Profiles.

Make sure it has enough storage space. Each location you pick must be accessible to all

computers where your users will dictate with Roaming User Profiles. You can create multiple

network storage locations.

n How the computers from where your users will dictate will connect to that network location;

for example using a mapped drive, UNC connection, or an HTTP or HTTPS connection.

Using a networked computer or Windows file
server
If you choose to use a networked computer or Windows server, you should determine the path to

where the Master Roaming User Profiles will reside. You can create multiple network storage loca-

tions.

The Roaming feature supports the following types of locations for your Master Roaming User

Profiles:  

n Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

n UNC Paths—Connects to a shared network folder using the Universal Naming Convention

(UNC) to locate a User Profile. Format is: \\<servername>\<sharename>\<path>\<filename>.
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What you'll need to know to configure your local Roaming User Pro-
files

After you have chosen the type of computer to store the Master Roaming User Profiles, you

should determine the following information so that you configure your local copies of Dragon to

connect to a mapped or shared drive:

Mapped Drives

UNC paths

Using a HTTP or HTTPS web server
If you choose to use a HTTP or HTTPS web server, the Roaming feature supports the following

types of locations for your Master Roaming User Profiles

n HTTP (http:)—Connects to computer on the internet or your local intranet. Format is:

http://<myserver.com>/<webdav>

n HTTP with SSL (https:)—Connects to computer on the internet or your local intranet with

SSL. Format is: https://<myserver.com>/<webdav>

Supported web servers

If you want to store your Master Roaming User Profiles on a web server, Internet access to Master

Roaming User Profiles is supported on two web servers:

n Microsoft Internet Information Services (IIS) 7.0 and 7.5. For this type of server:

l Be sure that the server has Web-based Distributed Authoring and Versioning

(WebDAV) software is turned on to publish content to an Internet Information

Services (IIS) web server.

If you have not already installed the WebDAV component, use the Add or

Remove Programs in your Control Panel and run the Windows Components

Wizard. WebDav is listed under Application Server>Internet Information

Services>World Wide Web Service>WebDAV Publishing.

n Apache HTTP Server 2.0.54 and higher. For this type of server:
l Internet Roaming User—Redirects must be turned on when using Digest

authentication.

l Be sure that the server has Web-based Distributed Authoring and Versioning

(WebDAV) software turned on. The WebDAV Apache module is available free

of charge at http://www.webdav.org/mod_dav/.

What you'll need to know to configure your local Roaming User Pro-
files

After you have chosen the type of computer to store the Master Roaming User Profiles, you

should determine the following information so that you configure your local copies of Dragon to

connect to the HTTP server:

n The network location: You need to know the URL address of your HTTP server.
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For more information, see XXXXX.

n HTTP settings: For your http (or https) connection you need to know

authentication, firewall, and proxy server information. For more information, see

HTTP Settings.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:

n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Add all file extensions within your Master Roaming User Profile directories and

sub-directories to the Registered MIME types list of your IIS server. You could

also add a wildcard ( .*) MIME-type.

For more information on adding a wildcard ( .*) MIME-type, see:

For Windows Server 2008:

http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx
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l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Where to install and configure Dragon
NaturallySpeaking

Installing Dragon NaturallySpeaking where you
plan to dictate using the Roaming feature
Dragon NaturallySpeaking must be installed each computer where you plan to have users dictating

with Roaming User Profiles.

Installing Dragon NaturallySpeaking on the same
computer as your Master Roaming User Profiles
Nuance recommends that you install Dragon NaturallySpeaking on the same computer where the

Master Roaming User Profiles for your network are located.

As the system administrator, you are responsible for running the Acoustic and Language

Model Optimizer on the network location of the Master Roaming User Profiles. The Acoustic

and Language Model Optimizer and the Acoustic and Language Model Optimizer Sched-

uler can only be run on the Master Roaming User Profiles.

Running the Acoustic and Language Model Optimizer updates the Master Roaming User Profiles

with the accumulated acoustic data from any corrections and additional training done by the users

at the computers where they dictate. Running the Acoustic and Language Model Optimizer will

increase your overall accuracy. Any optimizations done by the Acoustic and Language Model

Optimizer are copied to each Local Roaming User Profile when synchronization occurs.

Running the Acoustic and Language Model Optimizer over the network can result in a large

amount of data being transferred between the server and the workstation running the optimizer.

For more information, see Running the Acoustic and Language Model Optimizer for Roaming

User Profiles.

If you are using Dragon NaturallySpeaking , see Using multiple acoustic models with a User Pro-

file for information on using the Acoustic and Language Model Optimizer with a User Profile that

has two acoustic models.

Notes:

n You must have Windows Administrator privileges on the computer where you are running the

Scheduler for the Acoustic and Language Model Optimizer.

n Do not enable the Roaming feature on the administrator computer where you plan to run the

Acoustic and Language Model Optimizer.

n When the Roaming feature is enabled on a computer where someone dictates, that computer is

blocked from locally running the Acoustic and Language Model Optimizer or the Acoustic

and Language Model Optimizer Scheduler on the local copy of the Roaming User Profiles.
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For more information on installing or upgrading
Dragon
For more information on installing or upgrading Dragon NaturallySpeaking on the computers in

your network, see:

n Upgrading Roaming User Profiles: Overview for information how to upgrade Roaming User

Profiles from Dragon NaturallySpeaking 10.x or 11.x to Dragon NaturallySpeaking .

n The Installation Guide that came with your copy of Dragon for information on installing Dragon

on a single computer

n The Dragon Administrator Guide for information on how to use MSI to install or upgrade

Dragon on multiple computers.

222



Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Storage space required for the Master
and Local Roaming User Profiles

Adequate storage space must be available for User Profiles that store information about each par-

ticular user’s speech patterns.

You need to plan for storage space on:

n Each computer where you plan to have users dictating with a Roaming User Profile.

n The network accessible central computer or computers where Master Roaming User Profiles are

stored.

These are guidelines only and not definitive specifications—actual size will vary from site to site.

For each Master Roaming User Profile on the
network
For each Master Roaming User Profile (User Profiles stored on the central network location), you

should plan on:

n 55 MB for each set of Roaming User Profiles, this includes:
l 18 MB for each additional vocabulary you add for this user profile

l 35 MB for each additional dictation source you add for this user profile

n 1000 MB for acoustic optimizer data associated with each dictation source of each User Profile

For each computer where Dragon is installed
You must install 1 copy of Dragon NaturallySpeaking on each computer where your users will be

dictating with the Roaming feature. Multiple users can use a single Dragon installation.

Each installation of Dragon NaturallySpeaking takes a minimum of 1.8 GB of free hard disk space

for a custom Installation where you install only the program files and 1 set of User Profiles. Instal-

lations can range from 800 MB (US English Home Edition) to 5 GB (Dragon NaturallySpeaking ),

depending on which languages and vocabularies you install. See Dragon system requirements for

information on disk space requirements for Dragon NaturallySpeaking .

For each Local Roaming User Profile on the client
PC
On each installation of Dragon where your users plan to dictate using the Roaming feature, each

Local Roaming User Profile (the User Profiles stored on the local computer running Dragon Nat-

urallySpeaking , require the following:

n 55 MB for each set of Roaming User Profiles. This includes:
l 18 MB for each additional vocabulary you add for this user profile

l 35 MB for each additional dictation source you add for this user profile
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n 10 MB per topic for language model optimizer data in the topic container data

n 240 MB for acoustic optimizer data associated with each dictation source of each User Profile

How much acoustic optimizer data is retained locally is controlled by settings on the Data tab of

the Options dialog box:

1. To set the number of minutes of audio to retain locally, click the Archive size... button and

position the slider.

2. To turn off retaining this data locally, check the Conserve disk space required by user pro-

file (for portability) option.

A non-Roaming User Profile requires approximately three times as much disk space as a local

Roaming User Profile. Dragon periodically creates a backup copy of a non-Roaming User Profile

and stores the copy on the local computer. On the other hand, a Roaming User Profile is stored in

a network storage location and Dragon does not create a backup copy of a Roaming User Profile.

An administrator should create backup copies of all Roaming User Profiles on a regular basis.
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How Dragon Synchronizes Master and
Local Roaming User Profiles

When an end-user that uses a Roaming User Profile exits Dragon, switches User Profiles, closes a

User Profile, or saves a User Profile, Dragon saves changes to the Local Roaming User Profile and

then synchronizes these changes with the Master Roaming User Profiles on the network.

In a networked situation, this occurs at the time one of these operations is performed.

When an end-user dictates using a computer not currently connected to a network, all changes are

saved to the Local Roaming User Profile; synchronization occurs when the end-user reattaches the

computer to the network containing the Master Roaming User Profile and opens that User Profile

again.

For more information on what options effect what data gets synchronized between the Master and

Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

Note: During synchronization, changes to the Master Roaming User Profile overwrite any changes

made to a Local Roaming User Profile that an end-user has been using for dictating and correcting

dictation while not on the network.

What happens during synchronization
The following changes take place when Local and Master Roaming User Profiles are synchronized:

n Combines words added to the Local Roaming User Profile during a dictation session with the

Master Roaming User Profile vocabulary,

n Removes words deleted from the Local Roaming User Profile from the Master Roaming User

Profile vocabulary.

n Copies acoustic data (from files with a .DRA or .NWV extension) from the Local Roaming User

Profile and adds them to the Master Roaming User Profile where the data become available to

the Acoustic Optimizer (Note that .DRA files saved voluntarily by the end-user along with a

document do not get added to the Master Roaming User Profile. The.DRA files created

automatically by Dragon for use by the optimizer are the only ones that get added to the Master

Roaming User Profile). For more information on running the Acoustic Optimizer, see Running

the Acoustic and Language Model Optimizer for Roaming User Profiles.

n Copies any custom commands created or modified locally (using theMyCommands editor) to

the Master Roaming User Profile.

n Saves any local end-user options that you changed on the Options or Formatting dialog box to

the Master Roaming User Profile, except the options listed below.

What changes don't get synchronized

The following options are not synchronized with the Master Roaming User Profile; they remain

exclusively on the local computer with the Local Roaming User Profile:

Locally set options on the Options dialog:

n On the Data tab:
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l Conserve disk space required by user profile option

l Create usability log option in the Advanced dialog box

l Incremental adaptation in general training option

n On theMiscellaneous tab:

l Voice enable menus and dialog controls option

l Launch Dragon in QuickStart mode when Windows starts option

n On other tabs of Options dialog box:

l All the options on the Playback/Text-to-speech tab

l All the options on the Hot keys tab

n Settings in the Auto-Formatting dialog box:

l The UK and Canadian postcodes option

What files are synchronized
The following table explains how and when individual files are copied or updated to the master

Roaming User Profile or to the local cache when the Master and Local Roaming User Profiles are

synchronized.

For more information on what options effect what data gets synchronized between the Master and

Local Roaming User Profile, see Setting/selecting Roaming User Profile options.

These options can effect how much data is transferred across your network when the Master and

Local Roaming User Profiles are synchronized. For more information, see Estimating Network traf-

fic caused by synchronization.

File name or type
Copied or updated with the master
Roaming User Profile

Copied or updated to local
cache

Acoustic files:*.usr
and *.sig

At save time if the Always copy
acoustic information to network
option in the Administrative set-
tings is on. See Acoustic files for
more details.

Copied if version number on
server is different

Vocabulary files:*.voc Copied only after the acoustic files
for the User Profile have been mod-
ified with information from Learn
from specific documents, Learn
from sent e-mails, Import a list
of words or phrases, and similar
procedures.

Copied if version number on
server is different

Acoustic archive
created for each dic-

Copied to session folder if it exists;
once master voice_container limit

Never
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File name or type
Copied or updated with the master
Roaming User Profile

Copied or updated to local
cache

tation session: acar-
chive.nwv (encryp-
tion disabled),
acarchive.enwv
(encryption enabled)

is reached, nothing more is copied.
The local copy is deleted and a
zero-length file is created.

Audio.ini Copied to master after running the
Check Microphone wizard or at
User Profile close if not copied suc-
cessfully after running the
Check Microphone wizard

Copied if version number on
server is different; also copied
right before Check Micro-
phone wizard is run

Backups Never - Dragon does not backup
local Roaming User Profiles on the
end-user workstations and does not
backup the Master Roaming User
Profiles on the location where they
are stored on your network.

See Backups for more details.

Never

DRA files, aco.ini;
drafiles.ini

Copied to session folder if the
master voice_container has space.
Files are deleted after being copied;
aco.ini and drafiles.ini are recreated
at zero-length

Never

Custom commands
created on client
PC:Mycmds.dat

Copied when User Profiles are
saved, or a User Profile is closed
and saved.

Copied at User Profile open if
version number on server is
different

Options.ini, sop-
tions.ini, itnop-
tions.ini

Copied at User Profile close,
options dialog close when the times-
tamp on the local file has changed.

Copied on User Profile open,
options dialog open if version
number is different on the
server

History of changes to
the vocabulary: voc-
delta.voc

Merged to master copy on

User Profile save and open.

When vocabularies are copied

up, vocdelta.voc is reset to

zero in the master copy for

that topic.

Copied to local cache on User
Profile open andmerged into
the voc if version number is
different on the server

nsuser.ini, local.ini,
nssystem.ini, nat-
speak.ini

Never (machine dependent) Never

Acoustic files

If the setting is off (the default), after the acoustic optimizer runs on the master Roaming User

Profile, the server incorporates the changes

In Dragon NaturallySpeaking , an end-user can set the Save Acoustic information option to con-

trol if Dragon saves the .usr and .sig files on each computer they dictate on. See "Controlling
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updates to the acoustic components of a User Profile" in Dragon What's New for administrators

for more information.

Backups

It is the responsibility of your local administrator to backup the Master Roaming User Profiles.

However, Dragon does automatically back up local non-Roaming User Profiles on the end-user

workstations as specified in the Miscellaneous tab of the Administrative Settings dialog box.
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Estimating Network traffic caused by
synchronization

The following table explains how and when individual files are copied or updated to the master

Roaming User Profile or to the local cache when the Master and Local Roaming User Profiles are

synchronized and how much data is transferred in the process.

In addition, this table which option controls whether the data is transferred. For more information

on what options effect what data gets synchronized between the Master and Local Roaming User

Profile, see Setting/selecting Roaming User Profile options.

The estimates of the data transferred across the network is for a single Roaming User Profile.

Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

Acoustic files: *.user

and *.sig

User Action: Dic-

tation, Audio Setup

Transfer time: When

the User Profile is

saved

35 MB

<---->

Transfer

time: Copied

if server ver-

sion is dif-

ferent from

client version

n Always copy acoustic
information to net-
work

n Save Acoustic infor-
mation

Vocabulary files:

*.voc

User Action: Dic-

tation, Learn from spe-

cific documents, Learn

from sent e-mails,

Vocabulary Optimizer.

Transfer time: Copied

only after the vocab-

ulary files for the end-

user have been mod-

ified with information

from Learn from spe-

cific documents,

Learn from sent e-

mails, and the Vocab-

ulary Optimizer. Cop-

ied only after saving or

closing a User Profile.

18 MB

<---->

Transfer

time: Copied

if server ver-

sion is dif-

ferent from

client version

Access net-

work at user

profile

open/close

only
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Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

Acoustic archive

created for each dic-

tation session: acar-

chive.nwv,

acarchive.enwv

User Action: Dic-

tation, Correction

Transfer time: Copied

to session folder if it

exists. Once master

voice_container limit is

reached, nothing more

is copied. Copy only

happens after saving or

closing a User Profile.

240 MB

<------

Transfer

time: Never.

The local

copy is

deleted and a

zero-length

file is created

after files are

copied to the

server.

Access net-

work at user

profile

open/close

only

DRA files created dur-

ing dictation: DRA

files, aco.ini, drafiles.ini

User Action: Dic-

tation, Correction

Transfer time: Copied

to session folder if the

master voice_container

has space.

1.3 MB/min-

ute

<------

Transfer

time: Never.

Files are

deleted after

being copied;

aco.ini and dra-

files.ini are

recreated at

zero-length

Conserve

archive size

on network

Custom commands

created on client PC:

Mycmds.dat

User Action: Changes

to some Options on the

local PC

Transfer time: Copied

when a User Profile is

closed or saved.

66 K

<---->

Transfer

time: Copied

when a User

Profile opens

on the local

PC and the

version

number on

the server is

different from

the version

number on

the server

.INI file changes on

client PC: options.ini,

< 1 k

<---->

Transfer

time: Copied
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Files copied to the Master
Roaming User Profile

Transfer Direction
& Data Amount

Files copied to the
Local Roaming User

Profile

Administrative
Setting to enable
for Transfer

soptions.ini, itnop-

tions.ini

User Action: Changes

to some Options on the

local PC

Transfer time: Copied

at User Profile close,

Options dialog close

when the timestamp on

the local file has

changed

to local cache

on when a

User Profile

opens and

merged into

the voc if the

version

number is dif-

ferent on the

server

History of changes to

the vocabulary: voc-

delta.voc

User Action: Adding

words, changing word

properties

Transfer time:

Merged to master copy

when a User Profile is

saved or opened. When

vocabularies are copied,

vocdelta.voc is reset to

zero in the master copy

for that vocabulary

500 KB

max. (12

bytes/word)

<---->

Transfer

time: Copied

when a User

Profile opens

or the

Options

dialog opens

if the server

version is dif-

ferent from

the client ver-

sion

Merge con-

tents of voc-

delta.voc

into network

user profile

when file is

full

Log file: Dragon.log

User Action: Any use

of Dragon

Transfer time: Copied

if the Administrative

option is set.

< 1 MB

<------

Transfer

time: Never

Copy Dragon

log to net-

work
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Enabling the Roaming feature on each
computer where an end-user will
dictate

After you have set up the network location for the Master Roaming User Profiles and installed or

upgrading Dragon NaturallySpeaking on the computers in your network, you must enable the

Roaming feature on each computer where the end-user will dictate using a Roaming User Profile.

Step 1: Start Dragon NaturallySpeaking
You must start Dragon NaturallySpeaking to enable the Roaming feature.

Step 2: If already Dragon is running, select
Administrative Settings
If Dragon is already running, on the DragonBar, select Tools > Administrative Settings and

click Proceed. This action closes all open User Profiles and displays the Administrative Settings

dialog box.

n If the Open User Profile or Profile Creation wizard dialog box appears when you start

Dragon, click Cancel.

n If a User Profile opens automatically (Dragon does this if there is only one User Profile

available), select Profile > Close User Profile on the DragonBar.

Step 3: Turn on the Roaming feature
After closing any open User Profiles:

1. If Dragon is running, from the DragonBar menu, select Tools > Administrative Settings.

This action displays the Administrative Settings dialog box.

Note: You do not have to be running Dragon to act as an administrator of the product.

Instead of opening the Administrative Settings dialog box from the DragonBar

menus, you can open the dialog box from the command line by selecting Start > Run,

then entering the following command in the Open text box (include a space between

natspeak.exe and the /SetAdministrativeOptions option that follows it):
“C:\Program
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Files\N-
uance\Na-

turallySpeaking12\Program\natspeak.exe”/SetAdministrativeOptions

2. On the Roaming tab, check Enable.

3. Click Apply to save the changes and keep the dialog box open.

Note:With the Roaming feature enabled, the Open User Profile dialog box later displays only

User Profiles in the Roaming User Profile storage locations. To let the end-users open both local

(non-roaming) and Roaming User Profiles, check the Allow non-roaming user profiles to be

opened option in the Administrative Settings dialog box. Clearing this option prevents end-

users from dictating with a non-roaming (local) User Profile by mistake, but you should check it

now if you want to ensure you can open existing local User Profiles so that you can convert them

to Roaming User Profiles.

Step 4: Set the location of Master Roaming User
Profiles
On each computer where you plan to have end-users dictating as a Roaming User Profiles, you

must tell that installation of Dragon where the Master Roaming User Profiles are located.

After selecting Enable on the Roaming tab:

1. Click the Add button. The Roaming User Network Location dialog box displays. You use the

Roaming User Network Location dialog box to define the network location of the master

Roaming User Profiles. The location you pick must be accessible to all computers on the net-

work that you want available for dictation with Dragon.

2. Set the Display Name to the way the name of the directory should display in other dialog

boxes. The display name later appears in the Roaming tab of the Administrative Settings

dialog and the Location of user profile text box of both the Open User Profile and theMan-

age User Profiles dialog boxes.

3. Set the Network Location. See the types of locations that the Roaming feature supports in

Creating a network storage location for Master Roaming User Profiles.

4. If you are using a web server to store Master Roaming User Profiles, click the HTTP Settings

and SSL Settings (if you are using HTTPS) button to set information about your HTTP and

HTTPS connection and proceed with HTTP Settings and SSL Settings for further information.

After entering the HTTP and SSL Settings, use the Test Connection button to make sure

your settings are correct. For help troubleshooting a problem with the connection, see Testing

and troubleshooting an HTTP connection .

5. Click OK in the Roaming User Network Location dialog box.

For more information on setting the location of the master Roaming User Profiles, see Roaming

User Network Location.

Note: You cannot create a non-Roaming User Profile on an HTTP connection. You

can only create Roaming User Profiles on an HTTP connection when the Roaming

feature is enabled.
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Step 5: Set location of Local Roaming User Profiles
When an end-user opens a Master Roaming User Profile, Dragon transfers a copy of that User Pro-

file to the local computer. That local copy is called the Local Roaming User Profile. This is the

location on the computer where changes made during a dictation session, such as corrections or

new acoustic data, are stored before they are synchronized with the master Roaming User Profile.

You can set this location, called <Roaming Local>, from the Administrative Settings dialog box.

Nuance recommends leaving this option at the default setting.

Note: the location of <Roaming Local> is per-PC and cannot be changed to an end-user-specific

locaftion.

<Roaming Local>

To accept the default <Roaming Local> location (which Nuance recommends), click OK on

the Administrative Settings dialog box. You will be prompted to create the default directory if it

does not already exist. When you see the following message, click Yes.

The default location of <Roaming Local> is:

n Windows XP: C:\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking12\RoamingUsers\<display name>\

n Windows Vista and Windows 7:
C:\ProgramData\Nuance\NaturallySpeaking12\RoamingUsers\<display name>\

See Dragon file structure for information about the default location of the RoamingUsers directory

for Dragon NaturallySpeaking on other Windows operating systems.

The <display name> is the name you defined for the Master Roaming User Profile location. You

can have multiple network storage locations for your Master Roaming User Profiles and each has

its own corresponding directory for Local Roaming User Profiles.

Changing the default location for <Roaming Local>
1. Use the Browse for Folder dialog box to open a location where you want to store the local

Roaming User Profile. This is the location on the computer where changes made during a dic-

tation session, such as corrections or new acoustic data are stored before they are synchronized

with the master Roaming User Profile.

2. If the directory does not currently exist, click Make New Folder and type a name for the new

folder. The new directory can have any name, but calling it something meaningful, such as Local

Roaming User Profiles, will make the folder easier to find in the future.

3. Click OK.
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Step 6: Set Roaming feature options
The Administrative Settings dialog box also contains several options that affect how the Roam-

ing feature works. You select the options that indicate how you want a Roaming User Profile to

function at each Roaming User Profile location. For a list of the options to choose from, refer to

Selecting Roaming User Profile options. 

Notes:
n Once you set up an installation of Dragon to use the Roaming feature, end-users on that

computer can only open Roaming User Profiles; they cannot open any locally created User

Profiles unless you choose the "Allow non-roaming user profiles to be opened" option. For

a list of the options to choose from, refer to Selecting Roaming User Profile options. 

n If an end-user is dictating with a Roaming User Profile, the Acoustic and Language Model

Optimizer Scheduler is disabled on the local end-user's computer. You must run the

Acoustic and Language Model Optimizer on the computer where your Master Roaming

User Profiles are located or on an administrator’s workstation. For more information, see

Running the Acoustic and Language Model Optimizer with a Roaming User Profile.
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Administrative Settings: Roaming tab
You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want end-users to dictate

with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box

displays large numbers of User Profiles quickly. They can also be organized into subfolders. See

"Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

Enable

Select Enable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name and the Address underNetwork Location. The Roaming feature sup-

ports the following types of locations:
n Mapped Drive—the format is: <drive letter>:\<folder name>. For example,

y:\roaming.

n UNC Path—the format is: \\servername\sharename\path\filename.

n HTTP (http:)—the format is: http://myserver.com/<name_of_virtualdirectory>

where <name_of_virtualdirectory> is the name of the virtual directory set up by an

administrator during setup of the IIS or Apache web site. For HTTP locations, click

the HTTP Settings button to set information specific to your HTTP connection.

You can also test your connection to the HTTP server from the HTTP Settings

dialog box.

n HTTP with SSL (https:)—the format is: https://myserver.com/<name_of_

virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual

directory set up by an administrator during setup of the IIS or Apache web site. For

HTTP with SSL locations, click the SSL Settings button to set information specific

to your HTTP with SSL connection. You can also test your connection to the

HTTP with SSL server from the SSL Settings dialog box.

Local directory (for cache)

When an end-user opens a Master Roaming User Profile, Dragon transfers a copy of that User Pro-

file to the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:
Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\RoamingUsers\<display name>\<username>
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See Dragon file structure for information about the default location of the RoamingUsers directory

for Dragon NaturallySpeaking on other Windows operating systems.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can

have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate

directory for each User Profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User

options. You can also configure the Open User Profiles dialog box to display the Classic Open

User Profiles dialog if desired. See Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:
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n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

not all your User Profiles are listed in the Open User Profile dialog box, or after creating a

Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not

display all the vocabularies and acoustic models for your User Profiles, make sure that you:
l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Administrative Settings: Roaming
User Network Location

You use the Roaming User Network Location dialog box to define the network location of the

master Roaming User Profiles.

The location you pick must be accessible to all computers where end-users will dictate using a

Roaming User Profile.

Display Name
Sets the directory name displayed in the following locations:

n The Roaming tab of the Administrative Settings dialog box

n The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only User

Profiles in the Roaming User Profile locations. To let the end-users open both local (non-

roaming) and Roaming User Profiles, select the Allow non-roaming user profiles to be

opened option on the Administrative Settings dialog box. Clearing this option prevents end-

users from dictating with a non-roaming (local) User Profile by accident. For more information,

see Enabling the Roaming feature on each computer where an end-user will dictate.

n The Location of user profile drop-down list in theManage User Profiles dialog box.

Network Location—Address
On each computer where you plan to have users dictating as a Roaming User Profiles, you must

tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to

locate a User Profile. The UNC is a way to identify a shared file on a computer or network with-

out having to know the storage device it is on. The UNC path format is:

\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. UnderNetwork Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This dis-

plays the Browse for Folder dialog box. You can also create a new directory on the mapped

drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.
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Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure

Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your

master Roaming User Profiles are located.

2. Click
n HTTP Settings...to display the HTTP Settings dialog box, where you can set

information specific to your HTTP connection like Authentication, Firewall, and

Proxy Server information. You can also test your connection to the HTTP server

from this dialog box. For more information, see HTTP Settings.

n SSL Settings...to display the SSL Settings dialog box, where you can set

information specific to your HTTPS (SSL) connection. You can also test your

connection to the HTTPS server from this dialog box. For more information, see

SSL Settings.

Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You

can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the

Roaming feature is enabled.
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Setting up HTTP Connection: HTTP
Settings

You use the HTTP Settings dialog box to define and configure the connection to your

web (HTTP) server. Enter information about your connection in the following sections and text

boxes of the dialog box:

Authentication
Passwords

Defines how an end-user that uses a Roaming User Profile enters the server username and pass-

word. This username/password is to the server, not a local login:

n Prompt for User and Password: Select if local end-users will be prompted for a

username/password when they connect to the HTTP server.

n User/password: Sets the default username/password needed to connect to the HTTP server.

Be sure to put the domain name followed by a backslash in front of the end-user login name; for

example, Nuance\JWyman.

Authentication Type

Sets the type of authentication used on the HTTP server you specified as the Address in the

Roaming User Network Location dialog box. Select the type that indicates how your server is

configured:

n Basic: Choose if the server is configured for Basic authentication, where the username and

password are passed over the network as clear text

n Digest: Choose if the server is configured for Digest authentication, where the passwords are

never transmitted across the internet in unencrypted form. Digest is not supported for IIS.

Note: Digest authentication through a proxy server with Internet Information Server (IIS) 6.0 is

not supported.

Note: For security reasons, be sure that anonymous logins are disabled on the HTTP or

HTTPS server.

Connection
Follow Redirects

If you are storing the Master Roaming User Profiles on a server that redirects incoming con-

nections to another location, you can define how Dragon handles these redirects:

n Never: redirects are never followed, but ignored.

n Always: redirects are always followed.

n Same Scheme Only: only redirects using the same scheme as the client request are permitted.

Keep Connection Alive

This setting tells the client and server to keep the connection alive after the current session ends.
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Firewall and Proxy Servers
Use Proxy Server

Select Use Proxy Server if you are connecting to your HTTP server through a proxy server.

Type

Select the type of firewall used on the HTTP server from the drop-down list:

n HTTP Proxy: Select for a proxy server that specializes in HTML (web page) transactions.

n Tunnel: Select if you are connecting to the server with tunneling software.

n SOCKS4: Select for a SOCKS4 protocol that relays TCP sessions at a firewall host to allow

application end-users transparent access across the firewall. SOCKS4 doesn't support

authentication, UDP proxy. SOCKS4 clients require full Domain Name Service (DNS).

n SOCKS5: Select for a SOCKS5 protocol that relays TCP sessions at a firewall host to allow
application end-users transparent access across the firewall. SOCKS5 supports multiple
authentication methods. SOCKS5 clients use the SOCKS5 server to perform the DNS
lookup.

Server

Enter the server name provided by your network administrator.

Port

Enter the port number needed to connect to the proxy server or firewall.

User

Enter any username needed to log in to the proxy server or firewall.

Password

Enter any password needed to log in to the proxy server or firewall.

Firewall Data or Proxy Authorization

Enter any special authentication string provided by your network administrator.

Timeouts
Lock

Set to the number of seconds the server should wait before breaking the lock on any open Master

Roaming User Profiles. Setting the lock to 0 uses the default setting from the server. Specifying

another time overrides the server default. The administrator is responsible for breaking this type

of lock.

A network locks prevent anyone from opening a Master Roaming User Profile that someone else

has already opened. While this process does not take a long time, network problems can cause a

lock to become “stuck” and not release when the opening process is completed. When this
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happens, the next time you try to open that User Profile, you see a message informing you of the

lock.

The Administrator has to break the lock.

Connection

Number of seconds before Dragon should close the connection to the server either when the con-

nection is idle or after the connection has been open for that duration.

Type

Sets when the connection timeout in the previous text box applies:

n Inactivity: Closes the connection after the Roaming User Profile is inactive for the specified

time.

n Absolute: Closes the connection after the specified time independent of any Roaming User

Profile network activity. Use this option with caution, as it could close the connection during

synchronization.

Test Connection
Once you have filled in the information, you can click the Test Connection button to test the

connection to the HTTP server.

Restore Defaults
Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.
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Setting up secure web server
connection: SSL Settings

You use the SSL Settings dialog box to define and configure the connection to your secure

web (HTTPS) server. Enter information about your connection in the following sections and text

boxes of the dialog box:

Certificate Store
Here you indicate the type of certificate that provides server identity, certificate, and public key

information to clients that try to establish a connection:

Certificate Store Type

Select the certificate store type used for the client certificate on the local computer:

n User (default): For Windows, choose if the certificate store is a certificate store owned by the

current user. For Java, choose if the certificate store is the name of a JKS (Java Key Store) file.

If the provider is OpenSSL, choose if the certificate store is a file that contains the PEM

encoded certificate and private key.

n Machine: Choose if the certificate store is a machine store (not available in Java or when

provider is OpenSSL).

n PFX file: Choose if the certificate store is the name of a Private Key Server or PFX (PKCS12)

file containing certificates. If the provider is OpenSSL, the file may contain only one certificate

and private key.

n PFX Blob: Choose if the certificate store is a string (binary or base64 encoded) representing a

certificate store in PFX (PKCS12) format.

n PEM Key: Choose if the certificate store is a string or file name that contains a Privacy

Enhanced Mail (PEM) encoded certificate and private key. This store type is currently not

supported in Java.

Certificate Store

The name of the certificate store for the client certificate on the local computer:

The storage location is called the certificate store. A certificate store will often have numerous cer-

tificates, possibly issued from a number of a different certification authorities:

n MY: A certificate store holding personal certificates with their associated private keys.

n CA: A certificate store holding Certifying Authority (CA) certificates.

n ROOT: A certificate store holding ROOT certificates.

n SPC: A certificate store holding Software Publisher Certificate (SPC) certificates.

n Other: Any other Certificate Store not listed above.

Notes:

n If you select PFX file for the Certificate Store Type, for the Certificate Store select Other

and enter the name of the file in the associated text box below it.
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n If you select PFX Blob for the Certificate Store Type, for the Certificate Store select Other

and enter the binary contents of a PFX file (for example, the PKCS12) in the associated text

box below it.

n If you are using OpenSSL, for the Certificate Store select Other and enter the name of the file

containing a certificate and a private key in the associated text box.

Certificate Store Password

The password for the Certificate Store on the local computer if one is required.

Open SSL
Select Using OpenSSL if the HTTPS server uses OpenSSL as a Certificate Authority. OpenSSL

is a free non-commercial implementation of SSL.

When you select Using OpenSSL, you must provide:

n Cipher List: A string that controls the ciphers to be used by SSL. The cipher list consists of

one or more cipher strings separated by colons.

n Certificate Authority File: Name of the file containing the list of certificate authorities (CAs)

trusted by your application. The file set by this property should contain a list of CA certificates

in PEM format.

n CA Directory: Path to a directory containing CA certificates. The path set by this property

should point to a directory containing CA certificates in PEM format.

General
Use this section to enable/disable the supported security protocols on the HTTPS server.

n TLS1: Version 1 of the Transport Layer Security (TLS) protocol.

n SSL3: Version 3 of the Secure Sockets Layer (SSL) protocol.

n SSL2: Version 2 of the Secure Sockets Layer (SSL) protocol.

n PCT1: Version 1 of the Private Communications Transport (PCT) protocol.

Notes:

n Although a number of sites still support SSL2, Nuance recommends that you disable it because

of potential security vulnerabilities.

n If you select Using OpenSSL, this functionality is provided by the Cipher List.

Test Connection
Once you have filled in the information, you can click the Test Connection button to test the

connection to the HTTPS (SSL) server.

Restore Defaults
Restores the default settings.

After you click OK, you return to the Administrative Settings dialog box.
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Testing and troubleshooting an HTTP
connection

Once you have supplied all the necessary information needed to connect to your HTTP server,

press the Test Connection button. The Test Connection button tests the connection to your

HTTP server based on the information you supplied in the Roaming User Network Location and

HTTP Settings dialog boxes.

Troubleshooting test connections
The table below lists the possible messages you might receive after pressing the Test Con-

nection button.

Message Solution

Connection test successful! n None—test successful.

Could not connect to the

network location.

n Check spelling and syntax of the HTTP address in the HTTP Settings
dialog.

n Check your local network for problems.

Could not copy a file to the

network location

n Check create andwrite privileges on the server
n WebDav Server not installed or active. For more information, see
Configuring Internet Information Services andWebDAV for HTTP
Roaming.

Could not create a directory

on the network location

n Check the create directory privileges on the server for the Master
Roaming directory.

n Check the privileges for creating sub-directories under the Master
Roaming directory.

Could not delete a file from

the network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not delete a directory

from the network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not copy files into a

directory created on the net-

work location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges.

n Check for authentication time-out on your server.
n Check your local network for problems.

Could not list the contents

of a directory created on the

network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Contents of newly created

directory TempDir were

incorrect

n Caused by an incomplete directory listing. Try again. If the problem
persists, check the condition of your network.
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Message Solution

Could not copy a file from

the network location

n Check permissions on the Local Master Roaming directory.
n Check that the Local Master Roaming directory exists.
n MIME types not set to *.* (the file is .txt).

Could not get the size of a

newly created directory on

the network location.

n Apache: Make sure DavDepthInfinity directive is set to "on" for
Master Roaming directory.

Could not rename a file on

the network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not rename a direc-

tory on the network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.

Could not copy a directory

within the network location

n Check permissions on the Master Roaming directory. The end-user
must have read, write, andmodify privileges

n Check that privileges are inherited in the sub-directories.
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Setting and selecting Roaming User
Profile options

The Administrative Settings dialog box also contains several options that you can choose from

to indicate how you want a Roaming User Profile to function at each Roaming User Profile loca-

tion.

These options can effect how much data is transferred across your network when the Master and

Local Roaming User Profiles are synchronized. For more information, see Estimating Network traf-

fic caused by synchronization and How Dragon Synchronizes Master and Local Roaming User Pro-

files.

Roaming User Profile options on the Administrative
Settings dialog box
Display Classic Open User Profiles dialog

Enable this option to display the Classic Open User Profiles dialog box. The setting configures

the Open User Profiles dialog box to display only folders that contain actual Dragon User Pro-

files in the Location of User Profiles box.

Note:

For faster performance at large sites with Roaming User Profile directories, Nuance recommends

using the default appearance for the Open User Profiles dialog box. Displaying the Classic Open

User Profiles dialog box takes longer because Dragon first verifies that directories contain valid

Dragon User Profiles. Directory structures do not display with the Classic setting.

Allow non-Roaming User Profiles to be opened

Select this box to permit the end-user to open non-Roaming (local) User Profiles. Nuance rec-

ommends clearing this option to prevent anyone from dictating with a non-Roaming (local) User

Profile by accident.

Merge contents of vocdelta.voc into network user profile when file is
full

Select this box to copy the contents of the local vocdelta.voc file to the master Roaming User

Profile without running the Acoustic and Language Model Optimizer.

If you do not set this option and if you have not run the Acoustic and Language Model Optimizer

for a long time, the end-user will see a message when the vocdelta.voc file becomes full. If you do

not run the Acoustic and Language Model Optimizer regularly, you should set this option to pre-

vent end-users from seeing this message.

Vocdelta.voc is the file used to store vocabulary changes in the Master Roaming User Profile. It is

updated whenever a Local Roaming User Profile is closed, and it is used to update the Local Roam-

ing User Profile with vocabulary changes every time that a User Profile is opened. When you run

the Acoustic and Language Model Optimizer on the Master Roaming User Profile, Dragon
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incorporates the contents of vocdelta.voc into the vocabulary (.voc) file and clears the content of

vocdelta.voc.

If you check this setting, Dragon monitors the size of the vocdelta.voc file. When the voc-

delta.voc file reaches 90% of it's maximum size (500 KB), Dragon incorporates the contents of

the vocdelta.voc file into the vocabulary (.voc) file and clears vocdelta.voc.

This operation occurs when the end-user opens the local Roaming User Profile. This operation

can take a long time because the vocabulary file must be transferred over the network twice. Sub-

sequently, opening the local Roaming User Profile on another workstation can also take a long

time because the entire vocabulary file must be copied from the master to the local Roaming User

Profile.

Selecting this option will transfer at maximum 500 KB, or 12 bytes/word across the network at

synchronization if the Roaming and Local copies are different.

Access network at user profile open/close only 

Select this box to synchronize changes made to the local Roaming User Profile to the Master

Roaming User Profile only when a local Roaming User Profile opens or closes. If this box is not

selected, then these local changes are immediately transferred to the Master Roaming User Profile.

The only changes affected by this setting are the changes an end-user makes locally from the

Options dialog box, therefore this setting is highly unlikely to have a perceptible impact on Drag-

on’s performance.

At synchronization, setting this option will copy approximately

n 18 MB of vocabulary files (*.voc).

n 240 MB of acoustic archive files create for each dictation session (acarchive.nwv and

acarchive.enwv).

Note: These files are only copied from the Local to the Roaming User Profile; they are never

copied from the Roaming User Profile to the local User Profile.

These files synchronize across the network when:

n Vocabulary files - when the local end-user modifies the vocabulary with information from the

Learn from specific documents, Learn from sent e-mails, or Vocabulary Optimizer dialogs

or when the Roaming and Local copies are different.

n Acoustic archive files - these files will be copied to session folder if it exists. Once the master

voice_container limit is reached, nothing more is copied.

Ask before breaking locks on network user profiles (recommended
for UNC and mapped drives)

Select this box to keep the option of maintaining or breaking a network lock when opening a

Roaming User Profile. Normally, network locks prevent anyone from opening a Roaming User Pro-

file at the same time someone else is opening that User Profile. While this process does not take a

long time, network problems can cause a lock to become "stuck" and not release when the open-

ing process is completed. When this happens, the next time anyone tries to open that User Profile,

Dragon displays a message stating that the User Profile is locked and giving them the option of

overriding it. If you do not want this message displaying and always want to break a network lock
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in this situation, you can clear this option to prevent the message from appearing. Because the

presence of a lock can indicate a problem that needs to be addressed, Nuance recommends that

you enable this option.

Notes:

n This option is valid for users connecting to the Master Roaming User Profile location using a

mapped drive or UNC drive, but is not supported for users connecting over HTTP.

n Be careful when in breaking a locked Roaming User Profile. For example, if you break a lock

when another end-user is writing to the Master Roaming User Profile, breaking the lock may

corrupt the Master Roaming User Profiles.

n If an end-user opens a Roaming User Profile while the Acoustic and Language Model Optimizer

is running on the Master Roaming User Profile, the end-user will see a message but can

continue.

Set audio levels on each machine (recommended)

Select this box to run the Check your microphone option from the Accuracy Center window

before your first session with a Roaming User Profile. This includes the Volume Check and the

microphone Quality Check. Check this option if your users are dictating on different computers

or on a single computer, like a laptop, in many different locations. When an end-user changes com-

puters or locations, the audio setup data can vary depending on differences in the microphone and

sound card, as well as differences in ambient sound levels of each Roaming User Profile location.

In situations where Dragon detects a significant difference between operating systems, sound

cards, microphones, or other hardware, the program will prompt you to run Check your micro-

phone even if you do not have this option selected. 

Save acoustic information

An end-user selects the Save acoustic information option to make sure that their acoustic infor-

mation is saved along with their local User Profile. By saving the acoustic information, the end-

user ensures that any corrections they make will be available after they close and re-open the User

Profile. This option also makes sure that these corrections will be synchronized between the

Local and Master Roaming User Profile if the end-user also enables the Always copy acoustic

information to network option.

This option is turned on by default

Copy Dragon Log to Network

Select this box to copy the Dragon.log file from the local workstation to the master Roaming User

Profile location whenever the program synchronizes the local and master Roaming User Profile.

Dragon.log contains information that can help to diagnose problems that your users might

encounter using Dragon.

Note: The Dragon.log file will not be copied once the maximum size is reached in the Disk space

reserved for network archive option.

Selecting this option can increase how long it takes to close a Roaming User Profile. It can also

limit the usefulness of the Acoustic and Language Model Optimizer because it reduces the
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amount of acoustic data that can be stored in the network archive. Nuance recommends that you

not set this option unless requested by Nuance Technical Support.

Selecting this option will transfer 1 MB or less of data across the network at synchronization.

These files are only copied from the Local Roaming User Profile to the Master Roaming User Pro-

file; they are never copied from the Master Roaming User Profile to the Local Roaming User Pro-

file.

Always copy acoustic information to network

Select this box to copy the User Profile’s acoustic model (.usr and .sig files) to the Master Roam-

ing User Profile location.

If you chose not to copy the User Profile’s acoustic information to the network, updates to the

acoustic model that you make on one computer (for example by correcting and training words)

will not be available on other computers used by that particular Roaming User Profile until you

run the Acoustic and Language Model Optimizer on the Master Roaming User Profile loca-

tion and the Local and Master Roaming User Profiles synchronize. Therefore, if you do not run

the Acoustic and Language Model Optimizer on the Master Roaming User Profiles regularly,

you should set this option.

By always copying the acoustic information to the Master Roaming User Profile location, you

ensure these accuracy improvements will be available when the Master Roaming User Profile is

opened from another location. However, setting this option can increase the amount of time it

takes to close a Roaming User Profile.

In Dragon NaturallySpeaking , an end-user can set the Save Acoustic information option to con-

trol if Dragon saves the .usr and .sig files on each computer they dictate on.

See "Controlling updates to the acoustic components of a User Profile" in Dragon - What's New

for administrators for more information.

The transfer of acoustic information based on this option's setting is not limited by setting the

Disk space reserved for network archive option.

Setting this option will copy approximately 15 MB across the network at synchronization if the

Roaming and Local copies are different.

Prompt before saving to network location

Select the Prompt before saving to network location option to display a dialog box that lets

you choose where to save your User Profile. Dragon displays the dialog box when you attempt to

close Dragon, close a User Profile, or shut down the operating system. The dialog box displays an

estimate of the time required to save the profile to the local cache or the master location. This

option is turned off by default.
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To save the User Profile to the local cache, in the dialog box, select Save Locally. If you are on a

slow network, you can save the User Profile to the local cache to avoid waiting for the profile to

synchronize with the master profile in the master location.

To save the User Profile to the master location on the network, in the dialog box, select Save to

Network. Nuance recommends that you save a User Profile to the master location for accuracy

improvement and to ensure that updates to the profile are available on other computers.

Conserve archive size on network 

Select this box to prevent copying of .DRA files (files that contain the acoustic data from the

latest dictation session) to the Master Roaming User Profile location when the program syn-

chronizes the Local and Master Roaming User Profiles. Leaving this box unchecked allows the

local .DRA files to synchronize with the Master Roaming User Profile, which makes the .DRA

files available to the Acoustic and Language Model Optimizer when it is run on the Master

Roaming User Profile locations and provides increased accuracy.

However, because .DRA files can be large, if you experience excessive network slowdowns,

checking this option may solve the problem by eliminating the copying of these files each time

the Master and Local Roaming User Profiles synchronize. You can still run the Acoustic and Lan-

guage Model Optimizer on the Master Roaming User Profile, but since it will not have the

.DRA files to process, the accuracy gains will be less.

Note: The .DRA files will not be copied once the maximum size is reached in the Disk space

reserved for network archive option.

At synchronization, setting this option will copy approximately 1.3 MB for each minute of dic-

tation saved in the .DRA files. These files are only copied from the Local Roaming User Profile to

the Master Roaming User Profile; they are never copied from the Master Roaming User Profile to

the Local Roaming User Profile.

Disk space reserved for network archive

Use this option to specify the maximum size of the directory containing the acoustic data (the .dra

and the log files) available to the Acoustic Optimizer. By default the archive size is 500 MB per
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dictation source. To conserve space, you can reduce the default size and select the Conserve

archive size on network option.
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Creating a Roaming User Profile on
the local computer

There are two ways to create a Roaming User Profile:

n Train a new Roaming User Profile

n Convert a non-roaming local User Profile into a Roaming User Profile

To open or create a Roaming User Profile, your local installation of Dragon must be configured for

Roaming User Profiles. For more information, see Enabling the Roaming feature on each com-

puter where an end-user will dictate.

Notes
n If you use a variety of microphones or input devices with your Roaming User Profile, see the

topic: Using multiple dictation sources with a single User Profile.

n If you modify a master Roaming User Profile while you have a local Roaming User Profile open

on a computer that is not currently connected to the network (for example, a laptop at a remote

location), the changes to the master Roaming User Profile will overwrite any changes you make

to the local Roaming User Profile when you synchronize the local and master Roaming User

Profiles.

n When an end-user that is using a Roaming User Profile exits Dragon, switches User Profiles,

closes a User Profile, or saves a User Profile, Dragon saves changes to the Local Roaming User

Profile and then synchronizes these changes with the Master Roaming User Profile on the

network. For more information, see How Dragon Synchronizes Master and Local Roaming User

Profiles
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Creating and training a new Roaming
User Profile

To create and train a new Roaming User Profile:

1. To display the Open User Profile dialog box, select Profile > Open User Profile on the Drag-

onBar.

Note:When the Roaming feature is enabled, end-users can create only Roaming User Profiles.

The Location of user profiles field displays only the Roaming User Profile locations you

defined in the Administrative Settings dialog box. To let the end-users create both local (non-

roaming) and Roaming User Profiles, select the Allow non-Roaming User profiles to be

opened option on the Roaming tab of the Administrative Settings dialog box. Clearing this

option prevents User Profiles from dictating with a non-roaming local User Profile by accident.

For more information, see Enabling the Roaming feature on each computer where an end-user

will dictate.

If you allow end-users to open both non-roaming local and Roaming User Profiles, be sure they

select the correct location from the Location of user profiles field.

If there are multiple roaming profile locations, make sure each end-user selects the correct loca-

tion from the Location of user profiles field.

2. Click New and begin training the User Profile as you would any other User Profile.

3. When you are finished training the User Profile, the program saves the User Profiles into the

master Roaming User Profile location specified in the Location of user profiles field.
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Converting a non-roaming local User
Profile into a Roaming User Profile

You can convert an existing non-roaming local User Profile to a Roaming User Profile from the

Manage User Profiles dialog box. Converting a non-roaming local User Profile copies that User

Profile to the Master Roaming User Profile location.

To convert a non-Roaming User Profile to a Roaming User Profile:

1. Select Profile >Manage User Profiles from the DragonBar. This action displays theMan-

ager User Profiles dialog box.

2. In the Location of user profile drop-down list at the bottom of the dialog box, select the non-

roaming local location of your User Profiles. Now the list under User Profiles should include

all the non-roaming local User Profiles that you can convert to Master Roaming User Profiles.

3. Select the non-roaming local User Profiles you want to convert to a Master Roaming User Pro-

file.

4. Click the Advanced button and then select Save to Roaming from the menu that pops up.

The Save to Roaming dialog box appears.

5. Under Select Roaming Master Location to save the user, select the appropriate Master

Roaming User Profile location from the drop-down list. In the Choose subdirectory if

wanted field, you can select a subdirectory within the Roaming Master location. When finished,

click OK. A Master Roaming User Profile location appears in this list only if it is currently avail-

able to the local computer.

6. Repeat the process for any other non-roaming local User Profiles you want to convert to Master

Roaming User Profiles.
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Dictating with a Roaming User Profile
You dictate with a Roaming User Profile the same way you would with any other User Profile. For

specific information about working with a Roaming User Profile, refer to the following topics:

n Opening a Roaming User Profile

n Using multiple dictation sources with a single User Profile

n Running the Acoustic and Language Model Optimizer for Roaming User Profiles

n Synchronizing Master and Local Roaming User Profiles
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Opening a Roaming User Profile
When the Roaming feature is enabled, you can only open Roaming User Profiles (unless you set an

option allowing speakers to open both Roaming and Local User Profiles).

To open a Roaming User Profile:

1. On the DragonBar, select Profile > Open User Profile.

2. On the Open User Profile dialog box, select a User Profile from the list, and click Open.

If you do not see the User Profile you are looking for, press F5 to refresh the list of User Pro-

file.

Notes:
n If you allow end-users to select both non-roaming local and Roaming User Profiles,

make sure they select the correct location from the Location of user profiles drop-

down list.

n When the Roaming feature is enabled, you can only open Roaming User Profiles. The

Location of user profiles drop down list displays only the Roaming User Profile

locations you defined in the Administrative Settings dialog box. To let the end-users

open both local (non-roaming) and Roaming User Profiles, select the Allow non-

Roaming User profiles to be opened option in the Administrative Settings dialog

box. Clearing this option prevents end-users from dictating with a non-roaming local

User Profile by accident. For more information, see Enabling the Roaming feature on

each computer where an end-user will dictate.

n If you connect to your Roaming User Profile Master Directory over HTTP or HTTP

with SSL, and you find that the Open User Profile dialog box does not display all the

vocabularies and acoustic models for your User Profiles, make sure that:

The .INI extensions is registered in MIME types (ini.png) list of your IIS

server.

Add all file extensions within your Master Roaming User Profile directories

and sub-directories to the Registered MIME types list of your IIS server.

You could also add a wildcard ( .*) MIME-type.

For more information on adding a wildcard ( .*) MIME-type, see:

For Windows Server 2008:

http://technet.microsoft.com/en-us/library/cc725608(WS.10).aspx

n The end-user's topics.ini and acoustics.ini files are not locked, password

protected, or otherwise access restricted by your server permissions.
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Using multiple dictation sources with
a single User Profile

It is possible to have a variety of dictation sources (audio input devices) for a single set of User

Profiles so that the speaker can deploy various microphones or portable recording devices. This

ability is especially useful with the Roaming feature. By allowing multiple dictation sources, you

can still have the same User Profiles for each location regardless of the microphone type.

To add a new dictation source to a User Profile
1. In the Open User Profile dialog box, select the User Profile to dictate with the new dictation

source.

2. Click the Source button and then click New. The New Dictation Source dialog box appears.

3. Select a new input device for dictation from the list on the New Dictation Source dialog box.

You can choose from among different microphone or recorder types.

4. Click OK. You return to the Open User Profile dialog box.

5. Select the User Profile you just created and click Open. If you have not previously trained the

User Profile with the new dictation source, the Profile Creation wizard appears and you can

begin training.
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Running the Acoustic and Language
Model Optimizer for Roaming User
Profiles

When the Roaming feature is enabled on a workstation, that workstation cannot run the Acous-

tic and Language Model Optimizer or the Acoustic and Language Model Optimizer

Scheduler because the optimizer or scheduler can only be run on the Master Roaming User Pro-

file. Later, any optimizations done by the Acoustic and Language Model Optimizer are copied

to each Local Roaming User Profile when synchronization occurs.

The system administrator is responsible for running the Acoustic and Language Model Opti-

mizer on the network location of the Master Roaming User Profiles. The administrator can install

Dragon on the computer where the Master Roaming User Profiles are located or an administrator's

computer that has network access to the Master Roaming User Profiles and run the Scheduler for

the Acoustic and Language Model Optimizer. If possible, the administrator’s workstation

should be co-located with the server because a large amount of data needs to be transferred

between the server and the workstation running the optimizer.

Note: You must have Windows Administrator privileges on the computer where you are running

the Scheduler for the Acoustic and Language Model Optimizer.

Running the Acoustic and Language Model
Optimizer on a multi-core computer
If a Roaming User Profile is created and used on a multi-core computer with the Roaming feature

enabled, when an administrator runs the Acoustic and Language Model Optimizer on that profile

on a single-core computer, all accuracy improvements may not be applied to the profile. If an

administrator runs the Acoustic and Language Model Optimizer for a Roaming User Profile on a

single-core computer, when an end-user opens the profile on a multi-core computer, only the first

acoustic model will load.

To make sure that corrections and accuracy improvements that end-users make are applied to their

Roaming User Profile, an administrator should run the Acoustic and Language Model Optimizer

on Roaming User Profiles only on a multi-core computer.

Running the Acoustic and Language Model
Optimizer on a User Profile with two acoustic
models
If the computer that an end-user dictates on meets certain system requirements, Dragon Nat-

urallySpeaking can use two acoustic models (instead of one) with a User Profile. Using two acous-
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tic models instead of one increases recognition and dictation accuracy. Acoustic models that can

be added in pairs to a User Profile are called Two-pass models.

See Using multiple acoustic models with a User Profile for more information.

To run the Acoustic and Language Model Optimizer
to optimize Roaming User Profiles
1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic

and Language Model Optimizer. Also be sure that the Roaming feature is not enabled.

2. On the Windows Start menu, select Programs > Dragon NaturallySpeaking 12.0 >

Dragon NaturallySpeaking Tools > Scheduler for Acoustic and Language Model Opti-

mizer to start the Acoustic and Language Model Optimizer Scheduler.

3. Access the master directory of the Roaming User Profiles you want to optimize: select File >

Set Speaker Directory from the menu of the Acoustic and Language Model Optimizer

Scheduler window. In the Set User Profile Directory dialog box, either enter the path of the

directory or click the Browse button. If the User Profiles you want to optimize are located in

multiple directories, you can change directories to locate the additional User Profiles.

4. Select the User Profile(s) you want to optimize and set a schedule for running the Acoustic

and Language Model Optimizer. For specific instructions, click the Help button in the win-

dow.
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Controlling access to User Profiles
If you have multiple Dragon end-users on an end-user workstation, those end-users will have mul-

tiple User Profiles to choose from in Dragon's Open User Profile dialog box.

If you use a shared directory for User Profiles, whether they are roaming or non-roaming, you may

be concerned about the ability of an end-user to see and/or open another end-user’s profile as

well as their ability to open the correct profile. There are several ways to address this concern:

n Many of Nuance’s customers address this concern simply through end-user training. Each end-

user should be aware that if they open another end-user’s profile and try to use it, their accuracy

will be poor and end-user-specific customizations will not be available. Therefore, each end-

user has an incentive to use only their own profile. However, this fact doesn't prevent a

malicious end-user from damaging another end-user’s profile.

n If end-users always log into Windows with a unique Windows user ID, you can use Windows

file permissions to control access to the files. Typically, you do this by granting Full Control or

Read/Write/Modify access to the shared directory, but do not allow this permission to

propagate to sub-directories. That way, each end-user becomes the creator owner of any Dragon

User Profile that he or she creates. End-users can still see all of the Dragon User Profiles in the

Open User Profile dialog box, but if they try to select another end-user’s profile, a message will

appear saying that they do not have permission to access that profile. Apply similar file

permissions to the local copy of each Roaming User Profile; the default location for local copies

is under
C:\Documents and Settings\All
Users\ApplicationData\Nuance\NaturallySpeaking12\Roaming Users

n If end-users log in using a shared Windows user ID, the best way to control access is through

HTTP Roaming. In this configuration, you set up a web server running either IIS or Apache

and with the WebDAV file system enabled. On each workstation, you specify a URL on the

web server as the Roaming User Profile location. When an end-user launches Dragon, before

displaying the Open User Profile dialog it prompts for a user name and password, which it uses

to authenticate against the web server.

You can use file permissions on the web server to specify which User Profiles are accessible to

each account on the web server. File security is a function of the web server and the WebDAV

software.

Making it easier for end-users to select their User
Profiles
As described above, the Dragon Open User Profile dialog shows a list of all of the User Profiles in

a shared directory (unless you are using HTTP Roaming to limit access to User Profiles). If there

are more User Profiles than will fit on one screen, you can train end-users to go directly to a spe-

cific User Profile by typing the first few letters of its name.

In Dragon NaturallySpeaking , you can display and view groups of User Profiles in a tree-style

structure. See "Open User Profiles dialog box optimized for Roaming" in Dragon - What's New

for administrators for more information.
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Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:

n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

the Open User Profile dialog box does not display all the vocabularies and acoustic models for

your User Profiles, make sure that you:
l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Configuring Internet Information
Services and WebDAV for HTTP
Roaming

Here we discuss how to configure Internet Information Services (IIS) and Dragon Nat-

urallySpeaking to allow you to use WebDAV shares as http roaming users profile locations.

You must perform two steps to use IIS and WebDAV for Dragon HTTP Roaming:

1. Configuring Internet Information Services and WebDAV

2. Configuring Dragon internet roaming
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Configuring Internet Information
Services and WebDAV

To run WebDAV, you must install Internet Information Services (IIS) 7 or greater on a server

operating system such as Windows Server 2008.

In this section we discuss installing and configuring WebDAV on IIS 7.0.

Installing and configuring WebDAV on Internet
Information Services 7.0
Internet Information Services 7.0 - Install WebDAV
1. Install WebDAV on the IIS 7 server. For more information, see

http://technet.microsoft.com/en-us/library/cc431377.aspx

Internet Information Services 7.0 - Configuring WebDAV
1. Create a virtual directory that points to the Roaming User directory. For more information, see

http://msdn.microsoft.com/en-us/library/bb763173.aspx

2. Enable Basic Authentication for the Roaming User directory. For more information, see:
http://technet.microsoft.com/en-us/library/cc733010(WS.10).aspx

3. In the IIS Manager, select Default Web Site in the left pane.

4. In the main view, double-click WebDAV Authoring Rules.

5. Select WebDAV Settings.

6. In the WebDAV Settings page, under Authoring Behavior, set the Allow Unknown MIME

Types property to True.

7. Under Property Behavior, set the Allow Custom Properties and Allow Property Queries

with Infinite Depth properties to True.
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8. Click Apply to save the changes.

9. Make sure that the files in your Roaming User Profile directory are not locked, password pro-

tected, or otherwise restricted for access by server permissions.
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Configuring Dragon internet roaming
Perform the following steps to configure Dragon internet roaming on all workstations.

1. Start Dragon NaturallySpeaking .

2. Open the Administrative Settings dialog. On the Dragon Bar, select Tools > Administrative

Settings.

3. In the Roaming tab, select Enable.

4. Click the Add button to add a new network location.

5. Set the Display Name and the Network Location. The Roaming User Network Location dialog

box displays examples of what you can enter in the Address field.

l For HTTP locations, you can click the HTTP Settings button to set information specific

to your HTTP connection like Authentication, Firewall, and Proxy Server information.

Nuance strongly recommends that you test your connection to the HTTP server from the

HTTP Settings dialog box.
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Upgrading Roaming User
Profiles: Overview

This section describes how to upgrade Roaming User Profiles from Dragon NaturallySpeaking 10.x

or 11.x to Dragon NaturallySpeaking .

Since the Local Roaming User Profile is a copy of a subset of the end-user data taken from the

master Roaming User Profile, an administrator cannot directly upgrade the Local Roaming User

Profile when they upgrade the local Dragon installation from Dragon 10.x or 11.x to Dragon Nat-

urallySpeaking .

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.

Notes:

n Upgrading a set of Dragon 10.x or 11.x master Roaming User Profiles to Dragon

NaturallySpeaking leaves the Dragon 10.x or 11.x master Roaming User Profiles unchanged.

Leaving the Dragon 10.x or 11.x files intact allows the users in the network to run Dragon 10.x

or 11.x while the administrator plans the upgrade.

n You can upgrade from a variety of Dragon products to Dragon NaturallySpeaking . If you have

custom vocabularies from other versions or editions of Dragon, you must recreate the custom

vocabularies in Dragon NaturallySpeaking . See 'Upgrading to Dragon NaturallySpeaking ' in

What you should know before upgrading from a previous version for details.

n Plan to upgrade the master Roaming User Profiles at a time when User Profiles are not in use,

for example during the night or on a weekend.

n Even though the Dragon NaturallySpeaking User Profile Upgrade Wizard supports both mapped

drives and UNC paths, Nuance strongly recommends that administrators upgrade the Master

Roaming User Profiles on a drive on a computer where Dragon NaturallySpeaking is locally

installed. Nuance does not recommend that administrators upgrade the Master Roaming User

Profiles across a network to either a mapped drive or UNC path; upgrading over a network will

take a undetermined length of time. In addition, the User Profile Upgrade Wizard does not support

upgrading User Profiles over an HTTP connection.

n If upgrading from Dragon version 8.x or earlier to Dragon NaturallySpeaking , version 8.x or

earlier custom words and commands can be re-used in Dragon NaturallySpeaking :

1. In Dragon 8.x or earlier, export the custom words and commands

2. In Dragon NaturallySpeaking , create a new User Profile

3. In Dragon NaturallySpeaking , import the custom words and commands

See the Dragon Help for information on exporting and importing custom words and

commands.

Step 1: Preparing to upgrade Roaming User Profiles
To upgrade Master Roaming User Profiles from a previous version of Dragon, Nuance rec-

ommends that an administrator install Dragon NaturallySpeaking directly on the network
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computer where the Dragon 10.x or 11.x Master Roaming User Profiles are located and upgrade

those Master Roaming User Profiles directly to Dragon NaturallySpeaking Master Roaming User

Profiles.

If an administrator is unable to install Dragon where the Dragon 10.x or 11.x Master Roaming

User Profiles are located, Nuance recommends that the administrator:

n Install Dragon NaturallySpeaking on a separate computer where the administrator will perform

the upgrades.

n Copy the Dragon 10.x or 11.x Master Roaming User Profiles from the network location to the

computer where Dragon NaturallySpeaking is installed.

n Upgrade the Dragon 10.x or 11.x Master Roaming User Profiles on the computer where Dragon

NaturallySpeaking is installed.

n Copy the upgraded Dragon NaturallySpeaking Master Roaming User Profiles to a network

accessible directory on the original network location.

For more information, see Preparing to upgrade Roaming User Profiles.

Step 2: Upgrading the User Profiles
An administrator must separately upgrade the master Roaming User Profiles to Dragon Nat-

urallySpeaking using the User Profile Upgrade Wizard.

After an administrator upgrades the Dragon 10.x or 11.x Master Roaming User Profiles, they can

then proceed to upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading master Roaming User Profiles

Step 3: Upgrade the end-user systems
After an administrator upgrades the master Roaming User Profiles, they can then proceed to

upgrade end-user systems that deploy the Roaming feature.

For more information, see Upgrading end-user systems.
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Preparing to upgrade Roaming User
Profiles

Step 1: Install Dragon NaturallySpeaking on the
computer where you upgrade the Dragon 10.x or
11.x Master Roaming User Profiles
Nuance recommends that administrators install Dragon NaturallySpeaking on the computer where

the Dragon 10.x or 11.x Master Roaming User Profiles are located. If that is not possible, Nuance

recommends that administrators install Dragon NaturallySpeaking on a separate computer where

they will perform the upgrades.

For more information on installing, see Installing Dragon on a single computer.

Notes:

n If during the installation or upgrade, you see the Upgrade existing speech files to work with

this installation prompt, be sure to leave this option unchecked. You can manually running

the User Profile Upgrade Wizard in a later step.

n If you are unable to install Dragon where the Dragon 10.x or 11.x Master Roaming User Profiles

are located, Nuance recommends that you install Dragon NaturallySpeaking on a separate

computer where you perform the upgrades. For more information, see Upgrading Roaming User

Profiles: Overview.

n You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

n If upgrading from Dragon 8.x or earlier to Dragon NaturallySpeaking , version 8.x or earlier

custom words and commands can be re-used in Dragon NaturallySpeaking . See the Dragon

Help for information on exporting and importing custom words and commands:

i. In Dragon 8.x or earlier, export the custom words and commands

ii. In Dragon NaturallySpeaking , create a new User Profile.

iii. In Dragon NaturallySpeaking , import the custom words and commands

Step 2: On the Dragon 10.x or 11.x end-user
systems that use the Roaming feature
On the end-user systems where the end-users dictate using the Dragon 10.x or 11.x Roaming fea-

ture, save and close any open User Profiles on each Dragon 10.x or 11.x system that uses the Roam-

ing feature.

Note: If there is no time when all the Roaming User Profiles are not in use (for example, in a hos-

pital where some physicians use Dragon during a night shift), administrators can upgrade different

groups of Roaming User Profiles at different times.

270



Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Step 3: On the central network storage location for
the Dragon 10.x or 11.x Master Roaming User
Profiles
1. (Optional) Back up the master Roaming User Profiles to a separate location, either by using any

system backup utility that is implemented at your facility or by using the Dragon TheManage

User Profiles dialog.

Note: You do not need to back up the Roaming User Profiles because the upgrade retains the

Dragon 10.x or 11.x User Profiles in a directory that is separate from the Dragon Nat-

urallySpeaking User Profiles.

2. Create a new directory on the shared network drive to store the upgraded Dragon Nat-

urallySpeaking Master Roaming User Profiles. Although you can store the upgraded User Pro-

files in the same location as the current User Profiles — this would make two versions of each

User Profile visible to the end-user and lead to confusion — Nuance recommend creating a loca-

tion that is different from the location that stores the current (Dragon 10.x or 11.x) User Pro-

files.

Step 4: Copy the Dragon 10.x or 11.x Master
Roaming User Profiles to the Dragon
NaturallySpeaking client computer
If you install Dragon NaturallySpeaking on the computer where the Dragon 10.x or 11.x Master

Roaming User Profiles are located, then proceed to Step 5 below.

If Dragon NaturallySpeaking is not installed on the computer where the Dragon 10.x or 11.x

Master Roaming User Profiles are located, perform the following steps on the Dragon Nat-

urallySpeaking client computer:

1. Create a directory to store all the Master Roaming User Profiles you plan to upgrade.

2. Copy the Dragon 10.x or 11.x Master Roaming User Profiles from the network location to the

directory.

Step 5: On the administrator system where you
plan to upgrade the Dragon 10.x or 11.x Master
Roaming User Profiles
1. Start Dragon and make sure the Roaming feature is off.

To turn off the Roaming feature:

i. Close any open User Profiles.

ii. Click Administrative Settings on the DragonBar Tools menu. This action dis-

plays the Administrative Settings dialog box.

iii. On the Roaming tab, make sure Enable is not selected.
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2. Close Dragon.

3. Follow the instructions in the next section, Upgrading master Roaming User Profiles.

See "Upgrading User Profiles to Dragon NaturallySpeaking " in Dragon - What's New for admin-

istrators for more information.

272



Chapter 6: Configuring and using the Roaming feature and Roaming User Profiles

Upgrading master Roaming User
Profiles

You must use the User Profile Upgrade Wizard to upgrade Dragon 10.x or 11.x master Roaming

User Profiles to Dragon NaturallySpeaking .

Before you proceed with the tasks in this topic, complete the procedure in Preparing to upgrade

Roaming User Profiles.

After you upgrade the Dragon 10.x or 11.x Master Roaming User Profiles and optionally copy

them back to their network location, you can proceed to upgrade your end-user systems that use

the Roaming feature. For more information, see Upgrading end-user systems.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported

Step 1: Upgrade the Dragon 10.x or 11.x Master
Roaming User Profiles
On the computer with the Dragon 10.x or 11.x Master Roaming files and where Dragon Nat-

urallySpeaking is installed:

1. Select Start > Programs  > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking Tools > Upgrade User Profiles.

2. On the Select the profile(s) to upgrade page, click Browse to add a profile to select the

location of the Dragon 10.x or 11.x Master Roaming User Profiles. The Select the profile(s) to

upgrade page now displays a list of User Profiles in the selected directory:
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Continue to add User Profiles from other local locations or use the Remove from list button to

remove specific User Profiles. Click Next to continue.
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3. If you choose to upgrade only one User Profile, the wizard displays the number of minutes the

upgrade requires to complete the upgrade.

4. If you upgrade a UK User Profile, the wizard displays a page that lets you select a region for the

profile.

5. On the Choose where to store the upgraded profile(s) page, in the Location for upgraded

profile(s) text box, choose the local location you previously created to contain the upgraded

Dragon NaturallySpeaking master Roaming User Profiles. If a location is not visible, click
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Browse, find the correct location, and click Next.

6. The Begin profile upgrading page displays the number of User Profiles that the wizard is pre-

pared to upgrade.

Click Begin upgrading to start the upgrade process. The upgrade process can take 2-3 min-

utes or more per User Profile, depending on the speed of the computer system and the speed of

the network. Click Stop at any time to interrupt this process. The upgrade process creates new

master Roaming User Profiles in the destination you selected.

7. Click Finish to complete the upgrading process and exit the User Profile Upgrade Wizard.

The User Profile Upgrade Wizard names each Dragon NaturallySpeaking master Roaming User

Profile as follows: <name> (v12). For example, Dragon copies and upgrades a Dragon 10.x
Master Roaming User Profile with a filename of roaminguser1 to roaminguser1 (v12). Dragon does not

change the name of the Dragon 10.x Master Roaming User Profile.

Do no store the Dragon 10.x or 11.x Roaming User Profiles in the same directory as the upgraded

Dragon NaturallySpeaking Roaming User Profiles. The Open User Profile dialog box displays all

the Dragon 10.x and 11.x profiles. A Dragon end-user may not be sure of the profile they should

select for dictation.

Step 2: Clean up the Dragon 10.x or 11.x locations
for master Roaming User Profiles (optional) 
When the User Profile Upgrade Wizard modifies the Dragon 10.x or 11.x master Roaming User

Profiles, it create a copy of the upgraded User Profile and does not change the original profiles.

This ensures the original profiles are available in case someone requires them.
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An administrator can optionally rename or remove the Dragon 10.x or 11.x master Roaming User

Profiles through theManage User Profiles dialog box.

Step 3: Copy the Dragon NaturallySpeaking Master
Roaming User Profiles to their network location
(Optional)
If you were unable to install Dragon NaturallySpeaking where you store the Dragon 10.x or 11.x

Master Roaming User Profiles, and you instead copy them to a different computer with Dragon

NaturallySpeaking installed, you must now copy the Dragon NaturallySpeaking Master Roaming

User Profiles back to the new network directory. This is the directory you created on their original

network location.

You can skip this step if you installed Dragon NaturallySpeaking on the computer where the

Dragon 10.x or 11.x Master Roaming User Profiles are located and you upgraded those Master

Roaming User Profiles directly to Dragon NaturallySpeaking .

Step 4: Upgrade end-user systems to Dragon
NaturallySpeaking
After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that

use the Roaming feature.

You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon 9.x or

earlier to Dragon 12 is not supported.

For more information, see Upgrading end-user systems.
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Upgrading end-user systems
After you upgrade the master Roaming User Profiles, you can upgrade the end-user systems that

use the Roaming feature.

Before proceeding with this section, make sure you perform the procedure in Upgrading master

Roaming User Profiles.

Note: You can only upgrade from Dragon 10.x or greater to Dragon 12. Upgrading from Dragon

9.x or earlier to Dragon 12 is not supported.

Step 1: Upgrade Dragon 10.x or 11.x systems that
use the Roaming feature
Since the User Profile Upgrade Wizard does not change or move the Dragon 10.x or 11.x

master Roaming User Profiles, your Dragon 10.x or 11.x systems can continue to use the Roaming

feature until you upgrade to Dragon NaturallySpeaking .

To upgrade a Dragon 10.x or 11.x system to Dragon NaturallySpeaking , follow the installation

instructions under Installing Dragon on a single computer .

Notes:

n When prompted, choose to remove the Dragon 10.x or 11.x Dragon installation. If you choose

not to remove the previous installation, you cannot continue to upgrade.

Step 2: Enable the Roaming feature on the Dragon
systems

When you upgrade to Dragon NaturallySpeaking , the Roaming feature is off by default.

To turn on the Roaming feature, perform the following steps on each Dragon NaturallySpeaking

client computer:

1. Start Dragon.

2. Close all User Profiles.

3. Click Administrative Settings on the DragonBar Tools menu. This displays the Admin-

istrative Settings dialog box.

4. On the Roaming tab, select Enable.

5. The Network Directories list displays the network location of the Dragon 10.x or 11.x master

Roaming User Profiles.

If you created a new network directory for the Dragon NaturallySpeaking master Roaming User

Profiles, you can either click the Add button to add the new network location or select a listed

directory and then click Edit to change the path to the new location. When you have finished,

click OK to close the Administrative Settings dialog box. You should also remove any Dragon

10.x or 11.x master Roaming User Profile directories that are not in use.
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6. Select Profile > Open User Profile on the DragonBar. This action displays the Open User

Profile dialog box. If you allow end-users to select both non-roaming local and Roaming User

Profiles, make sure they select the correct location (the Dragon NaturallySpeaking Roaming

User Profile location) from the Location of user profile field.

7. Select a User Profile and click Open.

Note: If you did not upgrade the Roaming User Profiles and store them in the new master Roam-

ing User Profile directory, when you click Open, the User profile needs to be upgraded

dialog box appears. Since you cannot upgrade Roaming User Profiles locally, you should click Can-

cel and return to Upgrading master Roaming User Profiles. If you click OK instead of Cancel,

you receive a message stating You cannot upgrade a roaming user because you cannot upgrade

Roaming User Profiles on a workstation where the Roaming feature is on.
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This section contains information on using Dragon on Windows Server 2008 R2 or Windows 7 Ultimate
Server, including support for using the PowerMic II and Terminal Services.

Using Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server 282

Allow client users to connect to Dragon and applications on a server 283

Installing Dragon software on the server and the client computer 285

Configuring the Windows server 287

Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 1 288

Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 2 294

Configuring Remote Desktop Connection for Windows 7 Ultimate Server 295

Configuring the client computer to connect to Dragon through a remote desktop con-

nection 296

Updating earlier versions of Dragon to support audio redirection 301

Using the PowerMic II through a remote desktop connection 302

Keyboard keys you can assign to PowerMic II buttons 305

System Requirements for Dragon on Windows Server 2008 R2 or Windows 7 Ultimate

Server 306

281



Dragon 12 Administrator Guide

Using Dragon on Windows Server
2008 R2 or Windows 7 Ultimate
Server

This section provides information on how to deploy Dragon on Windows Server 2008 R2 or Win-

dows 7 Ultimate Server.

Tasks: Topic:

Overview of how client users can remotely

connect to Dragon installed on Windows

Server 2008 R2 or Windows 7 Ultimate

Server.

Allow client users to connect to

Dragon and applications on Windows

Server 2008 R2 or Windows 7 Ulti-

mate Server

Install Dragon on the server and install

Dragon Client For Remote Desktop

Installing Dragon software on the

server and the client computer

Set up the Windows server options Configuring the Windows server

Set up client computers by setting audio pol-

icies, roaming user directories, and the

Remote Desktop Connection 7.

Configuring the Dragon client com-

puter

Update earlier versions of Dragon to work

with Windows Server 2008 R2 or Windows

7 Ultimate Server

Updating earlier versions of Dragon to

support audio redirection

Use a PowerMic II with Dragon on Win-

dows Server 2008 R2 or Windows 7 Ulti-

mate Server

Using the PowerMic II through a

remote desktop connection

System Requirements for Dragon on Win-

dows Server 2008 R2 or Windows 7 Ulti-

mate Server

System Requirements for Dragon on

Windows Server 2008 R2 or Windows

7 Ultimate Server
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Allow client users to connect to
Dragon and applications on a server

Microsoft Windows Server 2008 R2 and Windows 7 Ultimate Server include the ability to enable

audio redirection from a remote desktop connection into the server. For Dragon 12 users, this

allows speech recognition to take place over the network when Remote Desktop Connection ver-

sion 7 (or higher) is used to connect the Windows client to the server. Dragon NaturallySpeaking

is installed on Windows Server 2008 R2 or Windows 7 Ultimate Server, Dragon detects when the

RDC 7 client session starts and allows users to dictate into remote applications that are published

on the server.

Windows 7 Ultimate Server allows only one client connection at a time. Windows Server 2008 R2

allows multiple client connections at once. Keep this in mind as you plan your configuration.

In order to transmit audio from the client computer to Windows Server 2008 R2 or Windows 7

Ultimate Server running Dragon NaturallySpeaking , you must:

n enable the audio recording option on the remote client software

n enable the audio recording redirection policy on the server

This configuration allows one Windows client computer to access and use a single installation of

Dragon NaturallySpeaking on the server.

Support for dictation sources over a remote
desktop connection
In Dragon NaturallySpeaking , you can use the following dictation sources over a remote desktop

connection:

n Smartphones: Apple iPhone 3GS and higher, Smartphones and tablets using Android OS 2.2

and higher. See Using a smart device as a microphone over VPN for details.

n USB microphones: including PowerMic II, Philips SpeechMike 

n Other microphones:Microphone plugged into Mic-In jack

n Headset: Andrea NC-181

n Bluetooth: Plantronics Calisto Bluetooth Headset

Note:

To use the PowerMic II over the RDC connection, you install the Powermic II Button Control

application to enable button support.

Notes: Using Dragon NaturallySpeaking on Windows Server 2008 R2 or Windows 7 Ultimate

Server:

n When you create a User Profile, you will not see a choice for the Powermic II dictation source.

You must use the USB selection. When you use the USB dictation source, you cannot use

hotkeys for the PowerMic II unless you manually configure the buttons using the PowerMic II

Button Control application, which is available in this release.
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n If you are using the Remote Application web interface - When you launch Dragon from the

Remote Desktop Connection, if you launch the DragonBar in Docked-to-Top or Docked-to-

Bottom mode, the Dragon menus will not be visible. To access the menus, you need to switch

to work with Floating, Clinging, or the Tray Icon mode.

Using a smart device as a microphone over VPN
It is possible to use a VPN connection to dictate to Dragon on a remote computer using a sup-

ported smart device and the Dragon remote microphone application. For detailed VPN setup and

access instructions, please contact your company's IT department and refer to your device sup-

port.

n For iOS devices, see the Apple knowledge base article "iOS: Setting up VPN" -

http://support.apple.com/kb/ht1424

n For Android-based devices, consult Google support.

n If you have problems using Bonjour over VPN, please use the barcode setup or manual setup.

method. See the Dragon Help for details.
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Installing Dragon software on the
server and the client computer

To enable audio redirection through a remote desktop connection, and allow users to connect and

use Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server, you install software on

Windows servers and on Dragon workstations. You can expect to spend around thirty minutes

installing and configuring the required software.

Perform the following steps:

1. Install Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server. See Installing

Dragon on a single computer for more information.

2. To use a smartphone device as a microphone- Configure the Dragon Remote Microphone appli-

cation on your iPhone to communicate with Dragon.Installing the Dragon Client for Remote

Desktop software and using the Audio Setup wizard is not required for smartphones.

or

To use a non-smartphone device as a microphone - On each client computer that will connect

to Dragon on the server, install the Dragon Client For Remote Desktop on the client computer:

1. Insert your Dragon NaturallySpeaking DVD in your local computer's DVD drive.

2. In the Dragon Client For Remote Desktop folder, run setup.exe and follow the

steps to install the software.The program group "Dragon Client For Remote Desk-

top" appears in your Windows program folders available from the Windows Start

menu.

Note: If you are installing Dragon Client for Remote Desktop using the MSI Win-

dows Installer, run dragonclientinstaller.msi.

3. Connect the microphone that you will use to dictate with Dragon.

4. If your computer has multiple audio sources, make sure that your microphone is

set as the Default recording.

5. From the Dragon Client for Remote Desktop program group, run the Audio

Setup Wizard to configure your microphone.

Note: To use a smartphone or other supported wireless device as a remote micro-

phone, do not use the Audio Setup wizard. See Set up a smart device as a micro-

phone

Dragon Client For Remote Desktop components
The Dragon Client For Remote Desktop installation consists of two components that you install

on the client computer:

n Audio Setup Wizard: a stand-alone application that provides a way to check that

your microphone sound levels and signal quality are suitable for using Dragon

NaturallySpeaking with a remote desktop connection. 

n PMIIControl.exe - the Powermic II Button Control application: a stand-alone

application that provides a way to customize the buttons on the PowerMic II. The

buttons can be used with Dragon NaturallySpeaking while working across the
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remote desktop connection, and can also be used with local applications,

independent of installing and using Dragon NaturallySpeaking .

3. Proceed to Configuring the Windows server.
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Configuring the Windows server
1. Ensure the server computer meets the system requirements. See System Requirements for

Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server for more information.

2. On Windows Server 2008 R2 or Windows 7 Ultimate Server, make sure that the "Remote

audio" recording device already exists.

3. If you are using Windows Server 2008 R2, perform the steps in Configuring Remote Desktop

Connection for Windows Server 2008 R2.

5. If you are using Windows 7 Ultimate Server, perform the steps in Configuring Remote Desktop

Connection for Windows 7 Ultimate Server.

6. Optionally, you can publish all applications and EMRs on Windows Server 2008 R2 or Win-

dows 7 Ultimate Server using Remote Application Manager. This provides full support for dic-

tation and playback.

7. Optionally, you can configure the Roaming User master directory and Roaming Administrative

settings. Nuance recommends enabling the Roaming User feature to store User Profiles on a

secure network.

8. Proceed to Configuring the client computer to connect to Dragon through a remote desktop

connection.
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Configuring Remote Desktop
Connection for Windows Server 2008
R2 Part 1

Perform the following steps to install and configure the Remote Desktop Services role.

1. Open Remote Desktop Connection.

2. Open the Server Manager.

3. Select Roles.

4. Select Add Roles.

5. On the Before You Begin screen, click Next.
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6. On the Select Server Roles screen, select Remote Desktop Services, click Next.

7. On the Remote Desktop Services screen, click Next.
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8. On the Select Role Services screen, select Remote Desktop Session Host, click Next.

9. On the Uninstall and Reinstall Applications for Compatibility screen, click Next.
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10. Select Do not require Network Level Authentication , click Next.

11. On the Specify Licensing Mode screen, click Next.

12. Click Next.
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13. Select the Audio and video playback option and the Audio recording redirection option.
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14. Confirm your selections, and click Install.

The Installation Progress screen display the status of the installation.

15. On the Installation Results screen, verify that the installation was successful. Click Close.

16. Restart the computer.

17. Proceed to Configuring Remote Desktop Connection for Windows Server 2008 R2 Part 2.
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Configuring Remote Desktop
Connection for Windows Server 2008
R2 Part 2

Perform the following steps to configure the local group policy on the server and to allow con-

nections from client computers.

1. From a command prompt, run gpedit.msc.

2. Navigate to Computer Configuration > Administrative Templates > Windows Com-

ponents > Remote Desktop Services > Remote Desktop Session Host > Device and

resource redirection.

3. Enable the Allow audio and video playback redirection option: on the Allow audio and

video playback redirection screen, select Enabled and Press OK.

4. Enable the Allow audio recording redirection option: on the Allow audio recording redi-

rection screen, click Enabled and Press OK.

5. Launch regedit on and set the following registry setting to 0:

HKLM\SYSTEM\CurrentControlSet\Control\Terminal Server\Wi-
nStations\RDP-Tcp
fDisableAudioCapture REG_DWORD 0x00000000

6. Open the Control Panel.

7. Navigate to System and Security > System.

8. Select Remote.

9. Enable the Allow connections from computers running any version of Remote Desktop

(less secure) option.

10. Click OK.

11. Continue at step 5 in Configuring the client computer and the server.
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Configuring Remote Desktop
Connection for Windows 7 Ultimate
Server

1. On the Windows 7 Ultimate Server, open the Control Panel.

2. Open System Properties.

3. Click the Remote tab.

4. Enable the Allow Remote Assistance connections to this computer option.

5. Enable the Allow connections from computers running any version of Remote Desktop

(less secure) option.
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Configuring the client computer to
connect to Dragon through a remote
desktop connection

After you install Dragon on the server and Dragon Client for Remote Desktop on each client com-

puter, perform the following steps on each client computer that will connect to Dragon on the

server.

1. Ensure the client computer meets the system requirements. See System Requirements for

Dragon on Windows Server 2008 R2 or Windows 7 Ultimate Server for more information.

2. On the client, plug in the microphone that you will use to dictate with Dragon. Then run the

Audio Setup Wizard to check that microphone sound levels and signal quality are suitable.

3. Ensure Remote Desktop Connection 6.1 (RDC 6.1) or higher is installed on the client com-

puter. If it is not, visit the following link to download Remote Desktop Connection 7.0 client

update http://support.microsoft.com/kb/969084

4. When you start Remote Desktop Connection 7, in the Remote Desktop Connection dialog box,

click Options. 
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5. Select the Local Resources tab, click Settings.

6. Select Play on this computer and Record from this computer, and click OK. Selecting

these options enables audio support each time the end-user opens the remote connection to use
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Dragon on Windows Server 2008 R2.

8. Recommended only for the PowerMic: On the Local Resources tab, set the Apply Win-

dows.key combinations field to Only when using the full screen. Using full screen lets you

use the PowerMic II Button Control application correctly. Note: If not using full screen mode,

key combinations may not work as expected and may be limited.
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9. Recommended only for the PowerMic: On the Display tab, set the Display configuration to

Full Screen.
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10. In the Windows sound settings, verify that Remote Audio device appears.

Create or open a User Profile and begin dictating with Dragon. Inform Dragon users that when they create

User Profile, they must perform four minutes of Short training. It is not possible to skip User Profile train-

ing when Dragon is installed on the Windows Server 2008 R2 and when using Remote Desktop Con-

nection 7. Dragon users can use profiles created on other systems without performing additional training on

Windows Server 2008 R2.

Nuance recommends creating User Profiles in the Windows Server 2008 R2. The microphone used to

create the profiles on a different system may be different than the currently available microphone on the

remote audio device.
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Updating earlier versions of Dragon
to support audio redirection

As mentioned in other sections, whenever you create a new User Profile and want the ability to

access Dragon with Remote Desktop Connection 7, you must perform short training.
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Using the PowerMic II through a
remote desktop connection

If you use the Nuance PowerMic II microphone to dictate with Dragon, the buttons will not

work with Remote Desktop Connection 7 unless you customize button settings using the Pow-

erMic II Button Control application. You use the PowerMic II Button Control application to

assign the buttons for use in any application that accepts hotkeys, such as EMRs, audio recorders,

etc. You do not need to start the Remote Desktop Connection to assign hotkey settings to the

buttons. See Keyboard keys you can assign to PowerMic II buttons for more information.

Configuring the PowerMic II buttons
1. In Windows explorer, navigate to the folder that contains PMIIControl.exe. The default loca-

tion of PMIIControl.exe is:

C:\Program Files\Nuance\Dragon Client For Remote Desk-
top\PMIIControl.

2. Double-click PMIIControl.exe. The following screen appears:

3. Place your cursor in the text box under Button Pressed Key Sequence.
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4. Enter the Windows keystrokes that will be sent to the server when you press the microphone

button, release the button, or press and release the button.

l Button 1: is set to send the sequence {Shift + Ctrl+D}, which is assigned to the Dragon

desktop shortcut and will start Dragon. Simply pressing Button 1 starts Dragon ; nothing

happens when you let go of the button. 

l Button 2: is set to simulate the Dragon Press-to-Talk button by pressing function key F3.

Let’s say the administrator assigns F3 in Dragon as the hotkey setting for using Press-to-

Talk: for a Remote Desktop Connection, the end-user must also set F3 in the PowerMic II

Button Control application. In order for the microphone to turn off when the end-user lets

go of Button 2, it is necessary to enable the Button Release Triggers Key Up checkbox. No

additional key sequence is required for this type of usage.

l Button 3: is set to send two key sequences to simulate turning a feature on and off. For

example, let’s say the end-user assigns {Ctrl+ P} and {Alt} to use to play and stop the

audio playback feature. The same key sequences must be assigned to buttons in order for

the feature to work with a remote desktop connection. This set of key sequences works dif-

ferently from the example for Button 2, since the keystroke for the Button Released is

defined explicitly by the user. It is not necessary to enable the Button Release Triggers Key

Up checkbox, since the key sequence itself defines the action.

Notes: Notes: Configuring the PowerMic II buttons
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n If you type a letter key (A-Z), the system automatically adds "Ctrl+Alt" as a modifier.

n If you type a digit (0-9), the system adds "Shift+Alt" as a modifier.

n Support is present for the Ctrl and Alt modifiers for all keys; Shift can only be allowed with

another modifier, followed by a letter or digit key. For example, you can assign

“{Shift+Extended -},” but not “{Shift -}.

n It is not possible to assign key sequences for mouse control features, or map the predefined

mouse buttons. However, you may modify the mouse speed by changing the Mouse settings in

the Windows Control Panel.

n If you use the PowerMic II Button Control application on a computer where Dragon is

installed, you will receive a warning if you try to assign a key sequence that is already assigned in

Dragon.

n The PowerMic II Button Control application will not run if an installation of Dragon other than

Dragon NaturallySpeaking is running on the local computer. In this case, the end-user will

receive a warning.

n You can assign a key sequence for:
l The Scan button, located on the under-side of the PowerMic II

l The Tab and Enter keys
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Keyboard keys you can assign to
PowerMic II buttons

You can use the PowerMic II Button Control application to assign the following keyboard keys to

the PowerMic II buttons:

n BACKSPACE

n DOWNARROW

n END

n ENTER

n ESC

n F1

n F10

n F11

n F12

n F2

n F3

n F4

n F5

n F6

n F7

n F8

n F9

n HOME

n INS

n LEFTARROW

n MINUSKeyPad

n PAGEDOWN

n PAGEUP

n PLUSKeyPad

n RIGHTARROW

n SLASHKeyPan

n STARKeyPad

n TAB

n UPARROW
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System Requirements for Dragon on
Windows Server 2008 R2 or Windows
7 Ultimate Server

n Dragon client: Dragon NaturallySpeaking , Dragon Professional or Legal.

n Server Operating System: Windows Server 2008 R2 or Windows 7 Ultimate Server

Window Server 2008 R2 supports multiple client connections at the same time. Windows 7

servers supports only a single client connections at one time.

n Client Operating System: The following operating systems support Remote Desktop

Connection 7:
l Windows XP Service Pack 3, 32-bit

l Windows 7, 32-bit and 64-bit

l Windows Vista Service Pack 2, 32-bit and 64-bit

n Client Hardware: The following are the minimum requirements for 2 concurrent users on a

client computer connecting to Dragon on a server:
l CPU: 2-core 2.x Ghz

l RAM: 2GB DDR3

n Server Hardware: For Windows Server 2008 R2, to support 6 concurrent users connecting to

Dragon, the minimum requirements are:
l Cache: 1 MB L2 cache per CPU

l CPU: 3.x Ghz

l Disk space: 5 GB

l Processor: Multi-core processor with 4 cores

l RAM: 16 GB DDR2 RAM

n Client Hardware: Disk space: 8 MB

n Dictation sources:
l Smartphones: Apple iPhone 3GS and higher, Smartphones and tablets using

Android OS 2.2 and higher. See Using a smart device as a microphone over

VPN for details.

l USB microphones: including PowerMic II, Philips SpeechMike 

l Other microphones:Microphone plugged into Mic-In jack

l Headset: Andrea NC-181

l Bluetooth: Plantronics Calisto Bluetooth Headset

n Software:
l Remote Desktop Connection 7 (RDC 7). The RDC 7 download is available

here, and works for all operating systems:

http://support.microsoft.com/kb/969084

Optionally, you can use USB Redirector rather than RDC 7.
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n Network:
l 100 Mbps connection speed 

l Network bandwidth required per active end-user is 1.3 Mbps
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This section contains information on how you can add or remove the custom words, vocabularies, and
commands for a User Profile.
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The Nsadmin utility for new words, vocabularies, and commands 318

Using paths with the nsadmin utility 325
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Adding words, commands, or
vocabularies to User Profiles

You use the nsadmin utility or the Data Distribution Tool to make new words, customized

vocabularies, or new commands available to all User Profiles on a particular installation of Dragon.

Both the nsadmin utility and Data Distribution Tool can work across a network.

The nsadmin utility lets you use the command line to make new words, commands, and vocab-

ularies available to end-users. The nsadmin utility can perform only one action at a time. How-

ever, you can create a batch file or script that can perform multiple nsadmin operations on a

computer.

The Data Distribution Tool lets you use a GUI to interact with the nsadmin utility and make

new words, commands, and vocabularies available to end-users.

Using the Data Distribution Tool
In Dragon Professional and Legal, you can use the Data Distribution Tool to interactively make

new words, customized vocabularies, or custom commands available to all end-users on a par-

ticular installation of Dragon.

You run the Data Distribution Tool on each installation of Dragon where you want the new

words or vocabularies to be available to Dragon end-users.

This section describes:

n Creating the Data Distribution Directory

n Starting the Data Distribution Tool

n Adding and removing custom words

n Adding and removing custom vocabularies

n Adding and removing custom commands

You can also run the nsadmin utility from the command line. For more information, see The

Nsadmin utility for new words, vocabularies, and commands.
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Creating the Data Distribution
Directory

You create a data distribution directory to store word lists, commands, or both, that you plan to

distribute to multiple end-users of Dragon NaturallySpeaking .

When word lists and commands are in the data distribution directory, as soon as a person opens

their User Profiles, Dragon automatically imports words and commands from the data distribution

directory into the User Profiles. This occurs regardless of the location of the computer the end-

user dictates on.

You can use the Data Distribution Tool to put words and commands into a data distribution

directory. For more information, see Starting the Data Distribution Tool.

Note: In Windows XP, by default, Dragon places custom words for existing Dragon User Profiles

here:
C:\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking12\custom.

See "Dragon file structure" in the Dragon Help for information on default locations on Windows 7

and other operating systems.

Create a data distribution directory in a location other
than the default location

Repeat the following steps for each workstation that should share the distributed words or com-

mands.

1. In Dragon, close all open User Profiles.

2. On the network, create a directory and give all end-users that dictate with Dragon access to the

directory. Grant read access to providers that dictate. Grant write access only to administrators.

3. If Dragon is running, on the DragonBar, select Tools > Administrative Settings. When the

Administrative Settings dialog box opens, proceed to Step 6.

4. If Dragon is not running, select Start > Run. When the Run dialog box opens, in the Open

text box, type the following, making sure to put a space between natspeak.exe and the /Se-

tDefaultAdministrativeOptions option:
C:\Program Files\Nuance\NaturallySpeaking12\Program\natspeak.exe” /Se-

tDefaultAdministrativeOptions

(The quotation marks are required because Program Files contains a space. Your path might

not require quotation marks.)

5. Click OK.

6. When the Administrative Settings dialog box opens, if the User Profile opens automatically,

click Cancel to close the User Profile or go to the DragonBar and select Profile > Close

User Profile.

7. Click theMiscellaneous tab.
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8. In the Data distribution location text box, click Change... and browse to a location where

you want Dragon to store custom words and commands.

9. Click OK.

10. Click Apply to save the changes.

11. Click OK to close the dialog box.

You can now use the Data Distribution Tool or the nsadmin command line utility to put new

words and commands into the data distribution directory. For more information, see Starting the

Data Distribution Tool or Starting the nsadmin command line utility.

Starting the Data Distribution Tool

You can use the Data Distribution Tool to make new words, customized vocabularies, or new

commands available to all Dragon end-users on a particular installation of Dragon.

You can run the Data Distribution Tool on a local computer or through a network connection.

The tool supports both mapped drives and UNC paths.

Start the Data Distribution Tool

Adding and removing custom words

You can use the Data Distribution Tool to make new words available to all end-users on a par-

ticular installation of Dragon.

Before you use the Data Distribution Tool, you must create a data distribution directory. For

more information, see Creating the Data Distribution Directory.

You must first either create a text file or export words from an existing end-user's installation of

Dragon before you can distribute the words (for example, a list of new drug names) to a different

installation of Dragon.

After you use the nsadmin utility to import the custom words, you must close your User Pro-

files, re-open the User Profiles, and save them for the changes to become available.

Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a par-

ticular installation of Dragon:

Create a text file that contains custom words
1. Create a text file.

2. In the text file, add each word or phrase that you want to add to the vocabulary. Make sure each

word or phrase uses correct spelling and is on a separate line.

l To add a multiple-word phrase, such as "Mayberry Tribune", type it on one line.
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l To include a spoken form of a word, type the word followed by a backslash (\) and the

spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy"when you

say "RFK", type Robert F. Kennedy\RFK in the text file.

Create a text file that contains custom words
1. If you have Dragon available on another computer, you can use it to create custom words and

export the words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin, you can enter paths as complete local paths, relative paths, mapped net-

work drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP drive. For

more information, see Using paths with nsadmin.

You must create a .txt file (newwords.txt in the following examples) that contains custom words

before you perform the following steps. For more information, see "Create a text file that contains

custom words" above.

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that an end-user uses for dictation, map a network drive to the location of

the data distribution directory. As an alternative, you may reference the network UNC address

of the location of the nsadmin utility.

3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

4. In the Data Distribution Tool, make the appropriate selections to add the list of words to the

data distribution directory. For more information, see Use the Data Distribution Tool to add

custom words.

Use the Data Distribution Tool to add custom words

If you add custom words to a Commands Only vocabulary, when you upgrade a User Profile,

the upgrade process does not retain the custom words. In general, you should not add custom

words to a Commands Only vocabulary.

1. On the Data Distribution Tool, select Add or remove words to share across vocabularies.

2. (optional) To choose a location for the custom words on the local computer, click Advanced.

In the Custom directory text box of the Advanced Settings dialog box, type the path to the

new location for the custom words. If you do not take this step, Dragon copies the files to the

following default location (in Windows XP):
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking12\Custom\enx

See Dragon file structure for information on default locations on Windows 7 and other oper-

ating systems.

3. Click Next.

4. Associate a language with the custom words.
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5. Click Next.

6. When the list of files appears, use the Import button to select the .txt files that contain custom

words. To view the content of a file, select the file and click View. To remove a file from the

list of files, select the file and click Remove. To remove all files from the list, click Remove

All.

Note: Once you add a text file that contains custom words to the data distribution directory,

and an end-user opens the profile, you cannot use the Remove and Remove All buttons to

remove the custom words.

7. Click Next. The Data Distribution Tool displays a log of the operations it performs.

8. Click Finish to re-display the first page of the Data Distribution Tool or click Cancel to exit.

Adding and removing custom vocabularies

You can use the Data Distribution Tool to make a customized vocabulary available to all end-

users on a particular installation of Dragon. For example, you can use the Data Distribution Tool

to copy a User Profile's vocabulary and set it as the base vocabulary on any installation of Dragon.

After you add a base vocabulary to an installation of Dragon, new User Profiles you create can use

that vocabulary.

Notes
n The default installation of Dragon places vocabularies for existing Dragon User Profiles here (in

Windows XP). See Dragon file structure for information on Windows 7 and other operating

systems.
\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking12\users\<user_name>\current

n Vocabulary files end with the *.voc extension.

n You cannot use a custom vocabulary created in Dragon 10.x or earlier with Dragon

NaturallySpeaking . You must recreate the custom vocabulary in Dragon NaturallySpeaking . If

you have a custom vocabulary from a Nuance VAR, you should contact the VAR to obtain a

new version of the vocabulary.

n If you create a User Profile on a dual core computer that uses a custom vocabulary, make sure

that the User Profile uses the BestMatch IV speech model (BestMatch IV has the greatest

recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select

the Advance button on the Create User Profile screen of the Creating a Profile wizard and make

sure that BestMatch IV is selected.

Prepare to use the Data Distribution Tool to add a
vocabulary

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that an end-user uses for dictation, map a network drive to the network loca-

tion of the data distribution directory.
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3. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

4. In the Data Distribution Tool, add the vocabulary to the data distribution directory. For more

information, see "Use the Data Distribution Tool to add a vocabulary" below.

Use the Data Distribution Tool to add a vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next.

3. Click Add to add a Base Vocabulary. Dragon displays the Add Base Vocabulary dialog.

4. In the Add Base Vocabulary dialog box:
n Give the vocabulary a name. The name should describe the content of the

vocabulary, such as Astronomy orMarketing.

n Select the location of the vocabulary, either a mapped drive or a UNC address.

n Give the vocabulary a unique numeric ID. Use a value greater than 9000 for the

topic ID parameter.

5. Click OK.

The next time you open a User Profile, Dragon automatically updates the User Profile's vocabulary.

Use the Data Distribution Tool to add an exported
vocabulary

You can use the Data Distribution Tool to distribute a vocabulary that you create using a sep-

arate installation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where

* is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument

to the nsadmin utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large |
Nuance" 9005

Use the Data Distribution Tool to remove a base
vocabulary

1. In the Data Distribution Tool, select Add or remove base vocabulary.

2. Click Next. Dragon displays the existing base vocabularies by ID and username.

3. Select the vocabulary to delete.

4. Click Remove and then click Next. The Data Distribution Tool displays a message when the

vocabulary is deleted.

315



Dragon 12 Administrator Guide

5. Click Finish to close the Data Distribution Tool or click your browser's back button to re-dis-

play the screen.

Adding and removing custom commands

Custom commands are voice commands that you can create and modify to enter text, insert graph-

ics, or activate menus and keystrokes in any application. You can use theMyCommands Editor

to create custom commands or the Command Browser to modify custom commands. 

You can use the Data Distribution Tool to copy a set of custom commands to the data dis-

tribution directory and make the set of custom commands available to all end-users at a particular

installation of Dragon.

Before you use the Data Distribution Tool, you must have already created a data distribution

directory, as explained in Creating the Data Distribution Directory.

Notes:

n The default installation of Dragon places custom commands for existing Dragon User Profiles

here (in Windows XP). See Dragon file structure for information on Windows 7 and other

operating systems.
\Documents and Settings\All Users\Application

Data\Nuance\NaturallySpeaking12\Custom\<language>

n After you import the custom commands to Dragon, for the changes to become available to those

User Profiles, you must close your User Profiles, then re-open and save the User Profiles.

n You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC

path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information,

see Using paths with nsadmin.

Prepare to use the Data Distribution Tool to export
custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-

Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

4. On each computer that an end-user uses for dictation, use the Data Distribution Tool to add

the .dat file to the data distribution directory. For more information, see Adding custom com-

mands.
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Use the Data Distribution Tool to add custom
commands

1. Start the Data Distribution Tool. For more information, see Starting the Data Distribution

Tool.

2. In the Data Distribution Tool, select Add or remove shared commands .

3. Click Next.

4. Select the languages for the User Profiles that you will add custom words to.

5. Click Next.

6. Use the Import button to select the .dat files that contain the custom commands to add. Place

the .dat files into the New shared commands list in the upper half of the dialog box. You can

modify the list by selecting particular file names and using the Remove and Remove All but-

tons.

7. Click Next. The Data Distribution Tool displays a log of all the operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.

The next time you open a User Profile, Dragon updates the commands in the associated User

Profiles. 

Use the Data Distribution Tool to remove shared
commands

1. In the Data Distribution Tool, select Add or remove shared commands.

2. Click Next.

3. Select the languages for the User Profiles that you will remove words from.

4. Click Next.

5. In the Existing shared commands list, select the command.

6. Click Remove.

7. Click Next. The Data Distribution Tool displays a log of all operations it performs.

8. Click Finish to re-display the Data Distribution Tool main screen or click Cancel to exit.
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The Nsadmin utility for new
words, vocabularies, and
commands

Dragon Professional and Dragon Legal include the nsadmin utility. The nsadmin utility is a com-

mand line utility that lets you make new words, customized vocabularies, and new commands

available to all end-users on a particular installation of Dragon.

The nsadmin utility performs only one operation at a time. You can write a batch file or script to

execute multiple nsadmin operations on each computer.

For step-by-step instructions on using the nsadmin utility, see the following topics:

n Creating the Data Distribution Directory

n Starting the nsadmin command line utility

n Adding custom words from a command line

n Adding and removing custom vocabularies from a command line

n Adding custom commands from a command line

You can use the Data Distribution Tool to run the nsadmin utility from a GUI. For more infor-

mation, see Starting the Data Distribution Tool.

Starting the nsadmin command line utility

You can use the nsadmin utility on a command line to make new words, vocabularies, or com-

mands available to end-users.

The nsadmin utility performs only one operation at a time. However, you can write a batch file

or script to execute multiple nsadmin operations on a computer. You can place the network loca-

tion of new words or vocabularies in a script and run the script from a client computer to copy the

new functionality to the computer.

You can find the nsadmin.exe file in the \Program directory under the parent Dragon instal-

lation directory. The default installation directory for Dragon is

C:\Program Files\Nuance\NaturallySpeaking12\Program.

The nsadmin utility supports both mapped drives and UNC paths. For more information, see

Using paths with nsadmin.

Before you can use the nsadmin utility, you must create a data distribution directory. For more

information, see Creating the Data Distribution Directory.
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Start the nsadmin utility

n Select Start > All Programs > Dragon NaturallySpeaking 12.0 > Dragon

NaturallySpeaking Tools > NSAdmin .

The nsadmin utility starts in a DOS window and lists the nsadmin syntax.

Display help information for the nsadmin utility

1. From a command prompt, type nsadmin/?

Command line syntax for the nsadmin utility

The nsadmin.exe utility uses the following syntax.

nsadmin <operation> <parameters> [options]

Commands and parameters Description

/commands <src_filename> Adds a command file to the local installation of Dragon.

/words <src_filename> Adds a list of new words to the local installation of Dragon.

/vocabulary delete <topic ID> Deletes the base vocabulary specified by <topic ID>.

Options

/language enx | fra | deu | ita | esp
| nld

Specifies an installed language that you want to addwords, com-
mands, or a vocabulary to. The default value is "enx".

/? Displays the command syntax.

/overwrite yes | no | ask Specifies overwrite rules if a file exists with the same name as the
file you are adding. The default value is ask.

Adding custom words from a command line

You can use the nsadmin utility to make new words available to all User Profiles on a particular

installation of Dragon.

You must first either create a text file or export words from an existing User Profile's installation

of Dragon before you can distribute the words (for example, a list of new drug names) to a dif-

ferent installation of Dragon.

After you use the nsadmin utility to import the custom words, for the changes to become avail-

able, you must close your User Profiles, re-open the User Profiles, and save them.
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Create a text file that contains custom words

Perform one of the following two actions before you distribute a set of custom words to a par-

ticular installation of Dragon:

Create a text file that contains custom words
1. Create a text file.

2. In the text file, add each word of phrase that you want to add to the vocabulary. Make sure each

word or phrase uses correct spelling and is a on a separate line.

l To add a multiple-word phrase, such "Mayberry Tribune", type it on one line.

l To include a spoken form of a word, type the word followed by a backslash (\) and the

spoken form of a word. For example, to have Dragon enter "Robert F. Kennedy"when you

say "RFK", type Robert F. Kennedy\RFK in the text file.

Export words from a Dragon installation

If you have Dragon available on another computer, you can use it to create custom words and

export the words to a .txt file. For more information, see the main Dragon Help file.

Add custom words to a shared location

When you use nsadmin utility, you can enter paths as complete local paths, relative paths,

mapped network drives, a UNC path, or the path to removable media such as a CD-ROM or ZIP

drive. For more information, see Using paths with nsadmin.

Perform the following steps after you create a text file that contains custom words or after you

export words from an installation of Dragon:

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory on page 311.

2. On each computer that an end-user uses for dictation, map a network drive to the location of

the data distribution directory. As an alternative, you may reference the network UNC address

of the location of the nsadmin utility.

3. In a command prompt, type a command to add the custom words from the .txt file. The fol-

lowing command copies the NewWords.txt file to the following directory:
C:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\Custom\enx\NewWords.txt.

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt

The next time you open a User Profile, Dragon automatically updates the User Profile's words to

include the words from the .txt file.

Use the command line to overwrite a custom word file

1. Use the /overwrite option to overwrite an existing custom word file. In Windows XP, if the

custom word file already exists in the\Documents and Settings\All Users\Application
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Data\Nuance\NaturallySpeaking12\Custom\enx directory, Dragon overwrites it without
prompting you. See Dragon file structure for information on default locations on Windows 7

and other operating systems.

The following command overwrites the NewWords.txt custom word file:

<PATH>\nsadmin /words G:\NsAdmin\NewWords.txt /overwrite=yes

Note:

If you add custom words to a Commands Only vocabulary, Dragon does not retain those words

if you upgrade the User Profile at a later date. In general, you should not add custom words to a

Commands Only vocabulary.

Adding and removing custom vocabularies from a command line

You can use the nsadmin to make a customized vocabulary available to all end-users on a par-

ticular installation of Dragon. For example, you can use the nsadmin utility to copy a User Pro-

file's vocabulary and set it as the base vocabulary on any installation of Dragon. After you add a

base vocabulary to an installation of Dragon, new User Profiles you create can use that vocabulary.

The nsadmin command uses the following syntax:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model
name> | <category>" <topic_ID>

Parameters Description

<language or
dialect>

Links a vocabulary to a language. For example, US English or UK Eng-
lish for an English install

The language or dialect must exist in the version of Dragon on the com-
puter.

<model_name> Specifies the size of the vocabulary you are importing.

<category> Describes the content of the vocabulary, for example, Astronomy orMarketing.

<topic_ID> Sets an ID for a topic.

The following nsadmin command copies the model name (Large), the category (Nuance), and the

topic ID (9005) to the models.ini file and copies the contents of the myvoc directory to
\Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-

urallySpeaking12\Custom\enx\Custom9005\.

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large |
Nuance" 9005

Notes:

The default installation of Dragon installs vocabularies for existing Dragon User Profiles in the fol-

lowing directory (in Windows XP). See Dragon file structure for information on default locations

on Windows 7 and other operating systems.
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\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\users\<user_name>\current

n Vocabulary files have a *.voc file extension.

n You cannot use a custom vocabulary created in Dragon 10.x or earlier with Dragon

NaturallySpeaking . You must recreate the custom vocabulary in Dragon NaturallySpeaking . If

you have a custom vocabulary from a Nuance VAR, you should contact the VAR to obtain a

new version of the vocabulary.

n If you create a User Profile on a dual core computer that uses a custom vocabulary, make sure

that the User Profile uses the BestMatch IV speech model (BestMatch IV has the greatest

recognition accuracy on dual-core systems with more than 2 GB of RAM). To check this, select

the Advance button on the Create User Profile screen of the Creating a Profile wizard and make

sure that BestMatch IV is selected.

Prepare to use the command line to add a vocabulary

1. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

2. On each computer that an end-user uses for dictation, in a command prompt, start the nsadmin

utility and use it to add the vocabulary to the data distribution directory. Make sure to reference

the network UNC address of the computer in the command. Use the following syntax for the

command:

<PATH>\nsadmin /vocabulary <directory> "<language or dialect> | <model
name> | <category>" <topic_ID>

The next time you open a User Profile, Dragon automatically updates the User Profile's vocab-
ularies. For more information on using the nsadmin utility, see Starting the nsadmin command line
utility.

Use the command line to overwrite a vocabulary

1. Use the /overwrite option to overwrite an existing vocabulary file. If the vocabulary file already

exists in \Documents and Settings\All Users\Application Data\Nuance\Dragon Nat-
urallySpeaking12\Custom\enx\Custom9005\, Dragon overwrites it without prompting you.

The following command overwrites the myvoc topic:

<PATH>\nsadmin /vocabulary G:\NsAdmin\myvoc "US English | Large |
Nuance" 9005 /overwrite=yes
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Use the command line to add an exported vocabulary

You can use the nsadmin utility to distribute a vocabulary that you create using a separate instal-

lation of Dragon. A Dragon vocabulary that you export saves as a group of files.

One of the exported files has a .top file extension, the other files have .to* file extensions, where

* is an integer.

1. In a command prompt, provide the path to the file with the .top file extension as an argument

to the nsadmin utility. Do NOT include the .top file extension on the command line.

The following command adds the myvoc exported topic (myvoc.top) as a new base vocabulary:

<PATH>\nsadmin /vocabulary D:\MyDocuments\myvoc "US English | Large |
Nuance" 9005

Use the command line to remove a base vocabulary

1. On each client computer, in a command prompt, enter a command to delete the vocabulary and

the corresponding entry inmodels.ini. You cannot use vocabularies that are based on a base

vocabulary you delete. Use the following syntax:

<PATH>\nsadmin /vocabulary delete <topic_ID>

The following nsadmin utility command deletes a vocabulary with a topic id of 9005:

<PATH>\nsadmin /vocabulary delete 9005

Adding custom commands from a command line

Custom commands are voice commands that you can create and modify to enter text, insert graph-

ics, or activate menus and keystrokes in any application. You can use theMyCommands Editor

to create custom commands or the Command Browser to modify custom commands. 

You can use the nsadmin utility to copy a set of custom commands to the data distribution direc-

tory and make the set of custom commands available to all end-users of a particular installation of

Dragon

Before you use the nsadmin utility, you must have already created a data distribution directory, as

explained in Creating the Data Distribution Directory.

Notes:

n The default installation of Dragon places custom commands for existing Dragon User Profiles

here:
\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking12\Custom\<language>

323



Dragon 12 Administrator Guide

n After you import the custom commands to Dragon, for the changes to become available to those

User Profiles, you must close your User Profiles, then re-open the User Profiles, and save the

User Profiles.

n You can enter a path as a complete local path, a relative path, a mapped network drive, a UNC

path, or the path to removable media, such as a DVD, CD, or ZIP drive. For more information,

see Using paths with nsadmin.

Use the command line to add custom commands

1. In Dragon, create custom commands.

2. Use the Command Browser to export the custom commands to a .dat file, for example, New-

Commands.dat.

3. If you have not already created it, create the data distribution directory. For more information,

see Creating the Data Distribution Directory.

4. On each computer that an end-user uses for dictation, in a command prompt, type a command

line using the following syntax, to add the custom commands from the .dat file. In the com-

mand, reference the network address of the data distribution directory in the command:

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat

The next time you open a User Profile, Dragon updates the commands in the User Profiles for the end-

user.

Use the command line to add custom commands to a language
other than English

Use the /language option to associate commands with a non-English language.

The following command associates the NewCommands.dat file with the language of French.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /language=fra

Use the command line to overwrite a custom command file

Use the /overwrite option to overwrite an existing command file.

The following command overwrites the NewCommands.dat file if it already exists in the

G:\NsAdmin directory. Dragon overwrites the file without prompting you.

<PATH>\nsadmin /commands G:\NsAdmin\NewCommands.dat /overwrite=yes
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Using paths with the nsadmin utility
When you use the nsadmin utility, you can use a path that is a complete local path, a relative

path, a mapped network drive, a UNC path, or the path to removable media, such as a DVD, CD,

or ZIP drive. If a path name includes spaces, you must enclose the path name in quotation marks.

When you are running the nsadmin utility from a directory other than the one nsadmin resides

in, you must provide the full path to the nsadmin.exe program on the command line.

The following command copies the NewCommands.dat file to the following directory:
<drive>:\Documents and Settings\All Users\Application Data\N-

uance\NaturallySpeaking12\Custom\enx\NewCommands.dat.

 <PATH>\nsadmin /commands \\HostComputer\NsAdmin\NewCommands.dat
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This section contains information on the tools and procedures you can use to maintain Dragon instal-
lations, including User Profiles and vocabularies. You can also view information on resources that can
help you trouble shoot issues that may occur in Dragon.
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Maintaining Installations
There are several actions you can take to maintain your Dragon NaturallySpeaking installation:

n Run the Acoustic and Language Model Optimizer and schedule the Optimizer to run

automatically (see Using Acoustic and Language Model Optimizer and Scheduler Tools ).

n Export User Profiles from one computer and import them to another as outlined in Exporting

and Importing User Profiles.

n Work with the Dragon.log file to determine the cause of error messages (see Handling Dragon

Error Messages).

n Work with a Usability log file—create a usability log (DgnUsability.log) by pressing

the Advanced button on the Data tab of the Options dialog box. For more information, see

Working with the Usability Log.

n Work with the Dragon knowledge base as outlined under Accessing Dragon Knowledge

Database.

n Work with the hardware compatibility list (see Hardware Compatibility List)

n Manage who has administrative privileges (see Managing Who Has Administrative Privileges).
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Using Acoustic and Language Model
Optimizer and Scheduler Tools

You run Acoustic and Language Model Optimizer Scheduler to:

n Choose to optimize the acoustic files for the User Profile

n Choose to optimize the language model for the User Profile

n Schedule one or both types of optimization to occur on a particular day or time at particular

intervals

n Enable or disable the scheduled optimizations

n Separate procedures exist for running the optimization on a Non-Roaming User Profile (see

Running Acoustic and Language Model Optimizer on Non-Roaming User Profiles) or a

Roaming User Profile (see Running Acoustic and Language Model Optimizer on Roaming User Profiles

on page 331).

Checking the optimization status of a User Profile
Dragon NaturallySpeaking checks the optimization status of a User Profile when:

n Dragon creates a User Profile and loads the profile

n Dragon loads a User Profile one week after its creation and the "Learn from" wizards have not

run for the profile

n Dragon loads a User Profile and the "Learn from" wizards have not run for six months

n The Language Model Optimizer has not run in over two months

n The Acoustic Optimizer has never run and at least 1 hour worth of DRA data is available

See the Dragon Help for details.

Keeping custom words up-to-date

Using Dragon’s support for custom words, especially contact names, can make communicating

with Dragon faster and more precise. To facilitate this, when Dragon loads a User Profile, Dragon

examines how long it has been since the last time custom words where updated. If required,

Dragon displays the Personalize Your Vocabulary dialog box to step the end-user through the

custom word update process.

The Personalize Your Vocabulary dialog box contains information about the last time the

"Learn from specific document” wizard and the “Learn from sent e-mails” wizard ran for the pro-

file. The dialog also displays the total time required to run the wizards.

Users can run both the "Learn from specific document” wizard and the “Learn from sent e-mails”

wizard from the dialog.

Dragon displays the Personalize Your Vocabulary dialog box:

n Two days after creating a User Profile if the "Learn from" wizards have not run for the profile

n Once a week after not running a "Learn from" wizard for 1 month or if the end-user pressed

cancel the first time Dragon displays the Personalize Your Vocabulary dialog box:
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Checking for User Profile maintenance when saving a User Profile

When an end-user saves a User Profile or closes Dragon, Dragon checks to make sure that sched-

uled language model User Profile maintenance has been performed recently. If not, then an addi-

tional check box will appear on the Save dialog. The maintenance should only take an extra

minute or two complete and is always beneficial – especially when new custom words have been

added.

Running Acoustic and Language Model Optimizer on
Non-Roaming User Profiles
An open local end-user cannot run the optimizer tools on User Profiles. Only an administrator can

run the Acoustic and Language Model Optimizer or the associated Scheduler tools. You

must have Windows Administrator privileges (at the operating system level) on the computer

where you are running the Scheduler. If you want to optimize a Roaming User Profile on the

computer where you are running the Acoustic and Language Model Optimizer, disable roaming

and browse to the Master Roaming User Profile location as if it were local.

As system administrator, you are responsible for running the Acoustic and Language Model

Optimizer on the network location of the Master Roaming User Profiles. You can install Dragon

on the computer where the Master Roaming User Profiles are located or on any computer that has

network access to the Master Roaming User Profiles, then run the Scheduler. Later, any opti-

mizations that result from running these tools are copied to the Local Roaming User Profile when

Dragon synchronizes it with the Master Roaming User Profile.

You can run the Acoustic and Language Model Optimizer from the Windows Start menu

without opening a User Profile, or you can run it from the DragonBar using the Tools menu

when a User Profile is open as indicated here.

Select Start > All Programs > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler.

Running the Acoustic and Language Model
Optimizer on a multi-core computer
If a non-Roaming User Profile with a BestMatch IV speech model is created and used on a multi-

core computer, when an administrator runs the Acoustic and Language Model Optimizer on that

profile on a single-core computer, all accuracy improvements may not be applied to the profile.

The Acoustic model will revert to a single model. When an end-user opens the profile on a multi-

core computer, only the first acoustic model will load.

To increase the accuracy of the User Profile, select Audio > Launch Accuracy Tuning from

the DragonBar.

To make sure that corrections and accuracy improvements that end-users make are applied to their

non-Roaming User Profile, an end-user should run the Acoustic and Language Model Optimizer

on non-Roaming User Profiles only on a multi-core computer.
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To run the acoustic and language model optimizers
on non-Roaming User Profiles:
1. On the DragonBar, select Profile > Open User Profile.

2. In the Open User Profile dialog box, select a User Profile to run the optimization on and click

Open.

3. On the DragonBar, select Help > Improve my accuracy. The Accuracy Center opens.

4. Click Launch Accuracy Tuning now. The Acoustic and Language Model Optimizer

dialog box opens.

5. If the end-user has not dictated and corrected recognized text since the last time the optimizer

was run, you receive this message: There is no new data in the acoustic archive. Acoustic

Optimizer does not need to be rerun. Click OK and the Acoustic and Language Model

Optimizer opens with the Perform Acoustic Optimization option grayed out.

6. Check the types of optimization you want to perform, Perform Acoustic Optimization (to

optimize the acoustic files of the User Profile), Perform Language Model Optimization (to

optimize the language model of the User Profile), or both.

7. Click Go to start the process. The process may take some time to complete. When the process

completes, you receive a message notifying you that it has completed.

8. Click Done.

9. When asked if you would like to save your User Profiles click Yes to return to the Accuracy

Center. Click Exit in the Accuracy Center dialog box.

Running Acoustic and Language Model Optimizer on
Roaming User Profiles
To run the Acoustic and Language Model Optimizer on Roaming User Profiles:

1. Be sure that a copy of Dragon is installed on the computer where you plan to run the Acoustic

and Language Model Optimizer.

2. Select Start > All Programs > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking Tools > Acoustic and Language Model Optimizer Scheduler. The

Acoustic and Language Model Optimizer Scheduler dialog box opens.

3. To access the master directory of the Roaming User Profiles you want to optimize, in the

Acoustic and Language Model Optimizer Scheduler dialog box, select File > Set User

Directory. The Set a Directory Containing User Files dialog box opens.

4. On the Set a Directory Containing User Files dialog box, either enter the path to the direc-

tory or click the Browse button and browse to the location of theMaster Roaming User Pro-

files, then click OK. If the User Profiles you want to optimize are located in multiple

directories, you can later repeat the steps outlined here and change this directory to locate the

additional User Profiles.

5. In the tree of User Profiles, select the User Profile you want to optimize. Notice that if you

expand that User Profile in the tree, you see one or more dictation sources under the Acoustic

Optimization tasks in the tree. You also see the vocabulary of the User Profile under the
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Language Model Optimization tasks.

OR

Select File > New Task. The Windows user name and password dialog box opens. To set a

schedule for running the Acoustic and Language Model Optimizer, either double-click on

the dictation source or the language model under that User Profile.

6. Before you proceed, enter your Windows user name and password. If you are logged in to a

domain, you must insert the domain name in front of your user name; for example, Hos-

pitalDB\RSessions for the HospitalDB domain.

7. Click OK. The Select Frequency dialog box opens.

8. UnderOptimization, select Perform Acoustic Optimization, Perform Language Model

Optimization, or both.

9. Under User Information, you can either select another User Profile from the User Name

drop-down list or, to select multiple User Profiles, click theMultiple Users button to open

the Select User Profiles dialog box.
In the Select User Profiles dialog box, use the Add> and <Remove buttons to put the User

Profiles you want to run optimization on in the Selected end-users in this task list to the right.

Or you can click Add All>> or <<Remove All to add or remove all User Profiles from the list.

You can also move a User Profile up and down in the list by selecting a name and clicking the

Move Up orMove Down button. When you are satisfied with the list, click OK to proceed.

10. If you selected multiple User Profiles in the previous step, skip this step. Otherwise, in the Dic-

tation Source text box, select an audio input device from the drop-down list and in the Vocab-

ulary text box, select a vocabulary from the drop-down list.

11. Under Select Frequency and Start Date & Time, select how often and at what time you

want the optimization to run, as well as the first date it should run.

12. At the bottom of the dialog, click the Enabled (schedule task runs at specified time) check box

to enable the optimization.

13. Click Apply to apply the changes.

14. Click OK to close the Select Frequency dialog box. The Acoustic and Language Model

Optimizer Scheduler dialog box displays a list of the events scheduled in the right pane of its

dialog box. You can create more than one optimization schedule for a single User Profile. When

you do, both optimization events appear in the schedule list.

15. Click Files > Exit to close the acoustic and language model optimizer scheduler
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Removing One or More Optimization
Schedules

To remove one or more scheduled optimizations from the scheduler:

1. Select the schedule you want to remove. You can select multiple schedules by holding the

CTRL key while clicking a schedule.

2. Press the Delete key on your keyboard or select Options > Delete Selected Tasks on the

toolbar.

3. Click OK when you are asked to confirm the deletion.
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Exporting and Importing User Profiles
You can export User Profiles on one computer and import them for use on another.

When you export a User Profile to a new location, any custom words added to a Local Roaming

User Profile do not accompany the User Profiles unless you first run the Learn from specific

documents wizard in the Accuracy Center .

Exporting User Profiles
To export User Profiles from Dragon:

1. On the DragonBar, select Profile >Manage User Profiles.

2. TheManage User Profiles dialog box opens.

3. Select the User Profile in the list that you want to export.

4. Click the Advanced button and select Export from the menu that appears.

5. When the Browse For Folder dialog box opens, navigate to the folder where you want to store

the exported User Profile (or create a new folder by clicking theMake New Folder button)

and click OK.

6. When a dialog box opens displaying a message indicating the export was successful, click OK.

7. Repeat steps 3 through 6 for each set of User Profiles you want to export.

8. Click Close to close theManage User Profiles dialog box.

9. In the operating system, navigate to the directory where you exported the User Profiles. In that

directory you find a separate folder for each exported User Profile, labeled with the user name.

Importing User Profiles
To import User Profiles into Dragon that you previously exported on a different computer:

1. On the DragonBar, select Profile >Manage User Profiles. TheManage User Profiles

dialog box opens.

2. Click the Advanced button and select Import from the menu.

3. When the Browse For Folder dialog box opens, navigate to the folder to retrieve a set of

exported User Profiles from.

4. Select the folder in that directory that has the name of the User Profile to import and click OK.

5. If the User Profile already exists aUser already exists dialog box opens and asks you to

choose how to proceed: Overwrite the existing user or Import the user with an alternate

name. If you choose to import the User Profile and assign it another name, enter the name in

the text box provided and click OK.

6. Repeat steps 2 through 5 for each end-user whose User Profiles you want to import.

7. Click Close to close theManage User Profiles dialog box.
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Backing up and restoring a User
Profile

If Dragon is unable to open your User Profile, click Launch Restore to open a backup copy of

the profile.See the Dragon Help for details.

Dragon automatically creates a full User Profile backup

n after you first create your profile

n if you add a new vocabulary to your profile

n every 5th time* your profile is saved

* Backup frequency is configurable in the Options dialog boxData tab.

Dragon displays the "Dragon couldn't restore backup" message if any of the component files in a

backed up User Profile are damaged or inaccessible. Data corruption can occasionally occur when

Dragon loads or manipulates files, and files can be temporarily inaccessible when they are in use

by another process, such as during a save operation over a network or analysis by anti-virus soft-

ware.

Users can backup and restore a User Profile. The Profile Restore wizard allows end-users to

choose restore a profile from a checkpoint or a backup copy.

Dragon displays the Profile Restore wizard when it cannot load a User Profile. End-users can also

launch the Profile Restore wizard through theManage User Profiles dialog box. .

Dragon places corrupt profiles in to the 'BadUsers' directory located beside the 'Users' directory.

To back up a User Profile:

1. On the DragonBar, select Profile >Manage User Profiles.

2. TheManage User Profiles dialog box opens.

3. Select a User Profile in the list.

4. Click the Advanced button and select Backup.

5. Repeat steps 3 and 4 for every profile you want to back up.

6. Click Close to close theManage User Profiles dialog box.

or

n Select Profile > Backup User Profile.

To restore a User Profile:

1. Click Launch Restore. Dragon opens the Choose a Backup to Restore window.

2. Choose the backup User Profile you want to restore from. When you backup profile opens, you

can resume dictating as usual.

or
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1. On the DragonBar, select Profile >Manage User Profiles.

2. TheManage User Profiles dialog box opens.

3. Click the Advanced button and select Restore.

4. When the Profile Restore dialog box opens, select a profile.

5. Click Restore.

6. Click Yes to confirm the restore or click No to cancel the action.

7. Repeat steps 4 and 6 for each profile you want to restore.

8. Click Close to close theManage User Profiles dialog box.

or

n Select Profile > Restore User Profile.
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Handling Dragon Error Messages
When Dragon displays an error message:

1. Read the message carefully. It may give you enough information to determine what to do.

2. If you dictated text into your document, click Close to close the error message box and then

save your document.

3. Do not save your User Profiles.

4. Copy the error message log file (Dragon.log) to a safe place. To locate this file, click Start >

Programs > Dragon NaturallySpeaking 12.0 > Show Dragon Log. In Windows XP, this

file is normally located in the C:\Documents and Settings\<username>\Application
Data\Nuance\NaturallySpeaking12 folder.
In Windows Vista, Windows 7, and Windows Server 2008, the file is normally located in:

C:\Users\<username>\AppData\Roaming\Nuance\NaturallySpeaking12.

Technical Support may ask you to send this file for further study.

5. Exit Dragon and start it again. In some cases it may be necessary to restart your computer.

6. Insert your Dragon DVD into your DVD reader, run the installation program again, and choose

the Repair option on the first screen of the Dragon setup program. After setup finishes, reinstall

any Dragon patches that were previously installed.

7. If the error message does not provide enough information to determine what to do, search our

Web site for information on the error message. You may find a solution that can save you time

and trouble:
http://www.nuance.com/product-support/default.asp?

lang=us&prod=dn

337

http://www.nuance.com/product-support/default.asp?lang=us&prod=dn
http://www.nuance.com/product-support/default.asp?lang=us&prod=dn
http://www.nuance.com/product-support/default.asp?lang=us&prod=dn


Dragon 12 Administrator Guide

Working with the Usability Log
In Dragon NaturallySpeaking, you can set up Dragon to create a usability log that logs all menu

commands, toolbar buttons, and voice commands that you use during a dictation session.

To set up a usability log:

1. With a User Profile open, on the DragonBar, select Tools > Options.

2. Click the Data tab.

3. Click the Advanced button.

4. When the Advanced dialog box opens, check the Create usability log check box and click

OK to return to the Data tab.

5. Click Applyand then click OK to close the Data tab of the Options dialog box.

Later, you can find the log under (in Windows XP) C:\Documents and Set-
tings\<username>\Application Data\Nuance\NaturallySpeaking12.

See Dragon file structure for information on default locations on Windows 7 and other operating

systems.
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Accessing the Dragon Knowledge
Database

Solutions to known problems with Dragon are provided at the Nuance Knowledge Base, located at

http://nuance.custhelp.com/.

If there are problems using Dragon with Microsoft Word on Windows XP (for example if the pro-

gram freezes or commands stop working in a Microsoft Office XP application), it may be that the

Microsoft Word XP’s built-in speech recognition is interfering with Dragon.

1. In the Search by Product drop-down list, select Dragon NaturallySpeaking.
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Managing end-user administrative
privileges

Before You Give Windows Administrator Privileges

Before you decide to give a Dragon user Windows Administrator privileges on a laptop computer,

note that you are giving that person access to the Administrative Settings dialog box on that

computer.

Determining Logged In User Has Admin Privileges

If the logged in end-user has Windows Administrator privileges, the following line appears in the

Dragon.log file after he or she logs in:

09:33:10 LOG (MainWin): Windows user has administrative access to NatSpeak
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This section contains information on how you can use tools in Dragon to control access to your custom
commands.

Managing and Securing Custom Commands 342

Using the Convert XML to DAT tool 343

Using the MyCommands Protection Utility 345
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Managing and Securing Custom
Commands

Make your custom commands more secure in two ways:

To make the tool available only in Dragon NaturallySpeaking, convert any XML files of com-

mands to DAT format. For details see Using the Convert XML to DAT tool.

To prevent any Dragon end-users from editing the commands, lock access to the file. For details

see Using the MyCommands Protection Utility.
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Using the Convert XML to DAT tool

You can use a text editor to open commands that are in XML format. To allow only Dragon end-

user to access those command files, you can convert them from XML format to DAT format.

Dragon uses .dat files to store commands.

You can use the XML to DAT tool (mycmdsxml2dat.exe) to extract end-user-defined Dragon

commands from an XML file. The tool writes the commands to a .dat file. Use the nsadmin util-

ity or the Data Distribution Tool to make the new.dat files available to those other end-users.

Starting the Convert XML to DAT tool

n In Dragon NaturallySpeaking:

Start > All Programs > Dragon NaturallySpeaking 12.0 > Dragon Nat-

urallySpeaking Tools > Convert XML to DAT

The Convert XML to DAT tool starts in an MS-DOS window, listing the tool's syntax.

Convert XML to DAT syntax

Convert XML to DAT (mycmdsxml2dat.exe) uses the following syntax:

mycmdsxml2dat.exe <dat-file-path> <xml-file-path> [options]

Parameters Type Description

<dat-file-path> Required The full path to the local copy of the cur-

rent end-user's .DAT file

<xml-file-path> Required The full path to the .XML file

-v Optional Validates the specified .xml file over the

Internet with a Nuance DTD (Doc-

ument Type Definition) file. Disabled by

default.

Use the XML to DAT tool to convert data in an XML file

1. Create an XML file that contains the commands to use with Dragon.

2. On a command line, use mycmdsXML2DAT.exe to convert the XML file to DAT format.

3. Use the nsadmin utility or the Data Distribution Tool to copy the .dat file to the data dis-

tribution directory.
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The next time you open a User Profile, Dragon incorporates the new commands from the .dat file

into the User Profile.

For more information, see:

n Adding custom commands (nsadmin)

n Adding and removing custom commands (Data Distribution Tool)
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Using the MyCommands Protection
Utility

In Dragon Professional and higher, when you export a set of custom Text-and-Graphics, Step-by-

Step, Custom Command, and/or Advanced Scripting commands into a .dat file, you can set

the permissions on that file so that after an end-user imports them, that end-user can dictate the

commands but cannot view their source code, edit their source code, or re-export the commands.

As a result, the integrity of the commands remains intact.

To set the permissions on the .dat file of commands to protect the commands in this way:

1. Make a backup copy of the unprotected .dat file and store it in a secure location. You later use

that file to edit the commands, because once you protect the .dat file that you are distributing,

you cannot make the file available for editing again.

2. Select Start > Run and enter cmd into the Run dialog box.

3. Change directories to (In Windows XP)<drive letter>:\Documents and
Settings\<user name>\Application
Data\Nuance\NaturallySpeaking12\Custom\<language>

See Dragon file structure for information on default location on Windows 7 and other operating

systems.

4. Enter the following on the command line:

protectcmds.exe <dat-file-path> <vendor-name> [<vendor-contact-info>]

5. Once you press return, after an end-user imports these commands, if that end-user attempts to

edit any of them, the following message indicates that the commands cannot be edited:

The command was protected by <vendor-name>.

Please contact <vendor-contact-info> for more information.

In the Command Browser, the same message appears as the Preview Content in Script mode.

Once you have protected the file, you can put it into the Data Distribution directory for dis-

tribution to multiple User Profiles. For more information about distributing saved commands,

refer to Creating the Data Distribution Directory, then refer to one of the following topics about

distributing commands to multiple User Profiles by either:

n Using the Data Distribution Tool (Data Distribution Tool: Adding and removing custom

commands)

n Using the nsadmin command line tool (nsadmin: Adding custom commands)
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application state

This section contains information how to create and use structured commands that perform actions
based on the state of the application.

Using Structured Commands 348

Structured Command Samples 349

Importing Sample Structured Commands 351
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Using Structured Commands
Dragon NaturallySpeaking Professional, and Dragon Legal include an extension to Text-and-Graphics

commands that let you to set the values of variables in text blocks based on voice input.

You can create simple Text-and-Graphics commands with variables in theMy Commands

Editor without having to do extensive programming in Microsoft® VBA.

Application states

Structured commands let you control the action of a command based on the state of the appli-

cation. For example, if you assign a state to each field in a form, the same command can perform

different actions depending on which field is activated.

You can use Advanced Scripting methods to control the states within structured commands or

to set the initial state from a non-structured command. You can also create structured commands

that prompt the end-user to select values from a predefined list.

When the end-user speaks a command, the end-user is presented with a list of pre-defined values

for the command. Once the end-user selects a value, the value is inserted into the correct location

in the custom command.

Samples

Dragon includes several sample Text-and-Graphics commands with variables and sample structured

commands. You can import the samples into Dragon to use them as templates for your own com-

mands. The sample commands are fully commented.

For more information, see:

n Structured Commands Samples

n Importing Sample Commands

Methods

For more information on the methods used by the sample commands, refer to the following topics

in the Main Help file:

n Global Methods

l SetState

l GetState

n EngineControl Methods

l MyCommandsActiveState

l PromptValue
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Structured Command Samples
Dragon includes several sample Text-and-Graphics commands with variables and sample struc-

tured Advanced Scripting commands. You can import the samples into Dragon to use them as

templates for your own commands. The sample commands are fully commented.

Sample location

The sample commands are installed in (Windows XP):

\Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\Data\Enx\samplecommands

See Dragon file structure for information on default locations on Windows 7 and other operating

systems.

A shortcut to this directory is available on the Windows Start menu. To open this directory, click

Start > Programs > Dragon NaturallySpeaking 12.0 >MyCommands Samples.

Importing Sample Commands

You can import the samples into Dragon to use them as templates for your own commands. For

information, see Importing Sample Commands

Samples

The following samples are included with Dragon:

GroceryListSample_DragonPad

GroceryListSample_DragonPad.xml contains Advanced Scripting commands that simulate

an on-line grocery order form in DragonPad. It demonstrates how to set and change command

states, activating and deactivating various state structured commands, and how to use the com-

mand prompt. The "Prepare Grocery List" voice command displays the first section of a

grocery list in DragonPad and sets a command state. Each section of the grocery list is designed

to have a separate state. The "What's Available" voice command prompts the end-user with a

set of grocery list commands that are active in the given section.

GroceryListSample_WordPad

GroceryListSample_WordPad.xml contains Advanced Scripting commands similar to those

of GroceryListSample_DragonPad.xml. It demonstrates how to set and change command

states and to use the command prompt in WordPad and uses a different coding style. The "Pre-

pare Grocery List" voice command starts the grocery list in WordPad, activate the initial grocery

list state, and prompt the end-user with a set of grocery list commands that are active in the given
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state. To read more about this sample and its commands, refer to the code comments in the XML

file.

SampleBoilerPlate_ColonCancer

SampleBoilerPlate_ColonCancer.xml contains Advanced Scripting commands that dem-

onstrate how to use structured commands and the command prompt for boilerplate text. This sam-

ple is modeled after a colon cancer checklist and is designed to work in Microsoft Word 2003.

The "Colon Cancer Checklist" voice command displays the boilerplate text and takes the end-

user, field by field, through the checklist.

SampleBoilerPlate_EndoBiopsy

SampleBoilerPlate_EndoBiopsy.xml contains a single Advanced Scripting custom command

that demonstrates how to set up boilerplate text and use the command prompt to guide end-users

in filling the boilerplate text without using states. This sample is modeled after an endoscopic

biopsy report and is designed to work in Microsoft Word 2003. The "Prepare Endoscopic

Biopsy Gross Template" voice command displays the boilerplate text and takes the end-user,

field by field, through the report.

SampleTGV_Restaurant

SampleTGV_Restaurant.xml contains Text-and-Graphics and Advanced Scripting com-

mands that are used in DragonPad to simulate an ordering system for a Chinese and Japanese res-

taurant. This sample demonstrates how to set states for structured commands as well as how the

same commands can be used to produce different results in different states. Either the "Chinese

Restaurant" or "Japanese Restaurant" voice command starts the ordering system and acti-

vates the structured commands created for the given state. The "Exit Ordering System" voice

command ends the ordering session.

SetStateSample

SetStateSample.xml contains simple Text-and-Graphics commands that demonstrate how to

use variables and text formats and Advanced Scripting commands to set and unset a command

state. This sample is designed to work in DragonPad with the initial command "Sample Set

State".When the command executes, a command state is set forDragonPad and a simple

exchange of greetings is simulated between the end-user and the system. The end-user speaks the

greeting, such as. "Good Morning", and the system responds in bold red text. When the end-

user says "Good-bye", the exchange is terminated and the command state is unset.

SampleInjuryReport

SampleInjuryReport.xml together with SampleInjuryReport.dot demonstrates how structured

commands and Microsoft Word templates can be used together to create a voice-enabled form fill-

ing environment. The template is a mock injury report with several text and checkbox fields can

be filled using the commands included in the XML file. You start a form filling session by speak-

ing the "Edit Report" voice command in a new document based on the sample template. Both

the template and the commands are designed to work in Microsoft Word 2003.
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Importing Sample Structured
Commands

You can import existing structured commands, such as the Structured Commands Samples, into

Dragon to use as templates for your own commands. Use the following procedure to import the

sample structured commands that are supplied with Dragon:

To import the sample structured commands:
1. On the DragonBar , select Tools > Command Browser to open the Command Browser

window.

2. Click theManage button on the Command Browser toolbar.

3. In theManage area, click the Import button, and in the Import Commands window choose

MyCommands XML files from the Files of type list.

4. Use the Import Commands window to browse to (in Windows XP) the following

directory:Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\Data\Enx\samplecommands

See Dragon file structure for information on default locations on Windows 7 and other oper-

ating systems.

5. Select one of the sample .XML files (for example, sampletgv_restaurant.xml) and click

Open.

6. Click OK on the Import Commands validation dialog box and then click Import on the

Import Commands window to import the commands contained in the file.

7. Click OK on the success message and return to theManage area of the Command Browser.

Note: The syntax of XML command files is defined by a document type definition (DTD) file

that resides on the Nuance web site. When you import an XML command file, the application

gives you the option of validating the syntax of the XML file against the DTD. The validation step

is useful if you receive a XML command file from another person and want to check it for syntax

errors prior to importing it.

To examine the sample code
1. Open the Command Browser and click theManage button.

2. Expand and select the appropriate item (for example, “<restaurant_type>Menu”)

3. Click the To Script button and then click the Edit button.

TheMyCommands Editor dialog box opens with the command you selected entered into it.

You can examine and modify the command with theMyCommands Editor.
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Chapter 12: Configuring
administrative features in

Dragon

This section contains information how to use the Administrative options, in the Administrative Settings
dialog box, to set and control many administrative features in Dragon.

Summaries of Administrative Settings Dialog Boxes 354

Administrative Settings: Roaming tab 355

Administrative Settings: Roaming User Network Location 358

Administrative Settings: Miscellaneous tab 360

Administrative Settings: Scheduled Tasks tab 364
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Summaries of Administrative Settings
Dialog Boxes

The tabs in the Administrative Settings dialog box are:

n Roaming

n Miscellaneous

n Scheduled Tasks

For more on each tab, see the corresponding topic below:

n Administrative Settings: Roaming tab

n Administrative Settings: Miscellaneous tab

n Administrative Settings: Scheduled Tasks tab
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Administrative Settings: Roaming tab
You use the Roaming tab of the Administrative Settings dialog box to set up the Roaming fea-

ture. You must set up the Roaming feature on each computer where you want end-users to dictate

with a Roaming User Profile.

When Roaming is enabled in Administrative Settings by default the Open User Profiles dialog box

displays large numbers of User Profiles quickly. They can also be organized into subfolders. See

"Creating subfolders for Roaming User Profiles" in the Dragon Help for more information.

Enable

Select Enable to activate the Roaming feature and the Roaming User Profile options.

Network Directories

To set the location of the master Roaming User Profile(s):

1. Click the Add button. You use the Roaming User Network Location dialog box to define

the network location of the master Roaming User Profiles. The location you pick must be acces-

sible to all computers on the network that you want available for dictation with Dragon.

2. Set the Display Name and the Address underNetwork Location. The Roaming feature sup-

ports the following types of locations:
n Mapped Drive—the format is: <drive letter>:\<folder name>. For example,

y:\roaming.

n UNC Path—the format is: \\servername\sharename\path\filename.

n HTTP (http:)—the format is: http://myserver.com/<name_of_virtualdirectory>

where <name_of_virtualdirectory> is the name of the virtual directory set up by an

administrator during setup of the IIS or Apache web site. For HTTP locations, click

the HTTP Settings button to set information specific to your HTTP connection.

You can also test your connection to the HTTP server from the HTTP Settings

dialog box.

n HTTP with SSL (https:)—the format is: https://myserver.com/<name_of_

virtualdirectory> where <name_of_virtualdirectory> is the name of the virtual

directory set up by an administrator during setup of the IIS or Apache web site. For

HTTP with SSL locations, click the SSL Settings button to set information specific

to your HTTP with SSL connection. You can also test your connection to the

HTTP with SSL server from the SSL Settings dialog box.

Local directory (for cache)

When an end-user opens a Master Roaming User Profile, Dragon transfers a copy of that User Pro-

file to the local computer. The local copy is called the Local Roaming User Profile.

You can change the setting of this location, always called <Roaming Local>.

The default location of <Roaming Local> on Windows XP is:
Documents and Settings\All Users\Application Data\N-
uance\NaturallySpeaking12\RoamingUsers\<display name>\<username>
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See Dragon file structure for information about the default location of the RoamingUsers directory

for Dragon NaturallySpeaking on other Windows operating systems.

The <display name> is a name you assigned as a Master Roaming User Profiles location. You can

have multiple network storage locations for your Master Roaming User Profiles.

The <username> is the name of an individual Master Roaming User Profile. There is a separate

directory for each User Profile.

Click the Browse button to find or create a new location.

Check Boxes for Roaming User options

The check boxes and other components below the Local directory are the Roaming User

options. You can also configure the Open User Profiles dialog box to display the Classic Open

User Profiles dialog if desired. See Selecting Roaming User Profile options. for details.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes: For use of WebDAV

n After you install Internet Information Services and WebDAV, you need to use the Internet

Information Services Manager tool to set the “Allow Unknown MIME Types”, “Allow Custom

Properties”, and “Allow Property Queries with Infinite Depth” settings to true. For example, in

IIS 7:
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n For more information, see Configuring Internet Information Services and WebDAV for HTTP

Roaming.

n If you connected to your Roaming User Profile Master Directory over HTTP and you find that

not all your User Profiles are listed in the Open User Profile dialog box, or after creating a

Roaming User Profile you cannot open it again, or the Open User Profile dialog box does not

display all the vocabularies and acoustic models for your User Profiles, make sure that you:
l Check that no files in your User Profile directory are locked, password

protected, or otherwise access-restricted by your server permissions.
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Administrative Settings: Roaming
User Network Location

You use the Roaming User Network Location dialog box to define the network location of the

master Roaming User Profiles.

The location you pick must be accessible to all computers where end-users will dictate using a

Roaming User Profile.

Display Name
Sets the directory name displayed in the following locations:

n The Roaming tab of the Administrative Settings dialog box

n The Location of user profile drop-down list in the Open User Profile dialog box.

Note:With the Roaming feature enabled, the Open User Profile dialog box displays only User

Profiles in the Roaming User Profile locations. To let the end-users open both local (non-

roaming) and Roaming User Profiles, select the Allow non-roaming user profiles to be

opened option on the Administrative Settings dialog box. Clearing this option prevents end-

users from dictating with a non-roaming (local) User Profile by accident. For more information,

see Enabling the Roaming feature on each computer where an end-user will dictate.

n The Location of user profile drop-down list in theManage User Profiles dialog box.

Network Location—Address
On each computer where you plan to have users dictating as a Roaming User Profiles, you must

tell that installation of Dragon where the Master Roaming User Profiles are located.

The Roaming feature supports the following types of locations:

Mapped Drives and UNC Paths

Mapped drives connect to a shared network folder that has a drive letter assigned to it.

UNC paths connect to a shared network folder using the Universal Naming Convention (UNC) to

locate a User Profile. The UNC is a way to identify a shared file on a computer or network with-

out having to know the storage device it is on. The UNC path format is:

\\servername\sharename\path\filename.

To use a mapped drive or UNC path:

1. UnderNetwork Location, enter the address of the mapped drive or UNC path.

You can click Browse to browse for the location of the mapped drive or UNC path. This dis-

plays the Browse for Folder dialog box. You can also create a new directory on the mapped

drive or UNC path by clicking the Make New Folder button.

2. Click OK when you are done.
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Intranet/Internet connections

The Intranet/Internet connection supports both HTTP and HTTP over an encrypted Secure

Sockets Layer (SSL).

To use an Intranet/Internet connection:

1. Under Network Location, enter the URL address of your HTTP or HTTPS server where your

master Roaming User Profiles are located.

2. Click
n HTTP Settings...to display the HTTP Settings dialog box, where you can set

information specific to your HTTP connection like Authentication, Firewall, and

Proxy Server information. You can also test your connection to the HTTP server

from this dialog box. For more information, see HTTP Settings.

n SSL Settings...to display the SSL Settings dialog box, where you can set

information specific to your HTTPS (SSL) connection. You can also test your

connection to the HTTPS server from this dialog box. For more information, see

SSL Settings.

Note: You cannot create a non-Roaming User Profile on an HTTP or HTTPS connection. You

can create only Roaming User Profiles on an HTTP or HTTPS connection and only when the

Roaming feature is enabled.
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Administrative Settings:
Miscellaneous tab

TheMiscellaneous tab of the Administrative settings dialog box contains the following

options:

Check for product updates at startup

Automatically looks on the Nuance Web every time you start Dragon. Any change to this option

does not take effect until you restart Dragon.

Backup location for User Profiles

Shows the location where Dragon will save backup User Profiles.

n Click the Change button to open a dialog box where you can specify a new location.

n Click the Use Default button if you want Dragon to use each Windows user's My Documents

folder.

You can change the Backup Location for User Profiles to any directory where Windows has

both read and write permissions, including portable devices such as Zip drives and CD/DVD

burners. If you change the location, backups for all User Profiles will be located in the same direc-

tory.

Data Distribution location

Shows the location where the local installation of Dragon stores customized words and com-

mands.

n Click the Change button to open a dialog box where you can specify the location for this

directory.

n Click the Use Default button to set the location to this default path:
C:\Documents and Settings\All Users\Application
Data\Nuance\NaturallySpeaking12\custom

You can change the Data Distribution location to any directory where Windows has both read

and write permissions, including portable devices such as Zip drives and CD/DVD burners.

For a default installation, custom words and commands are located in:

n Windows 7 and Windows Server 2008:
C:\ProgramData\Nuance\NaturallySpeaking12\custom\<language>

n Windows XP:
C:\Documents and Settings\All Users\Application Data\Nuance\Dragon
12\Custom\<language>

Do not allow restricted users to add or modify commands

Select this check box to prevent restricted Windows users from adding or modifying Dragon com-

mands. Selecting this option allows only end-users logged on with administrator privileges to add

or modify commands. (Windows XP Professional).
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Disable use of Macro Recorder Commands

Select this box to prevent end-users from using macro recorder commands. End-users can still run

the commands.

Disable use of Step-by-Step Commands

Select this box to prevent User Profiles from using step-by-step commands. End-users can still

run the commands.

Disable use of Advanced Scripting Commands 

Select this box to prevent User Profiles from using advanced scripting commands. End-users can

still run the commands.

Do not allow restricted users to modify Vocabularies

Select this box to prevent restricted Windows users from modifying Dragon Vocabularies. Select-

ing this option allows only end-users logged on with administrator privileges to modify Vocab-

ularies. (Windows XP Professional)

Record wave data between utterances

Select this option to capture all dictation, preserving all audio including any pauses, filler speech

like "ums" and "ahs", extraneous noises, and anything else the speaker may do like cough or laugh.

Correction Only Mode (no dictation available)

Select this option to enable Correction Only Mode.

Correction Only Mode allows transcriptionists to play back a speaker's dictation without having

their User Profile loaded. Note that dictation is disabled if you select this option.

Note: You must disable Correction Only mode before running the Acoustic and Language

Model Optimizer.

Disable Windows Advanced Text Services

Select this option to disable the Microsoft Alternative User Input Text Input Processor

(CTFMon) to eliminate potential conflicts with Dragon.

Dragon installs an add-in to Microsoft Word that can conflict with add-ins installed by other appli-

cations. After installing Dragon on a Windows XP system, errors may start appearing when using

Microsoft Word if the Microsoft Alternate User Input application (CTFMON.EXE) is also

installed and running. The Microsoft Alternate User Input application supports advanced text serv-

ices in Microsoft Office XP. These advanced text services include Microsoft speech, handwriting,

and East Asian keyboard input services. You can disable the Microsoft Alternate User Input appli-

cation during installation or later in the Administrative Settings dialog box.

Note: This option does not appear on systems running Windows Vista, Windows 7, and Windows

Server 2008.

Disable automatic acoustic model selection in the Acoustic Optimizer

Running the Acoustic Optimizer updates your User Profiles with accumulated acoustic data
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from any corrections and additional training end-users may have done. Running Acoustic Opti-

mization increases your overall accuracy. In the process of increasing your accuracy, Acoustic

Optimization may select a different acoustic model for your User Profile. For example, if you

chose a General accent during User Profile setup, Dragon may change it if your speech more

closely matches another accent. For more information, see "About speech and acoustic models" in

the Dragon Help.

Select this option to disable the Acoustic Optimizer from selecting a different acoustic model

when run.

If you are using .Dragon NaturallySpeaking, see Using multiple acoustic models with a User Pro-

file for information on acoustic model selection and User Profiles that use two acoustic models.

Encrypt patient health information

By default, this option is automatically selected in Dragon.

When end-users dictate, Dragon automatically saves interim Dragon Recorded Audio (.DRA) files

it creates to process dictated audio and transcribed text. If the end-user corrects any of the dic-

tated text, Dragon automatically stores interim files related to these corrections in .enwv files.

When this option is enabled, Dragon encrypts these interim .DRA and .enwv files before storing

them in the local or Roaming User Profile directories to help ensure patient privacy. Due to the

restrictions mandated by the HIPAA regulations, these encrypted .DRA and .enwv files can only

be opened by Dragon for its internal use. That means these encrypted files cannot be opened in

the non-Medical versions of Dragon, the Dragon NaturallySpeaking SDK Client (DSC) edition, or

the Dragon NaturallySpeaking SDK Server (DSS) edition. In addition, these encrypted interim

.DRA and .enwv files cannot be opened in DragonPad.

For more information on patient data encryption, refer to Helping with privacy of patient data

Note: Dragon does not encrypt .DRA files that the end-user explicitly saves. For example, if an

end-user saves recorded dictation when saving a document (for example, in Word, WordPerfect,

or DragonPad), these saved .DRA files are unencrypted.

Restore Defaults

Returns the Administrative Settings dialog box to the state it had when you first installed

Dragon. Note that the default is to have the Roaming feature turned off.

Notes
n When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by

voice.

n On Windows XP you must have administrator privileges to change the Backup Location.

Dragon will not let restricted end-users create backup files in directories reserved for the

operating system (for example, the \Windows directory). When specifying a backup location,

make sure that directory can be accessed by all end-users

n In some versions of Windows, such as Windows XP Pro, you must be logged on as the

administrator before you can access this dialog box.

n In some situations, an end-user that does not have administrator privileges may have access to

options on this dialog that they would not normally have.
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n Dragon NaturallySpeaking allows you to use the Universal Naming Convention (UNC) to locate

a User Profile. The UNC is a way to identify a shared file on a computer or network without

having to know the storage device it is on. The format is:

\\servername\sharename\path\filename.
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Administrative Settings: Scheduled
Tasks tab

The Scheduled Tasks tab of the Administrative settings dialog box allows you to schedule

Accuracy Tuning and Data Collection for all User Profiles created with this installation of Dragon

NaturallySpeaking

Accuracy Tuning
Schedule Accuracy Tuning to help Dragon to learn from you and make your dictation more accu-

rate. Accuracy Tuning runs the Acoustic and Language Model Optimizer to update your User Pro-

file with

n frequently dictated word sequences

n acoustic data from any corrections you make, including with the keyboard

n trained words

n commands used

n any additional training you perform

Enabled scheduled Accuracy Tuning

Check to turn on periodic scheduled acoustic model tuning for all end-users. 

Clear this checkbox if you want to disable Accuracy Tuning for the User Profile. The setting is

enabled by default.

Configure 

Click Configure to open the Select Frequency, Data Collection tab and set the Data Col-

lection schedule. You are immediately asked to log in with your Windows Administrator password

to make a schedule change. After you log in, you can set one schedule for Acoustic model tuning

and another for Language Model tuning by clicking the appropriate tab and choosing Daily,

Weekly, orMonthly and the start date and time.

Data Collection
Enable Scheduled Data Collection—Check to allow Nuance to collect up to 500 MB of acous-

tic data and text from your dictation sessions. Once the data is collected, you have the option of

sending it to Nuance to help improve the accuracy of future versions of Dragon Professional. No

personal information is ever sent to Nuance and participation is voluntary.
n Click Configure to set the schedule for data collection. You are immediately asked to

log in with your Windows Administrator password to make a schedule change. After

you log in, you can choose Daily, Weekly, orMonthly and the start date and time.

Let the user choose when to run Accuracy Tuning and Data Collection—Check to give

end-users access to this tab, effectively allowing them to change the schedules for Accuracy Tun-

ing and Data Collection.

Restore Defaults
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Click this button to restore the default values for Data Collection and Periodic Optimization.

Notes:

n When the User Profile is closed, you cannot use Dragon to dictate or to perform actions by

voice.

n Scheduled Accuracy Tuning and Data Collection cannot run if Dragon is open, including if

Dragon is running in QuickStart mode, if Dragon is left open with no User Profile loaded, or if

Dragon is left open by another end-user in a separate Windows session on the same computer.

n Since Dragon uses a local system account to schedule periodic tasks, User Profiles placed on

network shares will not be available for scheduled Accuracy Tuning and Data Collection unless

special arrangements are made with the network administrator

For more information, see the following topics in the Dragon Help:

n "About the Acoustic and Language Model Optimizer" for information about Accuracy Tuning.

n "About Data Collection" for more information about Data Collection.

n The "Options dialog box Data tab" for more information on scheduling Scheduled Accuracy

Tuning and Data Collection for the current Dragon User Profile.
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